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1.1

1.2

1.3

1.4

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system
administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.

When you invoke the application, the Sign In screen is displayed.

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:
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e Home screen

e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane

e Right Pane/Work Area

RACLE"
Financial Services Lending and Leasing

Ay - T O

> Origination
» Servidng
» Collections
> WFP

7 Tools

- Setup

You can view the application version details and copyright information by clicking About link
at the right bottom corner of the screen.

Header

About

Orad Finandal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1988,2017, Oracie andior fs affiates. Al rights reserved.

Oracke and Java are registered trademarks of Oracke andlor s affiltes. Other names may be trademrks of ther respective owners.

property laws. Except ed in your cense agreement or alowed by law, you may not use, copy, reproduce, ranslate, broadcast, modify license,
or display any part, n any form, or by any means. Reverss engineering, disassemby, or decompiation of this software,

If you find any errors, please report them o us in wriing.

U.S. Govemment or behalfof the U S. Goverment, the following notice is
appicable:

U.S. GOVERNMENT END USERS: 3 tem, hardware, andior
documentation, delivered to U.S. -

9 . per iury.f you use hardware in dangerous applications, then you shall
ppropriate faisafe, backup, redundancy, and ofher measures. use. Orack ©
abity for any damages caused by use of tis Software of hardware in dangerous applicatins.

nay formaton an contert, products and serice rm thd pates, Orack Corpraten and ks
= K whrespec 0 hd-paty conlen,products,and senioes. Oacle Corparaton and

ts affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

[ gose.

In the Header, system displays the following:
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User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

= Welcome, VAVAIDYA v (o]

Change Password

User Info

Change Password — Click to change the current password.

ORACLE.

G

Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing

User Info

Organization DMC
Division U501
First Name VARSHA
Last Name VAIDYA
Responsibility SUPERUSER
GL Post Date  02/10/2016

Last Login Date  02/10/2016 03:21:07 AM

Session Language DEFAULT v
Debug Enabled Ind

Time Zone  |JSER TIME ZONE r
Level
User Time Zone LUNDEFINED
Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)
Zone
Server Time  ASIA/CALCUTTA (INDIA STANDARD
Zone TIME)

Skin Family Skyros (Default) v

[ submit || 5% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from

the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter

Condition to record debug data

CMN_DEBUG_METHOD

If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES_HEADER.

CMN_DEBUG_LEVEL

If parameter value is greater than 0, only then the
debug data is recorded.
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The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
You can click on = List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close

Batch Jobs  Jobs Services Database ServerLog Files Parked Transactions = Users '

Database Server Log Files

View v Format~ 5 Fresze il Detach Wrap @) i=Sustrles [ Download File
File Name File Type File Size File Time
JSYPRC_EN_000_01_DB12C_2084400 lob 5706 02/18/2016 06:14: 11 AP »
ALERT lob 395 02/22/2016 03:59:15 A
CSVPRC_EN_100_01 DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSVPRC_EN_100_01_DB12C_3854338 lob 116750 02/22/2016 05:356:42 AN
JSWPRC_EN_000_01_DB12C_2094362 lob 5706 02182016 10:57:09 A} —
T m = - b

b
File Content

View ¥ Format v Fresze  fiDetach 1 Wrap o) ) Beginning®@ End  # ofLines 50 [E] show Fie

Text
t 45:FLL:1v_use BI::Y
cunsyp_cl_000_0l1.get_syp_parameter_value value: weblagic
get_syp parameter value value: http://ofss2221142.in.oracle.com:

get_syp parameter value value: racle.com:..
value value: /scratch/work area/DEV/QA143REL/T..
J5V_BI_USER
EPORT_RRCHIVE DIRECTORY
V_REPORTS SERVER TIMECUT

http://ofss2221142.in.

.get_syp parameter

0_0l.get_syp_parameter valus parameter

emnsyp cl_000_01
cunsayp _cl 000 0l.get syp parameter value parameter:

get_syp parameter value parameter

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.

NextGenUI - This is Next Generation User Interface option which is an enhanced
interface provided in OFSLL using the Oracle JavaScript Extension Toolkit (Oracle JET)
frame work. This is an additional interface supported from OFSLL to the existing system
and both intended to coexist in the system till further updates.

This option is enabled only if the corresponding system parameter is enabled in the
base system as configured by your system administrator. For more information, refer to
‘Appendix - Oracle JET Interface’ section in Servicing guide.

Sign Out — Click the link to sign off from the application. You can also click on E==m
icon to sign off from the application.
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Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and « to collapse them.

> DashBoard

> Origination

Servicing

Eles :

Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Documents i
Collateral Management

m

Reports
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions ~
> Collections
> WFP
> Tools

> Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’ ) SSHEKAR ~ 1 sgnout ©
Financial Services Lending and Leasing

4 @8 | Access x (3 Close:

Appication Retrieval(Origination) Data Sween Reports | Corespondence | Transaction
Applcation Documents (Crigination)
hsset Types(setup Products) Aeoes Gild o add || ZEit | Elven || 2 auit
Account Documents(Servicing) o e Freeze i Detach —_—"

Organization Division Company Branch Alowed

. r ) DMC usoL AL ALL
‘Application Entry(Origination) oG NLO2 AL ALL

Audit Tables{setup System) e sA03 AL AL
Advances(Servicing Batch Transactions) e P04 AL AL

Access(Setup User) |
AP Transactions{Servicing Interfaces)

¥
¥
Y
Y

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.
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Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

ORACLE
Financial Services Lending and Leasing

# Welcome, vAVAIYA - DSEREREE —

Sales Lead x [EEE

124081987

> sarviang
> Collections
> wrp
> 1ools

> setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

RACLE
Financial Services Lending and Leasing
T

ocessing Details
=3 Freeze i Detach Wrap L]

> Collections
- wee
> 100ls
> setup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Accounts at the same time as separate tabs in the right window,
provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’ in
MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Accounts in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Servicing Module Master
Tab. In the Left Menu of Servicing Module Master Tab, you can open multiple accounts by
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clicking on the Customer Service link. Each successive click, opens a new Customer Service
tab.

ORACLE HEGR 1 signout O
Financial Services Lending and Leasing
@8 Customer Service 3 | Customer Service % || Customer Senvice || Customer Service ¢ | Customer Service (@ Close
Search  Customer Service: 20160700010076  Review Request (Pending: 0)  Queue Assignment Z
> DashBoard
 Origination Account(s): 20160700010076: MILLEN JOHN Even | o adt
View ~ Format v Freeze Detach Wrap £ © Current(® Show All ©) Group Follow-up
Serviding & o P ® &
Company Branch Sub Unit Account ¥ Product Days Past Due Currency Pay Off Amt Amount Due St
Servicing NLO2 NLHQ UNDEFINED 20160700010076 LOAN VEHICLE (FR) -23 ELR. 50,089.31 0.00 m
Customer Service Al = = = ———— = = =
Securitization

Transaction Authorization
i e Summary | Customer Service | AccountDetals | Customer Detsils  Transaction History | PmtModes  Bankruptcy | RepojForedosure | Defidency  Colateral | Bursau | CrossfUp Sell Activi > ~
ost Date Ches

Escrow Transactions

Account Documents Alerts Conditions
Collateral Management
Reports Alerts Conditions
Producers Alert Condition StartDt Followup Dt
Vendors PRIM CUSTOMER ( JOHN MILLEN ) MARKED AS DECEASED, UPDATED PERMISSION TO CALL FLAG AVAILABLE FOR REPOSESSION 08/09/2016 08/30/2016
Batch Transactions 4 AS N FOR ALL CONTACTS DEFICIENCY 08/09/2016 08/30/2016 |
Advasices LIEN PERFECTED 08/09/2016 08/30/2016 =
Payments
Fees
Interfaces
Account Details Other Information
2P Transactions
GL Transactions .
Dues Collateral Information
Conversion Accounts |
Descrption Identification Year  AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 0 TOYOTA CAMRY a useD VEHICLE
R il 0 PR i G
Delg Due 0,00 Todays Payoff 50,089.31  AmtPaid Excess 0.00 ’ .
> Collections LCOwe 0.00 Future Payoff 50,158.61 Mermo Excess 0.00 Qitous lnformato
< 2 ik Customer
s NSFDUe 20,00 Future Payoff 08/15/2016 . Name Relation SN National
2 Date Paid Tern 0 -
ouroe 9 000000... JOHN MILLEN PRIMARY socxxx-3456 -45478
> Tools TotalDue  20.00 Future PmtDt 08/28/2016  Remaining Term 6 = = 5
> setup OldestDue Dt 08/28/2016  Days to Time Bar q
e R | %

Few screens in Servicing and Collections are identical and are linked. Hence, when multi tab
option is not enabled, you can open only one screen at a time from the group. A sample of the
grouping structure is given below, based on stages of the screens:

Collection:

e Collection

e Bankruptcy

e Repossession
e Deficiency

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |: to toggle the view of Right Splitter/Action Window.
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Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE" % Welcome, VAVAIDYA o
Financial Services Lending and Leasing
Close.
e origiation x EE
Search/Tack | Funding: 0000000378 | Review Requests (Pending: 0)
Application: 0000000378: TIFFANY RUSSEL / GRACE ER
View~ Formatv B} | (]| Freeze g Detach wsp B OvemideOK v WamingOK ¥
pre
o nop sub it status Origination Stege g cer ame Co Bstng Customer  2UP1C contact
tu
oxjosf2012 0000000378 UNGEFINED APPROVED-FUNDED  FUNDED GA-000D4 : ADVANCELER... . N N
, Summary
Requested  Approved
Advance 1500000 15,000.00
Summary | Applicant | Request || Decision | Contract || Collateral | Comments || Tracking || Document || Verification | Correspondence || Toals o R FHoa00
Tem 3 S
> Applicant Grade  DGRADE S 0
v 00
Stated PTI9s4
4 D Ratios Book 10,000
» Bureau
Queve FUNDED APPLICATIONS QUELE
b Checklist Change Status
Status APPROVED - FUNDED
Collateral Change Status
Colbateral Add Comment
Asset Type SubType Primary  Vear Vake Vodel Hileage New Wholesale Value 3
~ Serviding VEHICLE AR B 2012 CHEVROLET MONTE CARLO on 10,000.00 Alert
> Collections *Type v
> “sub v
RaWED, Trade-Tn Type
> Tools * Comment
b Setup Trade-In o -

Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

RACLE
Financial Services Lending and Leasing

Dues
09302017

osj0/2017
003 50,

003

o7 ooy osjojmr
3 o 15%.

col

dlector DEMOCOLL

Colateral Information
Py Descpton Ldentication #
2006 CHEVROLET MONTECARLO R

Customer Information
CSON ame Relaten

000000... MADHAN ORAGLE PROUARY

Enai EDW.SRSIGGMAL COM

Tive

Malng  Address

HouE v v 745 newyork MA-34038

Employment Information

BAPASGURITES2 06 NEW

Customer service (3§ Cose
Searh
Account(s): 2017010001007 Elvew [ LAt
Vews Fomate | B | MFeen Elivent o | W B ©CurentSon MO GromFlowss
Conpany wanch bunt Dayspastoue usrency Payoffant  Amountoue Stais OdstoueDt  DxQReason
st sk ) 150155 250021 (T N /017 15 PaveNT . ——
Bsbnt | [ @aex
Somary | (| [ S| At [ s G Pk T oy Pt [y e Do [l o] (o [ e A v ey
Qe Conditin =]
Meris Conditons Atorun
B textAccount
Rlerts Conditions ik
At AccontConiton Contionsrtot
No data o dlay Repossession s o FEEEES
oenauEn oy o P m——
=
=
AecountDetais Other Information

ew  Bssetcass AsetTpe  SbType
BiaE  om

National D a0t Gender

o o372s/sses uosneD

vy OptOut ¥

Phone

yses337

Eeestoment | [ G oer

=
=
=
=

B Fostcal vty | [ @ Cear
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e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click =i to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.

1.4.1.1 Time Zone Preference

Oracle Financial Services Lending and Leasing ®
User Info

Organization DMC Time Zone |JSER TIME ZONE v
Division US0L Level
First Name VARSHA User Time Zone  UNDEFINED
o e A Company US/CENTRAL (CENTRAL STANDARD
) : Branch Time  TIME)
Responsibility SUPERUSER e
A T Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT b Skin Family Skyros (Default) »

Debug Enabled Ind

Dh? Submit || 3% Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.
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1.4.2

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone' is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘SEE\(\! Customer Service: 20120200010231 Pme.uR!qhe:t‘\Penmug:D)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt

Vieww Format 5} Freeze i Detach ap | W) & @ curent O ShowAll © Group Follow-up
Company Branch Sub Unit Account # Product Days Fast Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usi1 USk1 UNDEFINED 0120200010231 LEASE VEHICLE 0 UsD 0,00 0.00 ACTIVE 02/10/2015
[ summary | Jcustomer Service] | Account Detil || Customer Detalls| TransactionHistory | Pt Modes | Bankruptey | Repo/Foredosure | Deficiency  Colleteral Bureau _Crosslp Sell Acivies |
‘ Call Activities | Maintenance Comments Promises | Checklists Tracking Attributes | References | Correspondence | Letters  Document Tracking
call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Followup Dt Time Zone Adj Follovup Dt Cor
AT PH ANSWERING MACHINE N 12300015 1,000.00 NONE N 1f0j01s 12{29/2015 12:30:00 P

AT PH ANSWERING MACHINE N 12/302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
b

You can click # to view the hidden tabs, if any.
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1.5 Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations

e Basic Actions

e Personalization Options

e De-supported Special characters
e Skip Zip Code Validation

e Export data to Excel

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
o Edit
e View
e Audit

e add | S Edit | 5 view | o Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation Description

Add Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit Click to view audit info. If an audit is set for a field, then the system

tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.
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1.5.2

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

Save and Add

[ save and stay

[ save and Return

<3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.

The Payment maintenance screens consist of the following actions.

Post and Stay

E Post and Return

<:] Return

The table below gives a snapshot of them:

Basic Actions

Description

Post and Stay

Click to post the transaction and remain in the same section. This
button is displayed when you click 'Modify Payment/Modify
Payment Transaction' button.

Post and Return

Click to save and return to main section. This button is displayed
when you click ‘Modify Payment/Modify Payment Transaction’
buttons.

Return

Click to return to main section without modifications. This button is
displayed when you click ‘Modify Payment/Modify Payment
Transaction’ buttons.

The summary screens consist of the following navigations. The table below gives a snapshot

of them:

Basic Actions

Description

Click to navigate to the first record.

Click to navigate to the previous record.

< [F[E

Click to navigate to the next record.
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1.5.3

Basic Actions Description

| A| Click to navigate the last record.

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|43r Download File - Click to download the details of selected data.

Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl

The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View'.
M Format » | [Ep Freeze i Detach

Columns 4 Show Al
| : + Product |
Detach + Description |
Sort v ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...
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Options Description

Format Click to resize columns or wrap a data in the table cells.
|
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column m I

Column DESCRIPTION

width | 100 [&] [pixels  [=]
| OK | Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View = Format *’ Freeze ﬁ Detach A Wrap a!}
i i i | B [
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

Product Definition . TN L= R T I |
view - [Faimats] | B | [Freee ffivetcn | [N | @ nes ¢
[poduct ot Jenaot
Wioan+e LOANHOME (R)  P1/01/1800 12/31/4000

LOAN SECURED
LoaNSG 12/31/4000

|Coliateral Type  |Collateral Sub Type: 15;;:@@:
HOME COLLATERAL® REAL PROPERTY HOM INSTALLMENT

HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT

WR)

LOAN-AUN B SRR 011500 12/31/4000
LOANAE EOANVERICLE(FR)! b1/01/1800 12/31/4000
D1 [ 3/08/1863

UNSECURED COLLATIUNSECURED INSTALLVENT

VEHICLE COLLATERA PERSONAL PROPERT INSTALLENT
VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT

MURABAHA = 1/01/1500

NDS1 NORM DSER. 3/11/1853 31/2000
NPOL neos 1/01/201 12/31/4000

HOME COLLATERAL  REAL PROPERTY HOR INSTALLMENT

UNSECURED COLLATIUNSECURED INSTALLVENT
HOME COLLATERAL REAL PROPERTY HORMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

ViewLast ©) 1Day @) 1Week D) 1Month@ By Date  startDt 07/01/2017 b EndDt 092002017 b &8

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt and ‘End Dt  fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

1-14 ORACLE



Detach

ORACLE
Financial Services Lending and Leasing

. Welcome, vavaY: - ERSEISIGN O

Close
e L3 customerseve ¢ e
ORI Search | G quest (Pending: 0) 7
Servicing
Sencing Account(s): 20120200010231: YUTAKA OZAKA / AKANE [Elview || «2 Audt
Citacienserae Views Fomatv B [[Freze HiDetach Jwap @) & © Curent O ShowAll O Group Follow-up
Secuitzation Company Branch sub Unit Account = Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due Dt
Transaction Authorization usog Usk1 UNDEFINED 0120200010231 LEASEVEHICLE 015D 000 0.00 ACTIVE 02j10/2015
Post Date Checks
S Trbedive Summary | Customer Service | Account Detals | Customer Details | Transaction History Pt fodes || Sankruptey | Repo/Foreclosure | Deficency | Collateral | Bureau | Cross/up Sel Activities
Account Documents
Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes References Corespondence  Letters Document Tracking
Reports
Producers i .
Vit Transaction Batch Information padi | et | Bvew | o auit
Batch Transactions View~ Format~v [ Freeze £ Detach Wrap W {5 post [ void
Adiances Date Monet Transaction status Batch
Pajments | 02/10/2016 'ADD CUSTOMER ADDRESS PHONE POSTED ]
Fees oot v TERMINATE ERROR ]
Interfaces 01/06/2016 ¥ TERMINATE Vo N «
P Transact 01050016 EXTENSION vom N
Detached Table x
Vieww Formatv [ Frecze [HDRRAR] o wp | @ 1 Vaid
Date Honetary Transaction Status Batch
zj10/2015 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/07/2016 Y TERMINATE ERROR N
01/06/2016 Y TERMIATE o N
01/06/2016 Y EXTENSION vo N
12232015 Y PAYOFF QUOTE LEASE POSTED ]
Views Formatv [ Freeze G Detach wap @
> Caollections Transaction Frocessing Details
S WP Transaction Posting Successful =+
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:

e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

2 Welcome, VAVAIDYA o

ORACLE"
Financial Services Lending and Leasing

> DashBoard
» Origination
Servicing

Senvidng

Customer Service x.

Search | G ice: :0)

Account(s): 20151200010012: MADHU BOBBURI

Customer Service
Securitization

View~ Fomat +
Company

Transaction Authorization vsor

Post Date Checs

Escron Transactions

Account Documents

Collateral Management

Call Activities
Reports

Producers

Vendors Transaction

Batch Transactions.

Date
Fayments

02/10/2016
Fees ‘ 04/25/2016
Interfaces 01/2212016
AP Trans: 030712016
12/15/2015
Transaction
Parameters
P View v Fomat
\ Parameter
> WFP o data to display.
> Tools
> Setup

Result

Summary | Customer Service | Account Details

Maintenance | Comments  Promises

View v Format v

B ] Freeze i Detach wap | G & ' cument O Showall O Group Follovi-up
Branch sub Unit Account = Days Past Due Currency
uskg 2015120001012 LOAN VEHICLE (FR)

Customer Details || Transaction History | Pt Modes | | Bankruptey | Repofroredos ¢ o o

Checkists || Tracking Attributes || References || Correspondence || Letters [ Jsamrch

Matfh @ all O Any
Batch Information

53 Freeze Efipetach | Jwap @

Transaction

et Ghvod

¥ — = ACCOUNT NG
™ i ADIUSTMENT}

Batch Information

search
Date 02/10/2016
* Monetary @) et
tv & Freeze &t Detach Wrap 5]

(3] Close.
Elview || o audit
Pay OFf Amt Amount Due Status Oldest Due Dt
5031881 EECEN v oeLo:non perro. (TR
x
Advanced
b dd | 7 i || Elvew || Pasdt
[ search Transactlhe
|
Search Basic

Match ® All ) Any
Tn Code

| Description
n

| [ Reset | [ AddFields || Reorder

Desciption
o rous to dis

Greater than or equal to
Betueen

oK || cancel

Value Required

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu

Do this

Basic

Click ‘Basic’ for normal search.
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1.5.4

1.5.5

Buttons/Menu Do this

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual
ones.

| * Channel | WEB ENTRY = * Producer Name [
NY-02: PR HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR A 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

De-supported Special characters

OFSLL ‘does not’ support the following special characters while accepting data through Ul,
web service and file upload process.

<>{}N\*[1"
Hence, ensure that the same is not used while processing any input data in the system.

Skip Zip Code Validation

While accepting data for interdependent fields through User Interface, OFSLL validates and
auto-populates the values for subsequent fields based on previous selection.

Accordingly, when a specific ‘Country’ is selected from drop-down list which is populated

based on COUNTRY_CD (COUNTRY CODE) lookup code, OFSLL validates and populates
the list of corresponding zip codes maintained in Zip Code setup.
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However, in case the zip code validation is to be skipped for a specific Country, then define
the Sub Code as NO_ZIP_VAL against the COUNTRY_CD in lookups screen as indicated

below:
Lookups x 38 Close
Lookup Type W add || ZEdit || 5] View || & Audit
View v Format v {Ef Freeze ;j‘ Detach Wrap @
Yes
& %COUNTRY%%
No
A System Defined
Lookup Type Description Yes/No Enabled
COUNTRY_CD COUNTRY CODE (SORT BASED ON CODE) Yes () No Y
»
Lookup Code P Aadd || ZEdit || ] view || & Audit
View ~ Format ~ (i) Freeze B Detach Wrap 2}
é Yes
%NOY
YoNO% o
Lookup Code Description Sort Sub Code SysromibHined Enabled
Yes/No
UK UNITED KINGDOM 1{NO_zIP_VAL Yes (. No Y
SG SINGAPORE 1|NO_zZIP_VAL Yes (' No =

On Selecting that particular Country from drop-down in any of the Ul screen, only the default
value ‘0000000000’ is available for Zip field drop-down list. On selecting the same, the City
and State fields are set as UNDEFINED.

Producer Details

[ save and Stay, || [ Save and Return || @ Retum

Producer # CO-00004 Address Line 1 2145 HWY 50 WEST Max Float 99,999
Old Producer # C0-00004 RS TiRE Remaining Float 99999
* |
Name DALE SPRADLEY MITSUBISHI Country | UNITED KINGDOM v Enabled
Company  ARGO1 v =
Zip 0000000000 Subvention Participation
Branch | ARO1 v ) 0000000000 UNDEFINED UNDEFINED
Zip Extn
Start Dt 05/27/1994 &y et
City MO T
End Dt 12/31/4000 | @ )
State UNDEFINED v Collection Type ' STATEMENT i
JACK -
Contact * Permission to Collection Frequency MONTHLY ¥
Group  NOT DEFINED i/ . pemussiaf‘::: Refund Disbursement 'NONE v
Method
Grade v Text Re o T =
egion
Type DEALER i Phone 1 (719)-543-6710 J
Territory | ALL 2
Status | ACTIVE v EinilG i,
Sales Agent % * Permission to License Details
Underwriter | DEMO UNDERWRITER v £l
* Permission t
Funides v e Valid From 01/01/1800 B
Collector  DEMO COLLECTOR v Phone 2 Valid To  12/31/4000 &

Note

Skipping zip code validation has significant impact in the system since the change impacts
all the Ul screens - Setup screens, Origination, Servicing and Collection module screens,
Interface, Customer Credit Limit, Collateral Management, and so on. Hence it is recom-
mended to be done with careful consideration and OFSLL is not responsible for any im-
pact/mismatch resulting out of this change.

1.5.6 Export data to Excel

While working on any of the screens in User Interface, OFSLL provides a flexibility to Export
the data that is displayed on screen to an Excel file. This helps to download and view the data
offline especially with data intensive screens.
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1.6

Clicking ‘Export to Excel’ option provides option to save the data to .xIs file.

Summary = Collections Customer Service =~ Account Details = Customer Details =~ Customer Preferences = Transaction History =~ Pmt Modes = Bankruptcy =~ Repo/Foreclosure — Deficien > ¥

Call Activities Comments = Promises =~ Checklists = Tracking Attributes | Field Investigation = References = Correspondence = Letters = Document Tracking =~ Scen: > ¥

Transaction Batch Information padd | AEdt | [ view | & Audit
View v Format v [ Freeze Efi Detach Wrap [0 % post Void | | Export to Excel
Date Monetary Transaction Status Batch
10/29/2020 i PAID OFF POSTED N
10/23/2020 N ADD CUSTOMER ADDRESS PHONE POSTED N

Parameters
View v Formatv [ Freeze B Detach Wrap ®
Parameter Value Required
TXN DATE 02/11/2020 Y
WRITE OFF INDICATOR YES Y

However, ‘Export to Excel’ option is currently available only to following screens and is also
access controlled depending on configuration defined in setup.

Queues/Search Results - Origination, Servicing, and Collections
Account Information

Balances

Call Activities

Maintenance

Promises

Due Date History

Collateral

Tracking Attributes

Condition Details / Condition / Queue History

In additional, OFSLL displays the total count of records fetched from database. The count is
displayed in the right bottom corner of records table. However, note that this is not the total
count of all the records in the database but only the records which are fetched based on
specific selection. For example, if there are 50,000 records in database and Ul is fetching
1,000 records, then the count is displayed as 1,000.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1.

Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

Arrow Keys to hover within the drop-down list.
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1.6.1

1.7

1.8

1.8.1

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click
monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.
Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.
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1.8.2

1.8.3

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users
without the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high
contrast mode and automatically render content that is compatible with OS high
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built
on Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate
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2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.
Apart from this, Search can also be performed using wild card characters.

ORACLE
Financial Services Lending and Leasing

Nelcome, PRAKRRAO v o

Customer Service 5 [E3k=
Search | Customer Service | Review Request (Pending: 0)
> Quick Search

Search Criteria

&P Reset Criteriz || @8 Search
View = Fomatv  [E| @Fresze Fivemch | o Wrap &

e ~]
Lixe = =
Lixe ~l
EQU [~
LIKE ~]

Lie vl
EQUAL =
e I~
ke ~
EQuAL ~]
e [~
e ~]
LIKE >l
Lixe ~]
Lixe ~T
Lixe [~ =
) Lixe ~1
e

<

L Open Account

Search Results
View » Fomatv B Frecze A Detsch oo | @
> Collections ‘Company Branch Account F Date Title Product Status. dD:y«:quency Amount Dus

v I
g

> WFP No data ta display.
<

> Tools

> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002
Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL . o .
Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (20001000012512°, <20010100012645°,
£20010300012817°)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645°, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (°20001000012512°, <20010100012645°,
€20010300012817°)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

e 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
o 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE
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2.21

Criteria Comparison Operator Value

APPLICATION DATE EQUAL 05/01/2001

APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an
application number greater than or equal to 0000000278.

Criteria Comparison Operator | Value

FIRST NAME EQUAL JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria Comparison Operator | Value

FIRST NAME LIKE JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”
e JAN ARBOR
e JAN FISHER
e JANE MEYERS
e JANETTE NORDSTROM

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular
application.

During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Line of credit origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

2. Click the Search Criteria tab.

The search tab enables you to locate an application using a broad range of search criteria.
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2221

e During Line of credit origination, the results are sorted according to the priority of
application and application identification number. However you can sort the records
using any criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. Onthe Results screen, select the application you want to load and click Open
Application.

The system loads the application on the respective screen.
You are now ready to begin work on the application.

Quick Search section

Quick Search enables to search for an account using any one of the following values -
Account Number, Customer ID, SSN, Identification Number or Queue.

To load an account using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. In the Quick Search section’s Acc # field, specify the account number you want to load
and click Submit.

You can also load the account by specifying the last 4 digits of the SSN Number. System
retrieves only those accounts where the searched SSN is of the Primary Applicant. If multiple
matches are found, system displays an error message as ‘Multiple Matches found for the
SSN, Please use normal Search’.

Note

Search cannot be performed using wild card characters in the Quick Search section.

The system loads the selected application.

To load an account from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Account.

Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.
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What is it? What does it do?

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.

Open Applica- | Displays the application details for the selected application.
tion

Unlock Appli- | Unlocks the selected application locked by another user.
cation

Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Line of credit information,
credit bureau data, and collateral information. The new application will have status/sub status
as NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.
3. Click Copy Application.

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
irrespective of whether it is copied in Underwriting/Funding screen. The system also notes
that this is a copied application with a system generated comment.

Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using
Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application
you want to work with.
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2. On Search Results/Task screen, select the application you want to load and click
Submit.

An Information message appears with the message: “An application is locked by another
user.”

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize’ and 'Calculate’ buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service
screen. The search tab available in the screen enables you to locate an account or customer
using a broad range of search criteria.

To view the Search screen during Line of credit servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.

Depending on the link clicked, Customer Service screen appears, opening at Results
screen.

Note

Oracle Financial Services Lending and Leasing does not display the financial details of se-
cured accounts if the logged-in user is not authorized. Though the search display the re-
sults, the fields such as Status, Delinquency Days, Amount Due, and Outstanding Balance
are masked with ‘xxxxx’ and clicking on the same displays an error message indicating
‘Cannot open secured account’.

3. Click the Search Criteria tab.

Using the Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and
Value columns.

2. Click Search. System displays all accounts that meet the search criteria in the Results
tab.

3. Onthe Search Results/Task screen, select the account you want to load and click Open
Account.

The system loads account on Customer Service screen.
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2.3.2

Quick Search section

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer #, Customer Id, SSN, National Id,
Identification #, or Queue/Condition.

To load an account using the Quick Search section

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform customer service task on the application, click Customer
Service.

3. In the Quick Search section’s Acc#/Customer #/Customer Id/SSN/National Id/
Identification # fields, specify the corresponding details in the respective fields and click
Submit.

4. You can also search for accounts which are mapped to a particular Queue or Condition
by selecting the same from ‘Queue/ Condition’ drop-down list and clicking ‘Next Account’
button. Clicking ‘Filtered Account’ opens the subsequent account fetched during a queue
search and listed in Queue Assignment section.

5. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen
for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click
Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

Select Customer as a search option.
1. On Search Criteria screen, use Comparison Operator and Value columns to create a

search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.
The system locates and displays all the accounts that meet your search criteria on Search
Results screen.

3. On the Search Results screen, view the following information for each account:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Line of credit product of the account.
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In this field: View this:

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
Type The type of account.

Also the ‘Customer Details’ section below displays the Customer Information along with
Addresses, Telecoms, Employments, and Tracking Attributes. You can click ‘View’ to display
the details in each section.

4. On the Search Results screen, select the customer you want to retrieve. The system
displays all the accounts pertaining to that customer Id. Select an account and click Open
Account.

The system displays the account details on Customer Service tab.

2.3.3 Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Account as a search option.
2. On the Criteria screen, use the Comparison Operator and Value columns to create a

search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.

3. Click Search. The system locates and displays all the accounts that meet your search
criteria on Results screen.

4. On the Search Results screen, view the following information for each account:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Date The date the account was created.

Title The primary and other applicant(s) attached to the account.
Product The Line of credit product of the account.

Status The status of the account.

Delinquency days The number of days the account has been delinquent.
Amount Due The total amount due for the account.
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In this field:

View this:

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

5. On the Results screen, select the application you want to retrieve and click Open

Account.

The system loads the account under the Customer Service tab

You are now ready to begin work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review

Request tab.

Search Using Business Details

To search and load an account with specific business using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Business as the search option.

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find the business type. You can click Reset Criteria at any time to clear
the Comparison Operator and Value columns.

3. Click Search. The system locates and displays all the records that meet your search
criteria on ‘Search Results’ section.

You can view the view the following information for each business record:

In this field:

View this:

Business #

The registered business number of the company.

Business Name

The name of the business.

Tax ID

The taxation identity number of the business.

Start Dt

The date when the business was initiated.

Phone Number

The contact number of the business.

Zip

The zip code where the business is established.

4. Onthe Results screen, select the business type of your interest. The sub section displays
the accounts associated with the selected business with the following details:

In this field: View this:

Company The company of the account.
Branch The branch of the account
Account # The account number
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In this field:

View this:

Product The Line of credit product of the account.
Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.

Amount Due

The total amount due on the account.

Status

The status of the account.

Oldest Due Dt

The oldest payment due date on the account.

Also the ‘Business’ section below displays the Business Details along with Addresses,
Telecoms, Partners, Affiliates and Tracking Attributes. You can click ‘View’ to display the

details in each section.

5. Select the required account and click Open Account. The system loads the account
associated with the business type in the Customer Service tab
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3.2

3. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards
Click Dashboard > Dashboard > Dashboard.

ORACLE" i ) = Welcome, PRAKRRAO ~ =
Financial Services Lending and Leasing

DashBoard B glose

Origination Setup Admin

My User Queues Product Expiring in Next One Month Critical Batch Job Status
Count. Product End Date Batch Job Sttus
No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App = Priority
No data to display.

My Pending Review Requests By Priority
Priorty Gount
No data to display.

Servicing Producer Vendor

Number of Queues Hard Assigned A~ Producers Count By Status ‘Vendors Count By Status
Queue Description Count. Status Count Status Count
No data to display. ACTIVE 82 ACTIVE 35

Number of Accounts Producers Expiring in Next One Month Vendors Expiring in Next One Month
ueue Description Count Producer End Date me End Date
No data to display. No data to display.

My Pending Review Requests By Accounts
Acc = Priority
No data to display.

> Origination My Pending Review Requests By Priority o
> Servicing | prienty Count

> Collections

> WFP

> Tools

> setup

Features

Following are the features of Dashboard:
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3.3.1

3.3.1.1

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity screen is a supervisor
feature that allows you to monitor the daily performances of users completing Line of credit
origination and servicing tasks.

These tasks are categorized as customer service/collection tasks. The system updates these
details on daily basis.
Using the User Productivity screen, you can review the following daily tallies:

e Number of accounts worked and call activities, by user
e Number of accounts worked and call activities, by queue

This chapter explains how to use the User Productivity screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

Viewing the Customer Service/Collection tasks

Daily tallies from the Customer Service module appear on screens opened from the following
tabs on User Productivity Screen:

e Collector Activity
e Queues Status

Collector Activity

The Collector Activity screen displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.

To use the Collector Activity

1. Click Dashboard > Dashboard > User Productivity > Collector Activity. The details
on this screen are grouped into two:
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e Users

e Activity Details

2. In the Users section, you can view the following information.

ORACLE

Financial Services Lending and Leasing

& Welcome, PRAKRRAO ~ o

Process Files

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

User
No data to display.

DashBoard Users Preductivity x
DashBoard Application Entry || Underwriting | Funding || Grigination Queuss | Collector Activity: | Service/Collection Queuss
DashBoard
Users Productivty
System Monitor Users
Producer Analysis View Formaty [ freeze EfiDetach | ol Wrap 5]

Activity Details
Viewv Format~ (5 Freeze [} Detach ] Wrap 5]
Queve Name Left Messoges  Promise To Pay
No data to display.

Neme

Mo Answer

5 Cose
Accounts Call Activities
Other Total

A brief description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Accounts Displays the number of accounts worked.
Call Activities Displays the number of call activities.

3. In the Activity Details section, you can view information for the selected user. A brief
description of the fields is given below:

Field:

View this:

Queue Name

Displays the queue name.

Left Messages

Displays the left message activity count.

Promise To Pay

Displays the promise to pay activity count.

No Answer Displays the no answer activity count.
Other Displays the other activity count.
Total Displays the total activity count.
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Service/Collection Queues

The Service/Collection Queues Status tab displays daily information regarding queues, such
as the number of accounts worked, number of call activities, number of accounts pending, and
totals number of accounts in the queue. It also displays information about the users who
worked on these queues and details of the call activities.

To use the Queues Status tab

1. Click Dashboard > Dashboard > User Productivity > Service/Collection Queues tab.
The details are grouped into two:

e Service/Collection Queues
e Activity details

2. In the Service/Collection Queues section, you can view the following information.

ORACLE
Financial Services Lending and Leasing

& Welcome, PRAKRRAO + =

[ Close

DashBoard Users Productivity »

DashBoard
Dashgoard
Users Productivity
System Monitor

Application Entry | Underwriting | Funding _ Origination Queues | Callector Activity | Service/Collection Queues

Service/Collection Queues

Producer Analysis View v Formatw Freeze

! Detach Wrap @

Process Files Company Branch Queue Name Accounts Activities Pending Total

No data to display.

Activity Details
View v Fomatv Ep Fresze

Hoceh | Glwep | @

Name Left Messages  Promisa To Pay. No Answer Other Total

User
No data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:
Company Displays the company name.
Branch Displays the branch.

Queue Name

Displays the queue name.

Accounts Displays the number of accounts worked.
Activities Displays the number of call activities.
Pending Displays the number of accounts pending.
Total Displays the number of total accounts.
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In the Activity Details block, you can view information for the selected queue. A brief
description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Left Messages Displays the left message activity count.
Promise To Pay Displays the promise to pay activity count.
No Answer Displays the no answer activity count.
Other Displays the other activity count.

Total Displays the total activity count.

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.

Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:

e Batch Job Sets

e Batch Jobs

e Batch Jobs Threads
e Request Details

e Request Results

To Monitor Batch Job
1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.
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2. Inthe Batch Job Sets section, you can view the following information

ORACLE’ . W PRAKRRAO ~ o
Financial Services Lending and Leasing

e System Monitor » 3 Close

Batch Jobs | Jobs | Services | Database Server Log Files | Parked Transactions | Users

Users Productivity

System Monitor Batch Job Sets
Producer Analysis Vieww Formatw [} Fresze i Detach Wirap T BB Re-submit Job Set
Process Files Set Code Job Set Description  Status Frequency Frequency Value  Start Time Encbled Critical Last Run Dt Next Run DI
SET-AAT ACCOUNT CREATL.. READY DAILY DAILY 10:00 &M N N 08/08/2003 08/09/2003 A
SET-ACR ACCRUALS AND D... READY DAILY DAILY 10:30 PM N Y 08/07/2003 08/08/2003
< >
Batch Jobs
Vieww Formatw [ Freeze i Detach Wrap @) BB Re-submit Job
Seq Job Type Job Code Status Job Description Threads Comemit Count Errors Allowed Weskend Holiday
1 PROCEDURE AATPRC_B1_100_01  COMPLETED APPLICATION TO. i ¥
2 PROCEDURE TXNACT_E]_100_01 COMPLETED ACOOUNT ACTIVA 1 100 50Y Y
< >
Batch Job Threads
§ View~ Fomat~ B Fresze ) Detach Wrap (65
Thread Status Errors Records Trace Level Enzbled
11DLE 0 ] oy
Request Details
View » Format+ [ Fresze ) Detach Wrap (5]
Request Type Stotus Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
>
Request Results
Vieww Fomate [ Frezze 2! Detach Wrap W
Requast Result Description
> Origination No datz to display.
> Servicing
> Collections
> WFP
> Tools
> Setup

A brief description of the fields is given below:

Field: View this:

Set Code Displays the code for batch job set.

Job Set Description | Displays the description for batch job set.

Status Displays the job set status.

Frequency Code Displays the frequency at which the job set is to be executed.
Frequency Value Displays the value of frequency code chosen for the job set.
Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.

Parent Displays the preceding job set.

Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set

Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused
the failure. Resubmitting a set causes system to re-perform the batch job set and dependent
batch jobs.

e Inthe Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.
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The Batch Job screen also allows you to resubmit jobs which are in READY or COMPLETED
or FAILED status if you have access key privileges define for your user responsibility. If
provisioned, then a ‘Force Re-Submit Job Set’ button is available instead of ‘Resubmit Job
Set’ button to resubmit the jobs with above status.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.
Job Type Displays the batch job request type.

Job Code Displays the batch job request code.
Status Displays the job status.

Job Description

Displays the batch job description.

Threads

Displays the number of threads used by the job.

Commit Count

Displays the number of rows after which auto-commit is
triggered.

Errors Allowed

Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job

Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

e In the Batch Jobs section, choose the batch job to resubmit (only a batch job with a
status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.

A brief description of the fields is given below:

Field:

View this:

Thread

Displays the name of thread.
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Field: View this:

Status Displays the status of thread.
Errors Displays the number of errors in the thread.
Records Displays the number of records in the thread.

Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).

Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

3.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.

3-8 ORACLE



To Monitor Job Details
1. Click Dashboard > Dashboard > System Monitor > Jobs.

ORACLE’

Financial Services Lending and Leasing

System Monitor x

Batch Jobs | Jobs

Job Details

View ~ Format

Request Type

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE
<

Services || Database Server Log Files

Batch  Back Ground || Credit Request

-
Status

COMPLETED.
COMPLETED
COMPLETED
COMPLETED
COMPLETED
COMPLETED

Freeze  pfiDetach

Parked Transactions | Users

§) viewlsst @ 1Day() 1week© 1MonthByDate StartDt EndDt @ view ©) Failed ® All

Valid Execution
Job Set Job Description Thread Errors Records Run Start Date/Tme Run End Date/Time  Process Dt Period Start

DateTime
SET-TRE TXNDDT_B1_100_. TXNDDT_B1_100_ 2 0 2 09/19/2017 11:52: _ 09/18/2017 11:52: . 03/20/2017 08/18/2017 11:52;
SET-TRE TXNDDT_BJ_100_.. TXNDDT_B1_100_ 1 0 & 09/19/2017 11:40: . 09/18/2017 11:41:. 03/20/1017 08/13/2017 11:40
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 0 2 09/19/2017 03:31: . 09/18/2017 08:31: .. 08/20/2017 08/13/2017 09:31
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 [ 2 09/19/2017 08:31:... 09/18/2017 08:31:... 08/20/2017 08/13/2017 08:31
SET-QRT QCSPRC_BI_100_ . QCSPRC_BI_100_ 1 o 2 09/18/2017 07:31:... 09/18/2017 07:31: .. 08/20/2017 08/13/2017 07:31
SET-QRT QCSPRC_BI_I00_ . QCSPRC_BI_100_ 1 0 2 09/19/3017 06:31: .. 09/18/2017 06:31:... 08/20/2017 08/13/2017 06:31

7

[ Close

Job Detail Description
THNDDT_B_100_0 1. TXNDDT_B1_100_01(6006)

Job Results
View » Formatv [P

Request Result
in Ani St

Freeze i Detach

Description

2. Onthe Job screen, you can select any of the following type of jobs which are available in

separate tabs:

Select: System Displays:
Batch Batch jobs (used primarily for the nightly processes).
Back Ground User submitted requests, such as reports and payment posting.

Credit Request

Credit bureau requests.

3. Inthe Job Details section, select the time frame based on elapsed days. You can select
any of the following options:

Select: System Displays:

1 Day All the types of jobs selected in Jobs Type section in last one-day.

1 Week All the types of jobs selected in Jobs Type section in last one-week.

1 Month All the types of jobs selected in Jobs Type section in last one-month.

By Date All the types of jobs selected in Jobs Type section for specific duration.
You can specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’
fields using the adjoining calendar and click ‘Search’.

4. If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

5. In the Job Details section, you can view the following information about jobs matching
the contents of Job Type, View Last and Failed boxes:

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.
Status Displays the job request status.
Job Set Displays the job set code.
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Field:

View this:

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected

in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard > Dashboard >System Monitor > Services.
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2. Inthe Services section, you can view the following information about the system’s
processing services:

ORACLE’
Financial Services Lending and Leasing

& Welcome, PRAKRRAO o

o Cose
e —— System Monitor 5 [E3fe
DashBaard
Dashgcard

Users Productivity .
System Monitor Services

Producer Analysis View  Format~ Ep Freeze
Process Files Service

BatchJobs  Jobs | Services Database Server Log Files | Parked Transactions | Users

! Detach Wrap @) @ status st Clstop
Description

CREDIT BUREAU SERVICE (EFX TEST FILES)
UREAL SERVICE (EXP TEST FILES)

Company Branch
v AL AL
sV AL ALL CRED)
v AL AL CREDIT BUREAU SERVICE (TUC TEST FILES)
BC AL ALL JOB SCHEDULER
sV AL AL JOB SERVICE

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.
Description Display the service description.
Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose: System:

Status Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.

Start Starts the job service.

Stop Stops the job service.

344 Database Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
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so on). The Database Server Log files tab lists and describes all such log files within the
system on the database server.

To view a log file on the database server
1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

ORACLE" . . 5w ABSHEKAR ~ 1@ Signout
Financial Services Lending and Leasing
@ Svstem Monitor (3] Close:
Batchlobs Jobs | Services  Database Server Log Files | Parked Transactions | Users 2
DashBoard
DashBoard - Database Server Log Files
DachBoard | “i‘e"'t B 1 O e @ T Mo e B B D2k Erd Dt % @@ Vien © Alert® Debug @ Interfaces
as
Users Productivity = -
View v Format » Freeze i Detach Wrap iSUstFies [ Download File =
System Maritor e & E W == G2
¥t A L File Name File Type File Size File Time
o T xaeprc_em_100_02_FMW116_7033906.log fie 159179 08/31/2017 02:28:52 AM -
JSVPRC_EN_000_01_DB12102_6574056.log fie 171338 08/28/2017 07:42:07 PM [
JSVPRC_EN_000_01_DB12102_7283859.log file 19897 09/10/2017 10:39:59 AM
g XAEUPD_EM_100_02_FMWW 116_7203940.log fie 26704 09/07/2017 03:50:43 AM
RDNLOG_EW_100_01_FMW116_7284144.log fie 1108 09/08/2017 06:00:34 AM -
> Origination Fle:Conimat
View = Format = Fr i Detach firap @ Begmning D End 2 ofLines 50 Show File
> Servicing = 50} 5]
- Text
& Colerions 08/31/2017 12:35:32: cmnini cl 000 0i.initialize svc -
> WEP 08/31 :32: cmnsyp_cl 00 get_syp paramever value parameter: XAEPRC EM_100_02_DEBUG_LEVEL
> Tools 2: xaeprc_em submit for Bpp No:
: User code: INTERNAL
> Setup = x
2: 1v_statement - SELECT ptc_cur_currency code FROM xae ptc_evw WHERE FTC_COMEANY = :bl 1 |-

2. In the Database Server Log Files section, you can sort the list of logs to be displayed
based on following options:

e Select the ‘View Last’ option to display the logs based on elapsed days by selecting 1
Day /1 Week /1 Month / By Date. If ‘By Date’ option is selected, you can specify a date
range (within 3 months) in ‘Start Dt’ and ‘End Dt’ fields using the adjoining calendar.
Click ‘Search’.

e Select the ‘View’ option to further filter the list based on the type of logs to be displayed
by selecting Alert / Debug / Interfaces.

3. Click on = List Files button to view the list of logged files. A brief description of the fields
are given below

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the date and time stamp of file.

4. To extract a local copy of debug details, click & Download File button and save the file.

5. Inthe File Content section you can view the content of the file selected in the Database
Server Log Files by clicking & Show File button.

6. To sortthe view of file contents, select the order as either ‘Beginning’ or ‘End’ and specify
the value for ‘# of Lines’ to be displayed (default 50).

3.4.5 Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.
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3.4.6

To monitor users who have logged on to the system

1. Click Dashboard > Dashboard >System Monitor > Users.

ORACLE' e, ABSHEKAR 1 Signout &
Financial Services Lending and Leasing

System Monitor [®Close
Batch Jobs || Jobs | Services || Datsbase Server Log Files | Parked Transactions  Users 2
User Logins
Vien v Formatv 5y Freeze ffiDetach Wrap | ) ViewLast © 1Day © 1Week® 1Month @ By Date  start Dt 2 EndDt @ View User ) Current User @ All Users
User User Name: Detaiis Login Date and Tine L0002t Date and
Time
SURABH SURABHI DESAL 09/20/2017 04:56:... 12/30/4000 12:30s...
SURABHI SURABH DESAL 09/20/2017 04:44%... 12/30/4000 12:30:...
ABSHEKAR ANAND SHEKAR 09/20/2017 04:38:... 12/30/4000 12:30:...
PRITAM PRITAM JENA 09/20/2017 04:30:... 12/30/4000 12:30:...
SKsK SALSK 09/20/2017 03:5%.. 12/30/4000
» PRITAM PRITAM JENA 09/20/2017 03:47:... 12/30/4000 1
NAVEEN NAVEEN RECDY 09/20/2017 03:47:... 09/20/2017 04:55:
JAYANTA JAYANTAC 09/20/2017 02:37:... 12/30/4000 12:30:
SKSK SALSK 09/20/2017 02:35:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 02:08:... 12/30/4000 12:30:
PRITAM PRITAM JENA 09/20/2017 01:45:... 12/30/4000 12:30:
JAYANTA JAYANTAC 09/20/2017 01:45:... 09/20/2017 02:37:
PRITAM PRITAM JENA 09/20/2017 01:27:... 12/30/4000 12:30:
susv SHRIVATS SINGH 09/20/2017 01:20:... 12/30/4000 12:30
NAVEEN NAVEEN REDDY 09/20/2017 01: 14:... 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/20/2017 12:35:... 12/30/4000 12:30:
ABSHEKAR ANAND SHEKAR 09/18/2017 11:45:... 12/30/4000 12:30:
PHACHODA PHANINDRA CHODA 03/18/2017 11:37:... 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/18/2017 11:32:.. 12/30/4000 12:30:
NAVEEN NAVEEN REDDY 09/18/2017 11:21:... 05/13/2017 11:32: b

2. Inthe User Logins section, sort the list of records to be displayed based on elapsed days
by selecting 1 Day / 1 Week / 1 Month / By Date. If ‘By Date’ option is selected, you can
specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’ fields using the adjoining
calendar. Click ‘Search’.

A brief description of the fields is given below:

Field: View this:

User Displays the user ID.
User Name Displays the user name.
Details Displays the details.

Login Date and Time | Displays the login date time for the user.

Logout Date and Time | Displays the logout date time for the user.

Monitoring JMS Queues

OFSLL uses MDB infrastructure as an interface for asynchronous communication with third-
party integrated applications and all the outgoing communications through all the interfaces
are tracked in ‘JMS Queues’ tab.

The ‘JMS Queues’ tab in System Monitor screen facilitates as a dashboard to monitor the
status of all the configured MDB (Message-Driven Bean) queues and provides a statistics of
the total messages / requests that are sent from OFSLL to external system along with their
status.

The ‘JMS Queues’ tab has the following sub tabs:

e Status sub tab - to view the last status of configured MDB
e Messages sub tab

— To view the list of configured interfaces and total messages triggered to the
interface.

— To view the status of response for the message received from the interface.
— To ‘Re-submit’ failed messages.
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To view the status of all the configured MDB
1. Click Dashboard > Dashboard > System Monitor > JMS Queues. The Status sub tab
is displayed by default.

ORACLE 2 Welcome, ABSHEKAR ~ o
Financial Services Lending and Leasing

System Monitor 5 [#] Close

Batch Jobs  Jobs | Services  Database Server Log Files | Parked Transactions | Users  JMS Queues

Status = Messages

Status
View v Format v ’%’ Freeze ﬁ' Detach | Wrap @E} (@ Status

&
Service Description Last Updated Status
BIP MDB BIP INETRFACE MDB SUBMITTED -

! DIR TRACKMDB  DEALER TRACK INTERFACE MDB ronving |

EFX MDB EFX INTERFACE MDB R |
EMALL MDB EMALL MDB runving |
EXP MDB EXP INTERFACE MDB R |
GAI MDB GENERIC AUCTION INTERFACE MDB Runving |
GRI MDB GENERIC RECOVERY INTERFACE MDB roemng |
POSTDEALER MDE  POST DEALER INETRFACE MDB R e
ROUTEONEMDE  ROUTECNE INTERFACE MDB
TORQUETTSMDB  TORGUE ITS INTERFACE MDB

2. Inthe ‘Status’ section, you can view the following details of configured MDB:

Field View this:

Service Displays the name of the message service suffixed by MDB to
differentiate the different MDB services.

Description Displays the description or abbreviated name of MDB inter-
face.

Last Updated Status | Displays the status of MDB interface. Following are the status
displayed:

* UNKNOWN - indicates that no MDB infrastructure is con-
nected or status ping message is not sent to that MDB.

+ SUBMITTED - indicates that a dummy ping message is sent
to MDB.

* RUNNING - indicates that the message is consumed by
MDB infrastructure.

« STOPPED - indicates if MDB infrastructure is down.

3. Inthe ‘Status’ section, select the required service for which you need the status and click
Click & button. On clicking, a dummy ping is sent to the interfaced server and status in
‘Last Updated Status’ column is updated as ‘SUBMITTED’.

4. Click @ (refresh) button, to fetch the latest status and the response received is updated
in ‘Last Updated Status’ column.
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To view the messages triggered to all configured MDB
1. Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.

ORACLE’ # Welcome ABSHEKAR v o
Financial Services Lending and Leasing

System Monitor [3] Close
BatchJobs Jobs Services | Datmbase Server Log Files | Parked Transactions ' Users IJMS Queues Events 2
Status  Messages
Company ALL v View Last O 1 Day(O 1 Week(® 1 MonthO By Date  Start Dt End Dt @
Messages
£ Detach Wrap @
Service Description Submitted Completed Falled Resubmitted
WEBHOOK MDB  WEBHOOK MDB 132 18 104 3
EXP MDB EXP INTERFACE MDB 3 3 0 0
EVENTS MDB EVENTS MDB 145 145 0 4
Message Details [E] view
View~ Format~ [ Freeze [ Detach Wrap W
»
Message ID Request Type Request SubType  Message Type Status Message Content Time
95F4139888951EB... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TY TY.! I _TYPE=TXN... 10/28/2019 02:03... A
95F428A97024209... OUTBOUND EVENTS EVENT_ACTION  COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20190100034443|EVENT_TYPE=TXN... 10/28/2019 02:07.
95F642DA46FS57... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20100100034443|EVENT_TYPE=TXN... 10/28/2019 04:38.
96067A77ED607A... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:50...
96067A77ED627A... OUTBOUND EVENTS EVENT ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:59...
96067A77EDG47A... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-ASSOCIATE-0... 10/28/2019 11:59...
96067A77EDSE7A... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=DEMO-MOTORCYCLES-001|EVENT_T... 10/28/2019 11:59.
960B86096B66037... OUTBOUND EVENTS EVENT_ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20181100045447|EVENT_TYPE=TXN... 10/29/2019 06:00.
960B86006B6A03... OUTBOUND EVENTS EVENT ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20190100001582|EVENT_TYPE=TXN... 10/29/2019 06:00...
960B8609686C03... OUTBOUND EVENTS EVENT ACTION ~ COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_NBR=20190600062140|EVENT_TYPE=TXN... 10/29/2019 06:00... V
Response Message Details
View v Format v Freeze i Detach Wrap @ Viewoption ® BeginningOEnd  # Of Characters 50 [E] show File  [=] show Al
Text
No data to display.
< D)
v

2. Inthe ‘Messages’ section, filter the list of messages using the following options:

— Select the required Company from the drop-down list to view JMS message at
company level. The list is populated only with those Company Definitions to which
you have been provisioned access. By default, ‘ALL’ is selected.

— Select the ‘View Last’ option to display the messages based on elapsed days by
selecting 1 Day (default) / 1 Week /1 Month / By Date. If ‘By Date’ option is selected,
you can specify a date range (within 3 months) in ‘Start Dt’ and ‘End Dt’ fields using
the adjoining calendar.

3. The ‘Messages’ section displays the list of configured interfaces and the total of
messages exchanged between OFSLL and MDB in Submitted, Completed, Failed and
Resubmitted status. Click &l (refresh) button to update the latest status.

4. In the ‘Messages’ section, you can view the following details:

Field View this:

Service Displays the name of the message service suffixed by MDB to
differentiate the different MDB services.

Description Displays the description or abbreviated name of MDB inter-
face.

Submitted Displays the total count of requests submitted.

Completed Displays the total count of requests completed.

Failed Displays the total count of requests failed.

Resubmitted Displays the total count of only those requests which are

failed and resubmitted again for processing.

To ‘Re-submit’ failed messages
1. Click Dashboard > Dashboard > System Monitor > JMS Queues > Messages tab.

2. Inthe ‘Messages’ section, select the required MDB interface.
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3. The ‘Message Details’ section below displays the list of messages sent to the interface
with the following details:

Field View this:
Message ID View the system generated MDB message ID
Request Type View the message request type

Request SubType View the message request sub type

Message Type View the message identifier
Status View the message processing status
Response This column data is displayed only for Webhook MDB.

View the HTTP Header received as response during Web-
hook event action invocation.

Message Content View the message content

Time View the message time stamp

4. Inthe ‘Message Details’ section, select the message in ‘Failed’ status. Click [@l (refresh)
button to update the latest status.

5. (Optional) You can click ‘View’ to display the selected record in ‘Message Details’ section.
6. Click B Re-submit. The details are triggered again for processing and the ‘Resubmitted’
counter in ‘Messages’ section is updated along with other counters.

Response Message Details

This section is enabled if Events or Webhook type of MDB service is selected in Message
section and displays the request Message Details that is propagated to external system for
the posted event action.

To view ‘Response Message Details’ of an Event
1. Select the required record from the Message Details section and click ‘Show File’.

e The first 50 characters of the request in json format is displayed since the default
preference selected is ‘Beginning’ in View option and ‘# of Characters’ is set to 50.

2. You can customize the preference using View Option (Beginning / End) and specifying
the number of characters to be displayed.

3. Also you can click ‘Show All’ to display the complete request.

Monitoring Events

The Events screen is a dashboard to view all the Events triggered in the system. In the Events
screen you can view the latest status of all the processed events and ‘Re-submit’ only failed
events for re-processing. However, this is a display-only field and does not allow to modify the
defined event action parameters.

The Events screen has the following sections:

e Event Actions
e Action Parameters

In the ‘View Options’ section, you can filter and view the list of Events based on following
Status:
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e ALL
e SUBMITTED

e WAITING FOR USER INPUT
e COMPLETED

e FAILED

e CRITERIANOT MET

e VOID

In the ‘View Last’ section, you can further sort the volume of records displayed on the Events
screen with the following options:

Select: System Displays:

1 Day List of all events posted in last one-day.

1 Week List of all events posted in last one-week.

1 Month List of all events posted in last one-month.

By Date List of all events posted between specific dates. You can specify a date
range (within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoin-
ing calendar.

To View the Events triggered in the system

1. On the Oracle Financial Services Lending and Leasing home screen, Click Dashboard >
System Monitor > Events tab.

ORACLE’
Financial Services Lendi

ng and Leasing

# Welcome ABSHEKAR ¥ o

a

System Monitor

Event Actions
View Options  ALL

View > Format~ [}

Entity Nbr Event Code

Freeze

ASSO_ABHI_INT_.... EVENT TO PROCE.

Action Parameters
Viewv Formatv [
Description
REQUEST TYPE
SOURCE
REPORT
CUSTOMER RELATION

Freeze

LINK_ABHI_INT_0... EVENT TO PROCE...
LINK_ABHI_INT_0... EVENT TO PROCE...
LINK_ABHI_INT_O... EVENT TO PROCE...
M LINK_ABHI_INT_0... EVENT TO PROCE...

BatchJobs Jobs Services Database Server Log Files Parked Transactions Users JMS Queues Events

View Last (O 1 Day() 1 Week®) 1 Month(O) By Date Start Dt

\i Detach
Event Query
PENDING_EVENT_ACTIONS
PENDING_EVENT_ACTIONS
PENDING_EVENT_ACTIONS
PENDING_EVENT_ACTIONS

Wrap

EVENT_ACC_UPDATE_BATCH_LOAN

i Detach Wrap

@ [B Re-submit

Event Action
REQUEST FOR CR...
SEND LETTER
CREATE REVIEW
CREATE WORK OR...
CREATE REVIEW

@

End Dt

Process Type
ONLINE
ONLINE
ONLINE
ONLINE
BATCH

Failure Count
0

0
0
0
0

Value Type
CONSTANT
CONSTANT
CONSTANT
USER INPUT

[3] Close

Status

FAILED

WAITING FOR US...
WAITING FOR US...
WAITING FOR US...
COMPLETED v

Run Dt
11/01/2019 03:07... A

Value
MANUAL
EXP
FICO

Required

2. By default, the Events screen displays all events posted in last one day.
3. Inthe ‘Event Actions’ section, view the following information:
Field: View this:
Entity Nbr Entity Number on which event generated.
Event Code Event Definition Description.
Event Query Event Criteria Definition Description.
Event Action Event Action Description.
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Field: View this:

Process Type Event processing type as either Online/Batch fetched
from EVENT_PROCESS_TYPE_CD lookup.

Failure Count Number of times the event processing has failed.

Status Event action with following execution status:
CRITERIA NOT MET

SUBMITTED

VOID

COMPLETED

FAILED

ALL

WAITING FOR USER INPUT

Run Dt Event Action Generation Date and Time.

4. Inthe ‘Action Parameters’ section, view the following information:

Field: View this:

Description Event Action Parameter Description.

Value Type Event Action Input Parameter Type.

Value Value defined for the event action.

Required Y/N indicating if the Action Parameter is mandatory.

Re-submit Failed Events

In the Events screen you can filter and re-submit only the ‘FAILED status Online Event
Actions’ for processing. An Event is marked with ‘Failed’ status when the same could not be
processed in the system due to setup/infrastructure issues. This is an additional option to re-
process the event actions. On resubmitting an event, the Failure Count against the record is
incremented by 1.

However, ‘Resubmit’ option is not allowed for Webhook and SEND JMS MESSAGE actions
since the same functionality is available in JMS Queues.

In the ‘Event Actions’ section, select the required event record listed with status FAILED and

click ‘RE-submit’. On triggering the event, the ‘Run Dt’ column is updated with Event Action
Generation Date and Time. Click ‘Refresh’ to fetch the latest status.

Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.
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Navigating to Producer Analysis
Click Dashboard > Dashboard > Producer Analysis.

ORACLE’ . . 5 & Welcome, PRAKRRAO v o
Financial Services Lending and Leasing
Producer Analysis 5
Select Criteria
Users Productivity
System Monitor Company ALL [] Territory - Funder AL & —
Producer Analysis Branch ALL[w] Sales Agent ALL [~] Status - = v
Process Files
TmeEhE Region AL [v] Undenwriter ALL [v] zip v
Producers | Terrtories Activity | Volume || Mix
> Dealer
> o
Recent Activity
MonBE th digiy, Last Funded Approved Funded Comments
No data to display.
Recently Approved Applications
Applicant Name _ Application # Amt Collateral Desc
Mo data to display.
1
Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
No data to display.
4
Recent Comments
& Detach Wrap
Date Comment Desc
No data to display.
> Origination
> Servicing
> Collections
> WFP
> Tools
> Setup

[ Close.

You can filter producer details based on any or all of the following criteria:

e Company

e Branch
e Region
e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System

displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #
e Name

e Company
e Branch

e Type

Select the producer you need to view the statistics. The system displays the statistics under

‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’

sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year
e Total Apps
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Approved
Conditioned
Rejected
Withdrawn
Funded
Amount

The system displays the following details under ‘Applications’ sub tab:

Company
Branch
App #
Date

Title
Product
Status

Sub Status

Process Files

The Process files screen allows you to view the incoming and outgoing files exchanged
between OFSLL and other interfaced systems for processing and also perform a bulk upload
of required files.

The Process files interface also provide information on the type of files uploaded along with
other attributes. In-order to facilitate the process files handling, the following parameters has
to be enabled in Setup > Administration > System > System Parameters screen. For more
information on enabling system parameters, refer to ‘System Parameters’ section in Setup
Guides.

CMN_FILE_PROCESS_TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

UIX_INCOMING_FILE_PATH
UIX_OUTGOING_FILE_PATH

On enabling the above two parameters, the incoming and outgoing file path of
application server need to be defined to the required folder path by updating the
‘Parameter Value’ which by default is ‘SETME’. (For example: /tmp)

If both the parameter ‘CMN_FILE_PROCESS_TO_LOB’ and ‘OUTBOUND_CALL_Q’
are enabled (status ='Y"), system automatically handles upload/download of files from
Weblogic configured process files.

Depending on the CLOB parameter option, if set to ‘Y’ the incoming/outgoing file directories
are to be manually created in Web Logic server. For details of directories, refer to ‘Creating
Application Home directory’ section in Database Installation Guide.
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Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system for immediate processing.

ORACLE"

Financial Services Lending and Leasing

NextGenUl M Welcome, ABSHEKAR v 1 signout O

Process Files x (3 Close
Incoming Process File | Outgoing Process File
Incoming Process File
View v Format v |52 Freeze [ Detach @ iSistFles [@uUpload Company AL v
¢0 m/ddfyyyy B
SelectAll () DirectoryName  File Name File Type File Size(bytes)  File Date Status
Jscratch/ofsll_hom... customer_pmt_extract_ALL_20200302.dat 127205 03/02/2020 NONE
Uploaded Files
> 3 " Wr View Last O 1 Day O 2 Days O 5 Days @ All D 3 £
View v Format v [ Freeze i Detach Wrap @ Viewlast O1Day O 2Days O 5Days ays @ Download Bad Data (@ Download Log Data ~ Company ALL v
File Name File Type File Dt Status User
SYSTEM_PARAMETERS. DAT FACTORY DATA UPLOAD 04/20/2021 PROCESSED subhash hegde hegde
OJET_MENU_ACCESS.DAT FACTORY DATA UPLOAD 04/19/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/16/2021 PROCESSED subhash hegde hegde
FLS_ACCESS_DETAILS.DAT FACTORY DATA UPLOAD 04/16/2021 PROCESSED subhash hegde hegde
FLS_ACCESS.DAT FACTORY DATA UPLOAD 04/16/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/15/2021 PROCESSED subhash hegde hegde
FLS_ACCESS.DAT FACTORY DATA UPLOAD 04/15/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/14/2021 PROCESSED subhash hegde hegde
ENDPOINT_LEDGER.DAT FACTORY DATA UPLOAD 04/13/2021 PROCESSED subhash hegde hegde
ACCESS_GRID_FUNCTIONS.DAT FACTORY DATA UPLOAD 04/12/2021 PROCESSED subhash hegde hegde -
»

View the list Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming

files.

A brief description of the fields is given below:

Field:

Description:

Select All

Select this option to select all the listed files.

Directory Name

View the directory path where incoming file is stored.

File Name

View the name of the file.

File Type

View the type of incoming file. The file type is auto populated
based on ODD (Output Data Definition) details maintained for
the specific file type in INCOMING_FILE_TYPE_CD lookup.

File Size(bytes)

View the size of incoming file.

File Date View the date and time when the incoming file was placed in
the directory.
Status View the status of the file.

Upload Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. In the Company drop-down list, select the portfolio company. Based on the Company
selected, system processes Incoming files. If the company is selected is ALL, system

processes the upload file related to any company.
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3.6.2

However, the Company list is populated only with those Company Definitions to which
you have been provisioned access. This company is considered if system is setup to
process batch jobs at Company level. For more information, refer to ‘Appendix -
Company Level GL Date Configuration’ section.

4. Select the check box adjacent to the required file and click Upload. You can also click
Select All check box to perform a bulk upload of all the listed files.

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2
Days / 5 Days / All Days. You can click [@) to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date and time when the file was uploaded.
Status View the status of upload.

User View the login ID of User who performed the file upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

e Sort the list of uploaded files based on specific company by selecting the same from
‘Company’ drop-down list.

Proration of Future Account Dues

OFSLL has a facility to derive future dated dues on an account using the input file processing
mechanism. This helps to view the future dues on accounts in bulk even before posting on the
account and without generating a mock statement on the account.

Similar to other input files processing, the required Account numbers and ‘Due Dates’ on
which the due is to be calculated are to be added as individual record in the file and uploaded
into the system by placing in input folder path. For more information on this process, refer to
above section.

The Input file is processed in the system on running the batch job IADPRC_BJ_100_01
(ACCOUNT DUES FILE UPLOAD) in SET-IFP batch job set and to the location as per the
system parameter CMN_FILE_PROCESS_TO_LOB value.

Using an internal function, system calculates the future dated due for the specific Account(s)

and stores the computed values in database table. The same has to be queried to view the
details. The due amount returned by this function is the regular bill amount calculated without

3-22 ORACLE



considering any other outstanding dues. This is the proration amount that is posted on the
same account before the next due is generated.

Note that, only ACTIVE status accounts are processed. Else system displays an error
indicating ‘Invalid Account Status’.

3.6.3 Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

ORACLE" . ) NextGenUl 1 Welcome, ABSHEKAR v 1g sign out O
Financial Services Lending and Leasing

Process Files x [36] Close:
Incoming Process File  Outgoing Process File
Outgoing Process File
View v Formatv Freeze [ Detach Wral @ (B Download  Viewlast O 1Day O 2Days O 5Days @ All Days Company ALL v
SelectAll (J File Name File Type File Date File Size(bytes) Status
Schema_Redaction_Policies.sql REDACTION POLL... 03/01/2021 236305 GENERATED
(=] Schema_Redaction_Policies.sql REDACTION POLI... 03/01/2021 236305 GENERATED
(@] Schema_Redaction_Policies.sal REDACTION POLL... 03/01/2021 236305 GENERATED
(E] Lnx_bkrp_output_INDIA_20210225_115824.spr OUTPUT DATA FIL... 02/25/2021 1822 GENERATED
(=] master_customer_business_statement_20210219.dat OUTPUT DATA FIL... 02/24/2021 28 GENERATED
O Lnx_bkip_output_INDIA_20210224_173223.spr OUTPUT DATAFIL... 02/24/2021 1822 GENERATED
M O customer_pmt_extract_INDIA_20210219.dat OUTPUT DATA FIL.. 02/24/2021 0 GENERATED
a Lnx_bkrp_output_INDIA_20210224_164549.spr OUTPUT DATA FIL... 02/24/2021 1822 GENERATED
[m] payable_requisition_export OUTPUT DATAFIL... 02/24/2021 5495 GENERATED
(@] producer_stmt 02/24/2021 28 GENERATED -
>
History
View v Format v Freeze [ Detach Wrap ®
User Download Dt
RAKESH BOINA 03/01/2021

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.

On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.

File Name View the name of upload file.

File Type View the type of file shared for upload. The file type is auto pop-

ulated based on ODD (Output Data Definition) details main-
tained for the specific file type in OUTGOING_FILE_TYPE_CD

lookup.
File Date View the date and time when the file was shared for upload.
File Size(bytes) View the size of upload file.
Status View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.

System displays the list of files shared for upload. You can click ¥ to refresh the grid
data.

2. In the Company drop-down list, select the portfolio company. Based on the Company
selected, system processes Incoming files. If the company is selected is ALL, system
processes the download file related to any company.
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However, the Company list is populated only with those Company Definitions to which
you have been provisioned access. This company is considered if system is setup to
process batch jobs at Company level. For more information, refer to ‘Appendix -
Company Level GL Date Configuration’ section.

3. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.

History

The history section displays the following details:
Field: Description:
User View the login ID of User who downloaded the file.
Download Dt View the date and time when the file was downloaded.
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4. Customer Service

Introduction

After an application has cycled through the Line of credit origination process, it becomes an
account. Account maintenance and collections tasks can be performed with Oracle Financial
Services Lending and Leasing’s Customer Service screen.

The Customer Service screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using Funding main tab or
convert from a legacy system. You cannot activate an account using the Customer Service
screen.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen. You cannot post and
reverse the payment in Customer Service screen. (For more information, see the Payment
Processing chapter).

Account Mask

After an application completes the Line of credit origination cycle and is funded or is ported
into the system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Quick Search section

Conditions and Queues

During the Line of credit application process, Accounts do not have sub statuses; instead,
accounts use conditions. Conditions further define the status of an account; for example:
delinquent, bankruptcy, scheduled for charge off, Do Not Charge Off. Conditions can be
applied automatically by the system based on set up, and manually by the system users using
Customer Service screen.
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However note that, when an application is funded as an accountin OFSLL, a default condition
is posted on the account as 'NO ACTIVE CONDITION'. This can be viewed in Summary tab
‘Conditions’ section. This condition is available in the Queue Criteria drop-down to create
Queue of Accounts with NO ACTIVE CONDITION. On posting any other condition on the
account, this default condition is replaced automatically and an entry is updated in Account
Details > Condition Details > Condition/Queue History tab.

The system can assign accounts to specific users by way of queues. Queues are a work flow
management tool that allow the users to work on accounts sequentially from a prioritized list,
rather than having to manually search for and load them. Queues are created and sorted
during nightly processing. Examples of customer service queues include due date change
requests, delinquent accounts, deferment requests, and title and insurance follow-up.

Account conditions serve as default queues; that is, an account’s condition determines which
queue the account is in.

In the following example, account has a condition of DELINQUENT, noted in the Conditions
section and Status field. The account was loaded from delinquent queue, DELQ (D).

A queue can be associated with only one condition. In the following example, the Delinquent
queue is associated with the Delinquent condition. However, an account can have more than
one condition, so an account can be in more than one queue. Multiple queues can be created
for a single condition. Account attributes (such as number of days delinquent and product
code) can be used for assigning accounts to a queue and sorting accounts within a queue.

You can quickly load an account from a queue using Next Account button in the Quick
Search section.

Customer Service screen

Most of the screens on Customer Service screen contain Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in Account(s) and Customer(s) sections, open Customer Service
screen and load the account you want to work with.

On Customer Service screen’s Account(s) section, view the following information: The
system filters and displays information based on your selection:

Command Action Performed:
Button:
Current Displays the current searched account only. It does not matter how

that account was searched like using account search screen or
selected a queue from drop-down and pressed ‘Next’ button or
account number was directly entered in Acc# search field and
pressed Submit button.This is the default option.
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Command
Button:

Action Performed:

Show All

Displays the related accounts based on current selected customer’s
customer Id or list of enabled business accounts matching with 'Tax
Number' of current selected business. To view the details of account
number(s) other than current account, select the account in
Account(s) section.

Group Follow-
up

Displays the set of accounts that share same account condition as
the selected account and bear same Customer/Business Id. Other
than having same account condition and Customer/Business Id, the
queue currently selected should have the Group Follow-up Indicator
enabled in queue setup and follow-up date should fall in range of
organization level system parameter UCS_GROUP_FOLLOWUP_-
DAYS.

Associated
Accounts

Displays all the Associated Accounts if the selected account is a
Master Account. This option is not selected by default.

Following are the other combinations on how system displays the
accounts:

- If the selected account is a Master Account, selecting this option
displays all Associated Accounts (if exists) of the Master Account
including the Master Account.

- If the selected account is an Associated Account linked to a Mas-
ter Account which also has other Associated Accounts, then system
displays all Associated Accounts of the Master Account including
the Master Account.

- If the selected account is not linked to any Master Account, then
system displays only the current selected account.

- If the selected account is the only Associated Account linked to a
Master Account, then system displays the current selected account
and its Master Account.

However, on selecting individual account record, system displays
the respective account details in all Servicing > Account tabs.

Agreement
Number

The option is enabled only on selecting ‘Associated Accounts’ as the
filter criteria and provides a drop-down list with all unique agreement
numbers present in the sorted list of account(s).

On selecting any of the Agreement Number from the drop-down list,
system filters and displays only those accounts associated with the
selected agreement number.

In Account(s) section, click View to view the following information:

In this field: View this:
Company The company of the account.
Branch The branch of the account.
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Account #

The account number.

Note: This can also be the external reference number in case of
conversion accounts if the value of system parameter
AUTO_GEN_ACC NBR _CONV is setto ‘N'.

Master Account
#

View the Master Account number of the customer.

During the funding process, an application can either be marked as
‘Master Account’ or ‘Linked to Existing Master Account’ in the Mas-
ter Account tab of Origination screen.

- If marked as Master Account, system populates the Master
Account # which is same as Account #.

- If Linked to Existing Master Account, system populates the
selected Master Account #.

- If the Application is neither marked as ‘Master Account’ nor ‘Linked
to Existing Master Account’, then this field is displayed as UNDE-
FINED.

Master Account

View the Master Account indicator value propagated from Origina-
tion on funding an application. ‘Y’ indicates that the current account
is a Master Account and ‘N’ indicates its not.

Product

The product for the account.

Days Past Due

The total number of days elapsed past due date.

Currency

The currency for the account.

Pay Off Amt

The current payoff amount for the account.

Amount Due

The current delinquent amount due for the account.

Status

The account’s status.

DLQ Reason

The delinquency reason that gets auto updated by the system as
one of the following when the account is marked delinquent.

- 1st Payment Delinquency, when the first payment is delinquent.

- NSF Delinquency, when the payment amount on due date results
in NSF (non sufficient funds) in the account.

- Matured Delinquency, when account reaches the ‘Maturity Date’
with some delinquency amount.

Note: System automatically removes the delinquency reason on the
account if the payment is received. However, if the same payment is
reversed, the conditions are posted back.

Oldest Due Dt

The oldest due date.
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Sales Order View the Sales Order Number propagated from Origination after
Number funding the application.

If Sales Order Number is Null or blank indicating that the same was
not specified during origination, you can add/update the Sales
Order number to the account by posting SALES ORDER NUMBER
MAINTENANCE non-monetary transaction. Refer to Appendix -
Non Monetary Transaction section for more details.

Note: In ERP systems, Sales Order Number is created to capture
the sale of Products & Services. A Sales Order Number may be
associated to multiple Accounts in OFSLL and in-turn helps to
group all those accounts with the same sales order number.

Statement Con- | View the statement Consolidation indicator propagated from Origi-
solidation nation > Funding screen or updated by posting Master Account -
Statement Consolidation Indicator Maintenance non monetary
transaction.

If checked, indicates that system generates consolidated billing
statement at Master Account level along with details of all the asso-
ciated accounts.

If unchecked, system generates billing statement to only current
account.

The system allows quick search of an account through Quick Search section in the right hand
side of screen irrespective of the customer service screen on which you are working on. This
is available in addition to the Quick Search section available in Results tab.

For more details on Quick Search refer ‘Search Functions’ chapter.

Comments can be added using Add Comment section in the right hand side of screen
irrespective of screen you are working on. This is available in addition to the Comments sub
tab available under Customer Service tab. This facilitates quick and easy reference.

For details on Comments refer Comments sub tab section in this chapter.

Call Activity functionality can be performed using Add Call Activity section in the right hand
side of screen irrespective of the screen you are working on. This is available in addition to

the Call Activities sub tab available under Customer Service tab. This facilitates quick and
easy reference.
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4.3

For details on Call Activity refer Call Activities sub tab section in this chapter.

ORACLE’
Financial Services Lending and Leasing

Customer Service

Search  Customer Service: 20190100010128  Review Request (Pending: 0)

Account(s): 20190100010128: TEST LINE

Summary  Collections ~ Customer Service  Account Details

Alerts

Customer Details

Queue Assignment

Customer Preferences

Transaction History

Pmt Modes

Bankruptcy ~ Repo/Foreclosure

View v Formatv [ Freeze i Detach Wrap MW & @ curentO show AlO Group Follow-up O Associated Accounts
Company Branch Sub Unit Account # Master Account #  Master Account Product Billing Cycle Purpose Days Past Due Currency
usot USRL UNDEFINED 2019100010128 UNDEFINED N LINE HE (VR) MONTHLY VEHICLE LOAN OR... 59 USD
Q >

Deficiency ~ Collateral

Conditions
] Alerts Conditions
Nert Account Condition Condition Start Dt Followup Dt
PAYABLE REQUISITIONS SENT TO THIRD PARTY CHECK PRINTING SYSTEM ~ NATURAL DISASTER 10/04/2019 10/04/2019
PAYABLE REQUISITIONS SENT TO THIRD PARTY CHECK PRINTING SYSTEM REPOSSESSION 09/16/2019 09/19/2019
PAYABLE REQUISITIONS SENT TO THIRD PARTY CHECK PRINTING SYSTEM v
Account Details Other Information

Dues Collateral Information
08/01/2019 07/01/2019 06/01/2019 05/01/2019 04/01/2019 Primary Description Identification # Year  AssetClass Asset Type
0.00 0.00 0.00 0.00 0.00 Y 2 DFFDGFD 2 NEW HOME ~
N 2019 TEST LINE 2019 USED TRAVELSHAI
Delq Due 0.00 Total Due(ind 0.0 Oldest Due Dt 09/01/2019 N 0 0 NEW HOME v
LCDue 0.00 aurrent due) Amt Paid Excess 0.00 < >
NSF Due 0.00 Todays Payolf 0.00 Memo Excess 0.00
Other Due 0.00 Future Payoff 0.00 Amount -
A Future Payoff Date 11/09/2019 Paid Term 6 Customer Information

[E view | & Audit

Bureau | Timeli > ¥ A

Customer Service screen’s Summary tab

Open Customer Service screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

Financial Services Lending and Leasing
Customer Service (3] Close
Search  Customer Service: 20190100010128  Review Request (Pending: 0)  Queue Assignment ~
Account(s): 20190100010128: TEST LINE B view | & Audit
View v Formatv [ Freeze [ Detach Wrap W & ©curentOshow AlO Group Follow-upO Associated Accounts
Company Branch Sub Unit Account # Master Account #  Master Account  Product Billng Cycle Purpose Days Past Due Currency
Uso1 USR1 UNDEFINED 20190100010128  UNDEFINED N LINE HE (VR) MONTHLY VEHICLE LOAN OR... 50 USD.
* >
Summary  Collections | Customer Service ~ Account Details ~ Customer Details | Customer Preferences | Transaction History | PmtModes | Bankruptcy | Repo/Foreclosure  Deficiency | Collateral | Bureau  Timeli > ¥ A
Alerts Conditions
Alerts Conditions
Nert Account Condition Condition Start Dt Followup Dt
PAYABLE REQUISITIONS SENT TO THIRD PARTY CHECK PRINTING SYSTEM ~ NATURAL DISASTER 10/04/2019 10/04/2019
PAYABLE REQUISITIONS SENT TO THIRD PARTY CHECK PRINTING SYSTEM REPOSSESSION 00/16/2019 00/19/2019
PAYABLE REQUISITIONS SENT TO THIRD PARTY CHECK PRINTING SYSTEM v
Account Details Other Information
‘4
Dues Collateral Information
08/01/2019 07/01/2019 06/01/2019 05/01/2019 04/01/2019 Primary Description Identification # Year  AssetClass  Asset Type
0.00 0.00 0.00 0.00 0.00 Y 2 DFFDGFD 2 NEW HOME ~
N 2019 TEST LINE 2019 USED “TRAVELSHAF
Delq Due 0.00 Total Due(incl  0.00 Oldest Due Dt 09/01/2019 N 0 0 NEW HOME e
LCDue 0.00 current due) Amt Paid Excess 0.00 < 5
NSF Due 0.00 Todays Payolf 0.00 Memo Excess 0.00
Other Due 0.00 Future Payoff 0.00 Amount -
Total Due 0.00 Future Payoff Date 11/09/2019 Paid Term 6 C"Sf“f‘f[ Information v

Alerts section

Any comment posted as an alert, are displayed in the alert section of Summary tab.

Conditions section

You can view any conditions like Bankruptcy, Repossession, Foreclosure etc posted on an
account. The condition is posted in the account with a start date which is the effective date
and follow up date which indicates the next follow-up date for further process.

For newly funded account, a default condition is posted as 'NO ACTIVE CONDITION'. This
condition is available in the Queue Criteria drop-down to create Queue of Accounts with NO
ACTIVE CONDITION. On posting any other condition on the account, this default condition is
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replaced automatically and an entry is updated in Account Details > Condition Details >
Condition/Queue History tab.

Dues section

Unpaid dues and the dates are displayed in a tabular form. Details of payment amount due,
fee due, payoff are also displayed.

In this field: View this:

Delq Due The total delinquent amount that is due so far in the account.

LC Due The total amount of non-sufficient fee due in the account.

NSF Due The non sufficient funds fee due.

Other Due The total of any other dues pending in the account.

Total Due The total of all dues including payment amount and all applicable

fees.

Total Due (incl
current due)

The additional due of current month (included based on pre-bill
days).

Today’s Pay-
off

If the account is to be paid off as per the current date and the
amount payable by the borrower.

Future payoff

The total Amount due on a future date. The borrower can know the
total pay off amount for a future date, say 10 days from today.

Future Payoff
Date

The date on which the future payoff is due.

Future Pmt Dt

The date till which the future payoff quote is valid.

Oldest Due Dt

The due date.

Amt Paid
Excess

The excess amount paid.

Memo Excess

The excess amount paid towards the membership fee.

Amount

Paid Term The total count of paid dues.

Remaining The total count of remaining outstanding dues to be paid.
Term

Days to Time
Bar

View the total number of days remaining to reach the time bar end
date.

Delinquency Information Section

View the following information in the Delinquency Information section:

In this field:

View this:

Late

Total number of times the account was delinquent for less than 30 days
since start date.
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In this field:

View this:

30 Total number of times the account was delinquent for over 30 days
since start date.

60 Total number of times the account was delinquent for over 60 days
since start date.

20 Total number of times the account was delinquent for over 90 days
since start date.

120 Total number of times the account was delinquent for over 120 days
since start date.

150 Total number of times the account was delinquent for over 150 days
since start date.

180 Total number of times the account was delinquent for over 180 days
since start date.

Category The delinquency category.

Days The number of days delinquent. A negative number in this fields
denotes the number of days until a payment is due.

Broken Total number of broken promises since the account start date.

Promises

(Life)

Broken Total number of broken promises since this year.

Promises

(Year)

Note that, the above fields - Broken Promises (Life) and Broken Promises (Year) are
auto-updated at runtime after executing the scheduled batch job CPPPRC_BJ_100_01
(BROKEN PROMISE PROCESSING) with the method of update defined in Company
parameter FUTURE PROMISE HANDLING METHOD (CMN_PROMISE_FU-

TURE_MTHD).

Kept Prom-

Total number of fulfilled promises since the account start date excluding

ises (Life) Broken and Cancelled Promises.

Kept Prom- | Total number of fulfilled promises since this year excluding Broken and
ises (Year) Cancelled Promises.

NSF (Life) Total number of non sufficient funds since the account start date.

NSF (Year) Total number of non sufficient funds since this year.

Collector The default collector working on the account.

Activities Section

View the following information in the Activities section:

In this field:

View this:

Active Dt

The date account was made active.
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In this field:

View this:

Last Activity Dt

The date on which most recent activity was performed in the
account.

Due Day

The due day for payment.

Last Pmt Amt

The last payment amount.

Customer The customer grade.

Grade

App# The application number from which this account was created.
Producer The producer through which the account was sourced.

X-ref The cross reference number of third party origination system.
Paid Off Dt The date on which account was paid off.

Note: Filed has value only if account has Paid-off condition.

Effective Dt

The date account became effective.

Current Pmt

The current payment amount.

Last Bill Amt

The last bill amount.

Last Pmt Amt

The last payment amount.

Chargeoff Dt The Date on which account was charged off.
Note: This is applicable only if account has Charged-off condition.
Else, no value displayed.

Military Duty If selected, indicates that at the time of billing, the customer was in

active military duty and qualifies for rates in accordance with Ser-
vice members Civil Relief Act (SCRA) of 2003.

Customer Score

The customer score.

Behaviour
Score

The behavior score.

Due Date Change section

The Due Date Change section displays the remaining number of transactions available for the
account in the Summary tab. You can view the following information under Due Date Change

section.
In this Field: Do This:
Last Txn Dt The last date on which the due date was changed.

Rem. Txn. Limit
(Life)

Remaining number of due date changes allowed till account clo-
sure.

Rem. Txn. Limit
(Year)

Remaining number of due date changes in the account for current
calendar year.
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Extensions section

The Extensions section displays the remaining number of transactions available for the
account in the Summary tab. You can view following extension details as per the conditions
maintained in the contract.

In this Field: Do This:

Rem. Txn. Limit | Remaining number of extensions in the account for current calen-
(Year) dar year.

Rem. Txn. Limit | Remaining number of extensions in the account till closure.
(Life)

Last Txn Dt The date when last extension was made.

Exten. Gap The number of months remaining before you can post Extensions
Rem. (Months) for an account.

Contract Information

You can view the contract information recorded during the funding process. It’s a display only
version of the same information found on the Funding screen’s > Contract screen.

In this Field: Do This:

Contract Dt View the contract funded date.
Term View the contract term.

Rate View the interest rate.

Maturity Dt View the contract maturity date.
Credit Limit View the total credit limit issued.

Collateral Information section

You can view the Collateral Information in this section:

In this field: View this:
Primary If selected. indicates that this is the primary collateral.
Description A brief description on the collateral.

This is a hyper-link which when clicked opens Collateral Manage-
ment screen with relevant collateral details.

Identification # The identification number of the collateral.

This is a hyper-link which when clicked takes you to the collateral
management screen with the relevant asset details.

Year The year of manufacture of the collateral.
Asset Class The asset class of the collateral.
Asset Type The type of collateral.
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Sub Type

The sub type of the collateral.

Customer/Business Information section

On Customer Service screen’s Customer Information section, select the record you want to
work with. Based on type of account selected as either Customer or Business, you can view
the related information as indicated below:

For a Customer account, view the following details:

In this field: | View this:
Customer # | Customer identification number (unique customer identifier).
Name Customer’s full name.
Relation Customer’s relationship to the account.
SSN Customer’s social security number.
If the organizational parameter UIX_HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXX-XX-1234.
National ID Customer’s national identification number.
Birth Dt Customer’s date of birth.
Gender Customer’s gender.
Email Customer’s e-mail address.
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Additional Customer Details

In this field: | View this:

Email Customer’s e-mail address.

Language Language spoken by the customer.

Marital Sta- | Customer’s marital status.

tus

Disability Customer’s disability indicator If selected, this indicates that the cus-
tomer is disabled.

Skip Customer’s skip indicator. If selected, this indicates that the customer is
a skip debtor. This is selected using the Maintenance screen.

Stop Corre- | Stop correspondence indicator. If selected, Oracle Financial Services

spondence Lending and Leasing will not send correspondence to customer. This is
selected using the Maintenance screen.

Privacy Opt- | Privacy opt-out indicator. If selected, indicates that customer does not

Out want the FI to share his /her information with any other body, other than
regulatory requirements. (optional).

Active Mili- Customer’s Active Military Duty indicator. If selected, this indicates that

tary Duty the customer is serving Military Duty. This is selected using the Mainte-
nance screen.

Time Zone Customer’s time zone.

For a Business account, view the following details:

In this field: | View this:

Business # | The registered business number.

Name of the | The name of the business.

Business

Organiza- The type of Organization to which the business belongs.
tion Type

Business The type of Category to which the business belongs.
Category

Type of The type of business.

Business

Legal Name | The legal name of the business.

Tax ID # The taxation identity number of the business.
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Additional Business Details

In this field:

View this:

Email

Business e-mail address.

Contact Per-
son

The contact person at the business.

Start Dt The Business start date.

Manage- The year the current management was established.

ment Since

Bankruptcy | Business’s bankruptcy indicator.

Skip Business’s skip indicator. If selected, indicates that the Business has
debts and the customer is a skip debtor.

Stop Corre- | Stop correspondence indicator. If selected, Oracle Financial Services

spondence Lending and Leasing will not send correspondence to Business.

Privacy Opt- | Privacy opt-out indicator. If selected, indicates that Business does not

Out want the financial information to share information with any other body,
other than regulatory requirements.

Time Zone Business time zone.

Address Information section

This section displays Customer Address or Business Address depending on the type of
account selected as either Customer or Business only account.

In this field: | View this:

Type Address type.

Current If selected, indicates that this is the current address.
Permission If selected, indicates that you can contact the customer.
to Call

Mailing If selected, indicates that this is the mailing address.
Address Address details.

Phone Phone number.

Employment Information section

The section is not displayed for Business only accounts. The details defined in Customer
Service > Customer Details > Employments tab are populated here.

In this field: | View this:
Type Type of Employment as PART TIME, FULL TIME and so on.
Current If selected, indicates that this is the current employer.
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Permission
to Call

If selected, indicates that you can contact the employer.

Employer Employer Details.

Next Pay The next payment day of the month.
Day

Frequency Frequency of the payment.
Address Address details.

Phone Phone number.

Telecom Information Section

This section displays Customer Telecom or Business Telecom depending on the type of
account selected as either Customer or Business only account.

In this field: | View this:

Type The type of phone contact such as Home / Office / Car / Mobile phone.
Current If selected, indicates that this is the current phone contact.
Permission | Permission as either Yes ‘Y’ or No ‘N’ to contact the customer over
to Call phone.

Phone The customer’s phone number.

Extn The customer’s phone extension.

Time Zone The customer’s time zone.

Best day to | Preferred day of the week to contact the customer, if specified.

call

Best Time Preferred time to contact the customer, if specified.

To Call

Outbound Call History

Displays outbound call statistics with following references:

In this field: View this:
Today The total number of outbound calls as of today.
Last 7 days The total number of outbound calls in the past 7 days.

Last 30 days

The total number of outbound calls in the past 30 days.
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Work Order Details

Displays work order details as indicated below:

In this field: View this:

Work Order # View the work order number.

Case # View the case number if associated with the work order.
Work Order Type | View the type of work order.

Vendor View the vendor to whom the work order is assigned.
Status View the status of work order.

4.4 Customer Service screen’s Collections tab

The Collections tab in the Customer Service screen displays the collection-related account
information required for a collector to work on the account. It is a quick snap-shot of the
payment dues and promises along with other account details maintained in the system.

ORACLE" BSHEKAR
Financial Services Lending and Leasing

Customer Service 5 [®] Glose
Search | Customer Service: 0000100021366  Review Request (Pendng: 0) | Gueue Assignment 2
Account(s): 20000100021366: ORACLE Eyen || o audt
View v Formatv [ Fresze G Detach D @ &  © Curent® Show Al O Group Folow-up
Company Branch Sub Uit Account = Product Days Past Due Currency Pay OFf Amt. Amount Due Status Oldest Due Dt Q!
uso1 usHQ SUBUNIT 0000100021365 LOAN VEHICLE (FR) 558 USD 8,433.46 13,095.79 ACTIVEDELQ 02/10/2016 15TF
<« i = = b
Summary | Collections || Customer Service | Account Details | Customer Detalls | Customer Preferences | Transaction History || PmtModes | Bankruptcy | RepofForedoswre | Defidency | Colateral | Bureau | Timeine | Crosspip§ > ¥+
Dues & Promises
iR Historical 06/10/2017  07/10/2017  08/10/2017  09/10/2017 Late Fee
12,907.13 63.57 6152 63.57 63.57 27,00
13,365.79 12,807.13 12,970.70 13,032.22 13,085.79 13,150.36 13,429.38
>
Aranged 0,00 Uiinrrag o
Unarranged 13,365.79 13657 o
Account Details @ 4« » |10y | August2017 “«
. Sun Mon Tue Vied Thy Fri Sat
Customer Information
—— 30 31 1 2 E + s
" Name Relation =1 National ID Birth Dt
000004, ORACLE PRIMARY 0003123 0 03/25/1585
g 2 7 8 9 10 11 12
Address Information
Type Curent PSSO g acdress Phane 2 i L 1 7 . ¥
toCal
HOME ¥ Y v 745 newyork MA-34038 (672)-886-3378 ).

The Collections tab consists of the following sub sections:

Dues & Promises

This section displays the details of unpaid dues and promises on the selected customer
account.

e Total Amt Due - Indicates the total amount due on the account.
e Arranged - Indicates the amount agreed as Promise to Pay (PTP).
e Unarranged - Indicates the difference between total amount due and Promise to Pay.

The adjacent section display the following details depending on the account status:
e ‘Historical’ due amount on the account from previous dues.
e Last 4 unpaid dues with the Due Date and Due amount.

e ‘Late Fee’ amount charged on the account.
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e ‘NSF Fee’ charged on the account.

e ‘Other Fee’ charged on the account.

e Consolidated amount agreed as PTP (Promise to Pay).

e ‘Unarranged’ indicates the total outstanding due excluding the Promise to Pay amount.

e Each bucket display the consolidated due amount with current and previous dues (if
any).

Note

When a due is partially paid and the Payment Received flag = N, system displays only the
remaining due amount and not the full due amount.

Account Details

This section displays the summary of account-related information maintained in the system.
Since some of the sections are already detailed in the above ‘Customer Service screen’s
Summary tab’ the same have been referenced in required instances.

Customer/Business Information

Displays the customer's information starting with primary customer or Business information
depending on the type of account selected as either Customer or Business only account. For
detailed information, refer to ‘Customer/Business Information section’.

Address Information

Displays corresponding Customer Address or Business Address depending on the type of
account selected as either Customer or Business only account. For detailed information, refer
to ‘Address Information section’.

Employment Information

Displays the corresponding Employment information of the customer selected in ‘Customer
Information’ section. For detailed information, refer to ‘Employment Information section’. The
section is not displayed for Business only accounts.

Telecom Information

Displays the corresponding Customer or Business Telecommunication details depending on
the type of account selected as either Customer or Business only account. For detailed
information, refer to ‘Telecom Information Section’.

Collateral Information

Displays the corresponding collateral details maintained in Customer Service > Collateral tab
for the selected customer account. For detailed information, refer to ‘Collateral Information
section’.

Reference & Other Contacts
Displays the following details maintained in Customer Service > References tab.

e Relationship

e Name
e Phone1l
e Phone2

e Comment

For detailed information, refer to ‘References sub tab’.
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Customer Preferences

This section displays the details of customer communication preferences maintained in
Customer Service > Customer Preferences tab.

In this field: | View this:

Communi- The mode of communication preferred by customer such as Email or
cation Mode | Phone.

Value Communication details such as email ID or phone number.

Type Preferred type of communication in case of ADHOC TELECOM.

Time Zone Customer’s time zone.

Best day to | Preferred day of the week to contact the customer, if specified.
call

Best Time Preferred time to contact the customer, if specified.
To Call

Calendar

This section displays the dues and payment related activities on account for the current month
in Calendar format. By default, the calendar is displayed in Monthly format and can be
changed to view by ‘Day’ on clicking &1 icon. The navigation buttons (4 and p ) facilitates to
move to Previous or Next Month/Day depending on the selection. However, clicking ‘Today’
button reverts the selection to the current Month/Day.

The following events are highlighted in the Calendar on specific dates:

e The next payment due date as ‘DUE’.

e The next payment day as ‘PAY DAY’ (displayed only for Primary Customer of the
account with Current indicator as ‘Y’ and for latest record in Employments tab).

e Paid Date as ‘PAID’.
e Promised to Pay Date as ‘PTP’.
e Current Date.

When multiple events occur on the same day, the same is indicated with the count along with

a link to view the events. Also depending on the time zone configured, an event may be
extended and highlighted to two days in the calendar when there is an overlap.

Eligibility

This section displays the customer account eligibility to take an ‘Extension’ for payment due
date and if ‘Due Date Change’ (DDC) is allowed on the account. If yes, the same is indicated
with a «# (tick mark).

Activities

This section displays the dues and payment related activities on account for 36 activities
starting from AO1 up to A36.
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4.5

4.5.1

4.51.1

Customer Service screen’s Customer Service tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

Each action and result has a code and description. The code for the call action and call result
is what appears on the Call Activity sub screen. The Call activity action codes (Action field)
and call activity results codes (Results field) are user-defined.

The Call Activities sub tab displays all the call activities defined by users in both “Customer
Service > Call Activities tab” and in “Right Hand Splitter > Add Call Activity section”.

Recording a Call Activity

To record a call activity

1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

Summary = Collections ~ Customer Service = Account Details = Customer Details ~Customer Preferences = Transaction History ~Pmt Modes | Bankruptcy = Repo/Foreclosure Deficiency = Collateral ~Bureau = Timeli > ¥

Call Activities Maintenance = Comments ~Promises Checklists ~ Tracking Attributes ~ Field Investigation ~ References = Correspondence Letters Document Tracking ~ Scenario Analysis  Access History

Call Activities
& save an dAdd | [ saveandsty  EH s d Ret GaRetum
View v Formatv [ Freeze [l Detach Wray W®
ot Action Result Contact Reason Promise Dt promise Amt. TN AU oniton Apprimt Followup Dt
11/05/2020 v v v v 000 12,583.05 v RO o
11/05/2020 CC CUSTOMER CA... NP NO PROMISE ATTORNEY 1ST PAYMENT DE. 0.00 12,583.05 DELINQUENT __ 11/08/2020

11/05/2020 DC DEALER CALLED PS PAYMENT SEN... ATTORNEY 1ST PAYMENT DE... 11/12/2020 5,000.00 12,583.05 DELINQUENT v 11/11/2020

| >

You can complete the following optional fields:

4. Perform any of the Basic Operations mentioned in Navigation chapter.

In this field: Do this:

Dt System defaults the current date.

Action Code The action code is auto-updated based on action selected.

Action Select the action performed from the drop-down list.

Result Code The result code is auto-updated based on result selected.

Result Select the result of the action from the drop-down list. Depending on

the action selected, filtered results are displayed for selection.

Contact Select the person contacted from the drop-down list.
Reason Select the reason for the communication from the drop-down list.
Cancel Select the check box to cancel the promise.
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4.5.1.2

In this field: Do this:

Promise Dt Select the promise date from the adjoining calendar.

Promise Amt Specify the promise amount.

Current Amount | View the amount due on the account as of current date.

Due On saving the record, the same amount is updated on the call activ-

or ity and also system posts a comment on the account with the
Amount Due as '<Account Currency Code> <Values of Amount
Due> Amount Due on <GL Date>'. For example USD 200 AMOUNT
DUE ON 11/12/2020.

Note: In add mode, this field name is ‘Current Amount Due’ and
table name is ‘Due on Taken Dt'.

Due on Taken Dt

Condition Select the condition or queue type from the drop-down list.

The list displays a combination of all the possible conditions
depending on the action and result selected along with any open
conditions applicable on the account. You can select ‘None’ if there
are no specific conditions.

Appointment Check this box to take an appointment.

If Appointment is checked, then system allows you to select date
and appointment time as per customer request. If appointment flag
is not checked, then you can only enter the date with date picker.

Followup Dt Specify the next follow-up date. Based on this date, system auto-
matically adds the account in queue for follow-up.

Time Zone Select the time zone of the customer.

Group Followup | Check this box to enable group followup.

Comment Specify additional information of the call activity, if any.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click to Save and Add to add a new record. Click to Save and Return to return to the
main screen. The system creates two entries on Customer Service screen for the call
activity.

The codes for Action and Result appear as a record on the Customer Service screen, under
Call Activities tab. The description for Action and Result appear as a system generated
comment on the Customer Service screen, under Comments tab. If the account is delinquent,
then the delinquency days is also appended in the system generated comment.

Making an Appointment

The Appointment box on Call Activities section enables you to schedule an account to
appear in a particular queue at a future date and time. When you make an appointment,
account will appear in the front of queue listed in the Conditions field at the time listed in the
Follow Up Dt field.

In order to view the account, you must be working in that queue at follow up time. Refer the
‘Recording a Call Activity section’.
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4513

4514

To make an appointment
1. Open Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add and specify the field details on Call Activities section (Refer, Recording a call
activity section).

4. In Condition field, select the condition for queue you want the account to appear in.

In Follow Up Dt field, select the date and time you want account to appear using the
calendar. This can be either current day or a day in future.

6. Select the Appn’mt box.
7. Click Save And Add / Save And Return.
If account is not worked within the queue on day of the appointment, nightly jobs will cancel

the appointment. If the account’s queue condition changes during nightly batch jobs, the
outstanding appointments are cancelled.

Cancelling an Appointment

Using the Call Activities screen, you can cancel an appointment for an account. The account
will still appear in the queue on follow up date, but no longer receive a priority.

To cancel an appointment

1. Open Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it.

Click Add. The system displays Call Activities screen. If you need to change time for the
appointment, create a new entry on account’s Call Activities section with the same condition,
but enter a new follow up date. If you need to cancel the appointment, create a new entry on
account’s Call Activities section with same condition, but don’t check the Appointment
check box.

(To create a new entry, refer Recording a Call Activity section.)

3. Click Save.

Recording a Promise to Pay

If you record an action on Call Activities screen as a ‘promise to pay’, it appears as a record
on the Account Details screen’s Promises section. The Promises section enables you to
quickly view these actions without searching for them individually.

To record a promise to pay
1. Open Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add. The system displays the Call Activities screen. In Action field, select the
action which is already performed, such as DC - DEALER CALLED

4. In the Result field, select a result involving a promise to pay, such as PP - PROMISE TO
PAY.

5. You can complete the following optional fields:

In this field: | Do this:

Contact Select the contact type. (Who was the person you communicated
with?).
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In this field: | Do this:

Reason Select the reason, as stated by the contacted person. (What is the
reason for this contact?).

6. Inthe Promise Dt field, record date when the person you spoke with promises to make
payment.

7. Inthe Promise Amt field, record amount of payment the person you spoke with promises
to pay.
8. In the Condition field, select the condition or queue type.

9. Inthe Follow up Dt field, enter next follow-up date for the promise-to-pay or accept the
default date.

10. Click Save. The system automatically notes this information as an entry on the Promises
and Comments sub screens.

Note

If payment amount is within the tolerance limit, promise is considered to be kept. If the pay-
ment amount is not within tolerance limit, promise is considered to be broken.

Cancelling a Promise to Pay

Oracle Financial Services Lending and Leasing enables you to cancel promises to pay using
the Account Detail’'s screen Call Activities section. You might do this when a customer
informs you prior to the promise date that he or she cannot make the payment.

To cancel the existing promise to pay

1. Open the Customer Service screen and load the account you want to work with.
2. Click Customer Service sub tab and then click Call Activities tab under it.

3. Click Add. The system displays the Call Activities screen.

4. Select the call activity entry for the promise to pay you want to cancel.

Click the Cancel box. The promise is marked as cancelled and will not be considered when
processing promises; in other words, it will not be counted as either satisfied or broken.

Posting Offline Call Activities

The system facilitates posting of offline call activities against an account.

To Post Offline Call Activities:

1. The source file is provided in CSV format (pre-determined for fields & size). Each field in
the file is separated by a comma (,) and each line is separated by return (New Line).

2. A batch job Offline call activity posting, loads the provided flat file in the specified format
and system will process it line by line.

3. Foreachline, the system posts Call Action Code and the corresponding Call Result Code,
for a given account number with SYSDATE.

4. The system will perform respective call activities and sets the follow-up date as SYSDATE
+ Follow up Days (As provided in the feed file)

5. During offline call activity, you can specify comments, if any, in the comments field. The
system defaults comments received from offline call activity in the comments section sub
tab under Customer Service screen.
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6. During offline call activity, you can also include the alert flag as ‘Y’ or ‘N’ for a comment
as the last parameter (i.e. after comments and separated by a comma). Oracle Financial
Services Lending and Leasing recognizes this comment as an alert and displays in
Customer Service > Summary Tab, in Alerts section.

452 Maintenance sub tab

The Customer Service screen’s Maintenance screen acts as a single command stations that
enables you to post a wide array of monetary and non monetary transactions for any given
account. Transaction available is based on the account’s Line of credit produce and the user’'s
responsibility. This section explains how to complete the following tasks:

Monetary tasks

Line of Credit:

e Apply, adjust, or waive servicing expenses

e Adjust or waive late charges

e Adjust or waive non-sufficient funds

e Apply, adjust, or waive repossession expenses

e Apply, adjust, or waive bankruptcy expenses

e Apply or adjust phone pay fees

e Change an index/margin rate

e Apply, adjust, or cancel financed insurance

e Generate a payoff quote

e Payoff an account

e Charge-off an account/Do Not Charge-Off an account
e Close an account

e Trading of Accounts - Monetary Transactions

e Indicate a borrower as on or off active military duty

e Post a credit limit

e Activate, adjust, cancel, or waive a credit insurance disability
e Activate, adjust, cancel, or waive a credit insurance life
e Adjust or waive an advance transaction fee

e Adjust or waive a membership fee

e Adjust or waive an over limit fee

e Adjust, charge-off, or waive the advance/principal balance
e Adjust the interest balance

e Stop interest accrual

Non-Monetary tasks

Line of credit:
e Update a customer’s/Business name
e Maintain customer details
e Mark a customer/business as a skipped debtor
e Change a customer’s Privacy Opt-Out indicator
e Stop correspondence
e Modify financed insurance information
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e Start or stop an ACH

e Reprint a statement (batch only)

e Add or stop servicing of accounts with post dated checks as a repayment method
e Adjust Dealer Compensation

e Trading of Accounts - Non-Monetary Transactions

e Bankruptcy Reporting Indicator

The system enables you to post a monetary transaction immediately or submit it for nightly
processing. The transaction is identified as either a ‘real-time’ or nightly batch transaction in
Oracle Financial Services Lending and Leasing’s transaction setup codes. The system also
enables you to cancel the future dated transactions or transactions those have been
submitted for nightly processing. All activities in the account, including who performed it, date
and time stamp, are captured in the audit trail.

4.5.21 Creating Monetary and Non monetary Transactions

All monetary and non monetary tasks listed in the appendix Transaction Parameters are
available for use on Maintenance screen. Each task requires a Transaction value and a
Parameter value.

To use the Maintenance screen to complete monetary transaction
1. Open Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Maintenance tab under it.

ORACLE & Welcome, vavaDYA ~ [ ERROUNGN O
Financial Services Lending and Leasing

i Close
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> Origination Search  Customer Service: 20150900014275  Review Request (Pending: 0)
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Senvicing Account(s): 20150900014275: RODRIGUEZ MILDRED 1| o aude
View v Fomatw [ Freeze i Detach Virap W & @ cumentO show Al Group Follow-up
‘Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Du
usoL UsHQ 'UNDEFINED 20150900014275  LINE HE (FR) 122 Usb 15,747.80 7,527.¢
< >

Summary || Customer Service || Account Details = Customer Details | Transaction History | PmtModes || Bankruptcy | Repo/Foredosure | Deficiency || Collateral || Bureau || Cross/UpSe > ¥

Gall Activities | Maintenance | Comments || Promises | Checklists || Tracking Attributes | References || Comespondence | Letters || Document Tracking

Vendors
Batch Transactions

i Transaction Batch Information Feadd | A Edi | View || o budit
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Fods Date Moretary Transaction Status Batch
Interfaces 02/01/2016 ¥ ¥
AP Transactions
GhT e Transaction Batch Information

CASA Recondiliation

Save and add Save and Stay Save and Return Ret
Conversion Accounts | 4 =] add | @ y | Hs R

Date 02/01/2016 * Transaction ® Status
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Parameter Value Required

No data to display.
Result

View~ Format~  [E Fresze 4 Detach  Wrep (5]

Transaction Processing Details
No data to display.

> Collections
> WFP
> Tools

> Setup

3. On the Maintenance screen’s Action section, click AddIn the Transaction Batch
Information Section section:

— Select the Monetary box to complete a monetary transaction.
-Or‘-
— Clear the Monetary box to complete a non monetary transaction.
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4.5.3.1

4. Inthe Transaction field, select transaction for the task you want to complete. Transaction
availability depends on the type of Line of credit account, whether the transaction is
monetary or non monetary, and user responsibility.

Note that, during set up, all transactions are configured to be processed either in real
time or as a batch transaction. Accordingly, the ‘Batch’ check box is selected only if the
selected transaction is to be performed through batch execution.

5. Click Load Parameters.

6. Specify all the required parameter values and click Post.
The system displays result (success or failure) in the Results section.

You can cancel a transaction by selecting the record and clicking Void. The parameter
‘TPE_TXN_POST_DEFAULT_GLDATE’ is used to default the transaction date to GL date. If
the ‘Default Transaction Date to GL Date’ is Yes, then GL date will be defaulted as transaction
date. If the value is ‘No’, then the transaction date will not be defaulted and you can specify
the transaction date manually.

When transaction date is not equal to or less than the system date, transaction is considered
to be back dated. System Date is ‘OFSLL System Date’ which is the GL Date. When user
posts the back dated transaction, system displays warning message as “Confirm to post the
back dated transaction” with YES/NO. If user selects 'Yes', then transaction proceeds. If user
selects 'No', then the transaction gets cancelled.

System displays back dated posting warning message only if the parameter
‘TPE_SHOW_BACKDATE_WARNING' is set to 'Y’

When an ‘'ON MILITARY DUTY TRANSACTION' is posted in an account:

e The system restricts users from bankruptcy /repossession/foreclosure conditions.

e System posts DO NOT CHARGE OFF condition on that account to exclude the account
from Auto Charge Off process.

e The DO NOT CHARGE OFF condition is removed when 'OFF Military Duty' transaction
is posted.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record/delete comments on
the Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

All the user added Comments in either Customer Service > Comments tab or in Right Hand
Splitter > Add Comment section, are displayed in the Comments sub tab including system
generated comments.

Recording an Additional Comment

To record an additional comment
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Comments tab under it.
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3. Click Add. The system displays the Comments screen.
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4. If you want to tag this comment as important, select the Alert box. If selected, the
comment appears on Customer Service screen’s Alerts section, after Save.

In the Type field, select what type of comment you are adding.
In the Sub Type field, select what sub type of comment you are adding.

In the Comment field, specify your comment.

©® N o o

screen.

Comments can be viewed under the Comments tab View the following:

Click Save and Add to add a new record. Click Save and Return to return to the main

In this field: View this:

Alert If selected, Oracle Financial Services Lending and Leasing to recog-
nizes this comment as an alert and displays in Customer Service >
Summary Tab, in Alerts section.

Type The type of comment.

SubType The sub type of comment.

Comment The text message entered in the Add Comments section.

Comment By The user ID of person who entered comment in the Add Comments
section.

Comment Dt The date on which comment was entered in the Add Comments sec-
tion.

4.5.3.2 Deleting Comment(s)

You can delete ‘REGULAR’ type comments displayed in the Comments sub tab.

To delete a comment
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Comments tab under it.
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3. Select the row which consists of the comment and click Delete from the actions.

4. Click ‘Yes’ to confirm delete in the warning message displayed.

Promises sub tab

The system automatically updates promise to pay request information as an entry under the
Promises sub tab based on value defined in parameter at setup level.

In this field: View this:

Promise Amt The amount promised.

Promise Dt The date by which customer promises to pay the said amount.
Taken By The user who took promise.
Taken Dt The date promise was taken.

Due on Taken View the amount due on the account as of current date.

Dt Note: In add mode, this field name is ‘Current Amount Due’.

Collected Amt | The amount collected against the promise.

Broken ind If °Y’, indicates that this is a broken promise.

Note: This field is auto-updated by the system at runtime after execut-
ing the scheduled batch job CPPPRC_BJ_100_01 (BROKEN PROM-
ISE PROCESSING) with the method of update defined in Company
parameter FUTURE PROMISE HANDLING METHOD
(CMN_PROMISE_FUTURE_MTHD). Refer ‘Company Parameters’
section for more information.

Cancelled If °Y’, indicates that this is a cancelled promise

If a call was recorded as a PROMISE TO PAY on the Call Activities section, it will appear
under the Promises sub tab. The Promises sub tab enables you to quickly view details about
the call and subsequent actions and displays 25 most recent promises to pay.

A promise is considered to be broken in either of the following conditions:

e If system does not receive the promised amount ‘ON or Before’ the promised date.

e If a paymentis received but the paid amount is not up to the tolerance limit, as defined
in Setup > Contract screen.

System automatically updates the consolidated status of all promises in Customer Service >
Summary tab, ‘Delinquency Information’ section. View the following information in the
Promises sub tab.

Create Multiple Promises

In the Promises sub tab, you can capture more than one Promise at a go and track all
promises, instead of adding multiple call activities to capture multiple promises.

To record multiple promises related to call activity, Click Create Multiple Promises. The
system displays the ‘Promises’ section with the following fields:

In this field: View this:

Action Select the type of action from the drop-down list.
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In this field:

View this:

Result

Select the required result of action from the drop-down
list. The Result field drop-down list displays only
“Promise to Pay” related results based on the action
selected.

Contact

Select the type of person you contacted from the drop-
down list.

Reason

Based on the account condition and the reason stated
by the contact, select the appropriate reason from the
drop-down list.

Promise St Dt

Select the date from which the first promise is made
from the adjoining calendar icon.

Frequency

Select the frequency of payment from the drop-down
list.

Promise Amt

System defaults the current due amount on the
account as on current date.

Specify the amount promised by the contact. Ensure
that you do not enter zero or a decimal value.

No. of Prom-
ises

Specify the total number of promises made by the con-
tact. A minimum of one promise need to exist.

Appointment

Select the check box if a prior appointment is to be
taken for future follow-up.

Current
Amount Due

View the amount due on the account as of current
date.

Comment

Specify additional details of the promise, if any.

Click Create to record the promise details. Based on the number of promises, equivalent

records are created in the section below with the following information:

In this field:

View this:

Promise Dt

The first record indicates the promise start date and
subsequent records will have dates incremented
based on frequency and number of promises.

Promise Amt

View the amount promised.

Reason Indicates the reason stated by the contact.
Contact Indicates the contact selected.
FollowUp Dt Indicates the followup date which is auto calculated by

the system by adding 2-3 additional days from the
promise date.

Appointment

Indicates if a prior appointment is required for future
follow-up.

Comment

Specify additional details of the promise, if any.
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If required, You can further modify the details of each record.

Click Save and Return. The recorded promises are populated in Call Activities tab for
tracking.

For more information on Call Activities, refer Customer Service > Call Activities sub tab
section.

Checklists sub tab

In this field: View this:

Promise Amt The amount promised.

Promise Dt The date by which customer promises to pay the said
amount.

Taken By The user who took promise.

Taken Dt The date promise was taken.

Collected Amt | The amount collected against the promise.

Broken If selected, indicates that this is a broken promise.

Cancelled If selected, indicates that this is a cancelled promise

Oracle Financial Services Lending and Leasing enables you to use checklist to ensure that
procedures are followed to complete various tasks. This instructional information appears
under the Checklist sub tab.

Completing a Checklist for an Account

To complete a checklist for an account
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service tab, Click Checklist sub tab.

ORACLE' # Welcome, DEMOSUPR +
Emancra\ Services Lending and Leasing
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Vew+ Fomatv Ep ([ Frece [Ejetsch wee | @ & ©cument O Showal O Goup Folowup
Company Branch n o Product Days st Due Currency Pay OFfAnt Amount Due Status Oldest Due Ot
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Checkist Comment Complete
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Action YesNo NA Comment
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Collections
wEP
Tools

Setup.

3. Inthe Check List Type field, select the type of checklist you want to complete and then
click Load Checklist. The system loads checklist in the Checklist and Checklist Action
sections.
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4. Under Action - Regular tab, Click Edit. In the Action field, select an action you want to
complete.

5. Under Action - Document tab, Click Edit. In Document tab, you can track documents
pertaining to the checklist type and update the status.

6. Note your work with the Yes/No/NA option buttons. You can also add comments to each
action on the checklist in the Comment column.

7. Click Save and Add to add a new record. Click Save and Return to return to the main
screen.

Tracking Attributes sub tab

The Tracking Attributes screen enables you to link information to an account that is not
tracked by default in the system, but is part of your company’s business practices; for
example, the location of important documents, how customers receive pay checks, or the hint
questions for remembering a PIN. Such attributes are defined during system setup.

The Tracking Attributes for Line of credit accounts in this screen can also be loaded in bulk

through file upload process. While doing so, ensure that the input data file definitions are in

sync with attribute names. Before processing the bulk upload, system validates if the Tracking
Attributes are already loaded. If not, system loads the Tracking Attributes and then updates
the details.

To use the Customer Service screen’s Tracking Attributes screen

1. Open the Customer Service screen and load the account you want to work with.
2. Click the Customer Service tab, then click Tracking Attributes sub tab.

3. Click Load Tracking. The system loads the tracking parameters.
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4. Complete Tracking section by entering the requested parameter in the Value field.

5. Save any changes you made to the account.

Field Investigation Sub Tab

The Field Investigation sub tab allows you to record the field investigation details for further
processing. Field investigation primarily consists of verifying cusotmer’s contact points and
the other details to be verified such as address, employment, asset etc through a specific
verifying agency.

To record field investigation and create work-order

1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Customer Service tab, then click Field Investigation sub tab.
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3. In Field Investigation section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields are given below:

Field Do this
Customer/Busi- Select the customer attached to the account or Business Name if it
ness is an ‘SBL’ or Business account from the adjoining drop-down list.

Verification Type

Select the field verification type from the adjoining drop-down list.

Verification Agency

Select the verification agency from the adjoining drop-down list.

Status Select the field verification status from the adjoining drop-down
list.

Spoke to Specify the name of the person contacted during field verification.

Call Dt Select the date when the customer was contacted from the adjoin-
ing calendar.

# of Attempts Specify the number of attempts made to contact the customer.

Result Select the field verification result from the adjoining drop-down list

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In Verification Details section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields are given below:

Field

Do this

Remarks

Specify remarks, if any regarding the field verification.

Verification Match

Check the box if the verification has matched.
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6. Perform any of the Basic Actions mentioned in Navigation chapter.

References sub tab

The References sub tab enables you to view/add/edit references attached to the account
during Line of credit origination cycle.

To use the Customer Service screen’s References screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click References sub tab.

3. Click Add.
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Specify the following details:

In this field: Specify this:

Relationship Referee's relationship with borrower.

Name Referee's name and details in the following fields.

Status Select the status of the reference as either ‘Active’ or ‘Inactive’ from
the drop-down list.

Country The country.

Address The address line.

Zip The zip code.

Zip Extn The zip code extension

City The city.

State The state.

Years Number of years that the reference is known by the borrower.

Months The number of months that the reference is known by the borrower.

Phone The reference’s primary phone number.

Extn The reference’s primary phone extension.
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In this field: Specify this:

Permission to Check this box if customer has provided permission to contact
call through the specified phone number.

Permission to Check this box if customer has provided permission to contact

Text through text message.
Phone The reference’s secondary phone number.
Extn The reference’s secondary phone extension.

Permission to Check this box if customer has provided permission to contact
call through the specified phone number.

Permission to Check this box if customer has provided permission to contact
Text through text message.

Comment The comments regarding the reference.

4. Click Save and Add to add a new record. Click Save and Return to return to the main
screen.

Note

You can also post a non-monetary transaction to add or modify contact reference details.
For more details, refer to Appendix - ‘Transaction Parameters’ chapter. For references up-
dated through the Customer Service screen, system automatically appends a comment as
'Direct Update' while posting the respective transactions.

4.5.9 Correspondence sub tab

Ad-hoc correspondence enables you to include information from accounts in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence screen when you have
opened an account. The screen enables you to generate a new letter or view a previously
generated letter.

To generate an ad hoc correspondence
1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Customer Service tab, then click Correspondence sub tab.
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In the Correspondence section, click Add. In the Correspondence section, use

Correspondence field to select type of correspondence you want to generate. The
system displays following information in the Correspondence screen for selected type of
correspondence:

In this field:

View this:

Id

The correspondence id.

Correspondence

The correspondence which is to be generated.

Date

The correspondence generation date.

4.

In the Correspondence section, click Save. The Documents section displays all types

of documents available for the type of correspondence you selected.

5.

In the Documents section, click View.View the following information for each document:

In this field:

View this:

Document Id

The document Id.

Document

The document description.

Recipient

The recipient description.

E-Form
Source

The e-form source.

Source Type

The source type.

Generated

'Y’ indicates that Oracle Financial Services Lending and
Leasing generated the document.

Selected

'Y’ indicates that this document is selected to be included in
the correspondence.

6.

In the Documents section, select the correspondence you want to view.
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7. The Document Elements section displays elements of the system used to generate
correspondence.

8. Click All to view all elements in the correspondence.
- Or -

9. Click User Defined, to view user-defined elements in the correspondence. In the
Document Elements section, view the following information:

In this field: Do this:

Element Type View the document element type.
Element View the element description.
Content Enter/view value of the element.

10. In the Document Elements section, click User Defined and complete Content fields for
Element fields you want to include in the correspondence.

11. In the Document Elements section, click Save.

12. In the Document Elements section, click View.
The system displays a PDF of the ad hoc correspondence.

4.5.9.1 Recipient Details Sub Tab

The recipient details sub tab facilitates you to send ad-hoc correspondence to Customers,
Producers, and Others as an email.

To add recipient details

1. Open the Customer Service screen and load the account you want to work with.
2. Click Correspondence > Recipient Details.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

- Business

Customer Type This field is enabled if you has selected the recipient as ‘Cus-
tomer’. Select the type of customer relation from the drop-down
list. The list is populated with all the customer relations linked to
the account.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:
- Fax
- Email

Type Based on the recipient selected, the following type of correspond-

ence is listed for selection:

When the recipient is selected as Customer / Producer, the Type
is defaulted as ‘Email’ and associated email ID is selected for cor-
respondence. You can also change the Type to ‘Adhoc’ and spec-
ify the required email ID.

When the recipient is selected as ‘Others’ you can specify the
email ID in Type field for correspondence.

FAX/Email View the auto populated FAX/Email details or select from the
drop-down list.

Email and Fax details are auto populated if the recipient is
selected as Customer / Producer / Business and the ‘Mode’ and
‘Type' is selected as EMAIL.

Comments Specify additional information as comments.

4. In the Recipient Details section, click Save.

5. Click Send to email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details::

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

4510 Letters sub tab

The Oracle Financial Services Lending and Leasing Customer Service screen’s
correspondence address matters regarding customer service and collections for accounts.
They also enable financial organizations to manage bulk mailings. The Letters screen enables
you to create and view the following types of correspondence:

—  Welcome letter
— Paid in Full letter
— PayOff quote letter
— Rate change intimation letter
— PDC renewal letter
e Collection:
— Collection Letter - 1
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— Collection Letter - 2
— Collection Letter - 3

You can view format of all the above letter types by clicking ‘View Letter button. In case, the
correspondence to a particular customer has been stopped using the Maintenance, ‘View
Letter’ button will not be displayed and only Letters screen will be available.

To use the Letters screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Letters sub tab.

RACLE  Welcome, DEMOSURR + 15 100 out O
Financial Services Lending and Leasing

0160100011260: BROAD STUART / SMITH EDWIN Elview || P audt
- | B | lFeee e B ® curent O Show Al O Gro

Pay Off Amt Amount Due Status Oldest Due Dt
15,002.08 0.00 ACTIVE 0272072016

Branch Sub unit Account # Product
st UnpEFINED 2016010001260 LOAN VEHICLE (FR)

Is| | Customer Detalls

History | Pt Modes

s promises | Checkists | Tr iutes | References

Frocze [ Detach e | @ [Evew Leter

aid | Pese || Clvew || o st
ecze [ Detach op | @ Esed
Type FaEmal SentIndicstor  Comments

Collections
wrp

Tools

setup

Recipient Details

In the Recipient Details section, you can maintain the recipient details to whom the letter
should be sent. You can specify the following recipient details:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

- Business

Customer Type This field is enabled if you has selected the recipient as ‘Cus-
tomer’. Select the type of customer relation from the drop-down
list. The list is populated with all the customer relations linked to
the account.

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax

- Email

4-36 ORACLE



Field: Do this:

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

When the recipient is selected as Customer / Producer, the Type
is defaulted as ‘Email’ and associated email ID is selected for cor-
respondence. You can also change the Type to ‘Adhoc’ and spec-
ify the required email ID.

When the recipient is selected as ‘Others’ you can specify the
email ID in Type field for correspondence.

FAX/Email View the auto populated FAX/Email details or select from the
drop-down list.

Email and Fax details are auto populated if the recipient is
selected as Customer / Producer / Business and the ‘Mode’ and
‘Type’ is selected as EMAIL.

Comments Specify additional information as comments.

3. In the Recipient Details section, click Save.

4. Click Send to email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details:

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

4.5.10.1 Collections: Collection letter 1

The predefined Collection letter 1 is automatically sent a configurable number of days after
an account becomes delinquent (receives a condition of active: DELQ on the Customer
Service screen).

The Collection letter 1 is available for Line of credit fixed and variable rate).

To generate the Collection letter 1
1. Open the Customer Service screen and load the account you want to work with.
2. Click the Customer Service tab, then click Letters sub tab.

3. On the Letters section, select Collection Letter - 1.
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4. Click View Letter to generate Collection Letter - 1.

Collection Letter ORACLE’
Financial Services Lending and Leasing

DEMO BANK USA

LINE1

LINE2

MINNEAPOLIS MN 55344 7255
Phone: ####8#4488444 Exin: 101
Fax:  #ssssss

Account number : 20150900014275
Amount past due: USD 7,527 99

Fanccliann

4.5.10.2 Collections: Collection letter 2

The predefined Collection letter 2 is automatically sent after a configurable number of days
for a delinquent account (one with a condition of active: DELQ on the Customer Service

screen).

The Collection letter 2 is available for Line of credit (fixed and variable rate).

Collection Letter ORACLE
Financial Services Lending and Leasing

DEMO BANK USA
LINE1

LINE2

MINNEAPOLIS MN 55344 7255

Phone; #H##HHFFEH Exin 101

Fax:  HHHHHEEREHE

Date: 2/9/2016

INTERSHELL INTERNATIONAL CORP

100 CORPORATE N PL STE 404 ANX E # 160
FAIRGATE

CANTON MA 02021

Account Number: 20150900014267
Amount Past Due: USD 5,329.00

Dear SHARP
This is to inform you that your account with DEMO BANK USA is currently in default. We hereby
demand that payment for USD 5,329.00 be brought current immediately. This amount includes
monthly payments together with all applicable fees due pursuant to your contract.
If you are unable to send such a payment, it is imperative that you contact our office at

Extn: 101 to discuss this matter. Your immediate response to this demand is
necessary if you wish to avoid further consequences.
Thank You in advance for your anticipated cooperation
Sincerely,

DEMO BANK USA

4.5.10.3 Collections: Collection Letter 3

To generate the Collections letter 3

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Letters sub tab.

3. On the Letters section, select Collection Letter - 3.
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4.5.11

4.

Click View Letter to generate Collection Letter - 3.

Collection Letter ORACLE
Financial Services Lending and Leasing

DEMO BANK USA

LINE1

LINE2

MINNEAPOLIS MN 55344 7255
Phone: s#ssssssteass Frm: 101
Fax: s

Date:2/9/2016

INTERSHELL INTERNATIONAL CORP

100 CORPORATE N PL STE 404 ANX E # 160
FAIRGATE

CANTON MA 02021

Account number: 0150900014267
Amount past due: USD 5,329.00

Dear SHARP,

Qur records indicate that you are past due on your loan in the amount of USD 5,329.00. This
amount includes monthly payments together with al applicable fees due pursuant to your
contract.

Several attempts have been made to contact you conceming this matter. In an effort to assist you
in attaining a current status on your account, we would ke to speak with you immediately. Please
contact our office at #HAHHAHFEE Exdn: 101 to make suitable amangements fo bring your
account current

Thank you in advance for your anticipated cooperafion.

Sincerely,

DEMO BANK USA

Document Tracking sub tab

You can view the documents attached to a particular account by loading the account on

Customer Service screen, then clicking the Document Tracking sub tab. You can also open
the Document Tracking screen and select from a list of all accounts with documents attached
on the Document Tracking screen.

To use the Document Tracking screen

1.

Open the Customer Service screen and load the account you want to work with.
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2. Click the Customer Service tab, then click Document Tracking sub tab.
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3.

information:

In the Documents section, select the document you want to view and view the following

In this field: Do this:

Document View the document type.

Type

Comment Specify comment.

4.

5.

In the Account Document Details section, select the document you want to view and

click Show in the Details column.

In the Account Document Details section, click View to view the following information:

In this field:

Do this:

Document Type

View the document type.

Document Sub Type

View the document sub type.

Version

View the version. Version numbers will be incremental by batch
job, first version will start with 1.0.

Page #

View the page number. In multiple paged documents, choose 1
in the Page # field on Account Document Details section to
view all the pages in the document.

Choose a specific page number to view only that page.

Document File Type

View the document file type.

Status

View the status of the document.

Tracker #

View the tracking number of the document.

Docket #

View the docket number of the document.
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4.5.12

In this field:

Do this:

Location

View the location of the document.

Received Dt

View the received date of the document.

Effective Dt

View the effective date of the document.

Expiry Dt

View the expiration date of the document.

Comment

Specify comment.

6. Click View Document. The system opens a File Download dialog box.
— Click Open to view the document in the browser screen
-or-
— Click Save to download the document to a location of your choice.

7. If you want, add comments to the Comments field in the Documents and Account
Document Details sections.

8. Save your entry.

Access History

The Access History tab in Customer Service screen displays the list of users who have
accessed a particular account in Oracle Financial Services Lending and Leasing application.

Irrespective of the action performed on the account or the way through which the account is
accessed such as using search, queue/conditions, review requests and so on, system
records every access and displays the user details in ‘Account Access History’ section.

Starting with the last user, the Account Access History section displays the list in descending
order along with their logged-in User ID (Accessed By), date and time (Access Dt) of login in
separate columns.

To view the account access history

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Customer Service tab, then click Access History sub tab.

ORACLE
Financial Services Lending and Leasing

ABSHEKAR i Signout

@ Customer Service x [ Close
Search | Customer Service: 2016070001076 | Review Requsst (Pending: 0) | Queve Assignment 2
» DashBoard
 Origination Account(s): 20160700010076: MILLEN JOHN Elvew | o Auit
e view v Formatv Ep Freeze &l Detach rap W & © curentO Show Al Group Folow-up
Company Branch Sub Uit Account = Product Days Past Due Currency Pay OFf Amt Amount Due St
Servidng MO2 MHQ UNDEFTNED 0160700010076 LOAN VEHICLE (FR) 23 EUR 50,088.31 o.00ff
Customer Service o3 = - - .
Seauritzation 4
Transaction Authorization I
Summary | Customer Service | AccountDetais || Customer Detols | Transaction History || PmtModes | Bankruptcy | RepofForecosure | Deficency | Collateral | Bureau | CrassiUp Sellacth » ¥
Post Date Checks
il = < mence || Comments | Promises || Checkists | Tracking Atimbutes || Field Investigation | References | Correspondence | Letters || Document Tracking || Seenario Analyss | AccessHistory | > ™
Account Documents §
Collateral Management
Reports Account Access History
Producers View v Formatv [P Freezz  fiDetach o] wrap W
Vendors Accessed By Access Dt
Baich Transactions ABSHEKAR. 08/08/2016 05:34:05 AM -
Advances RMACHARL 08/08/2016 05:23:25 AM
Payments MAHESHP 08/08/2016 04:31:32 AM y
Fees - PRIVAS 08/08/2016 01:28:53 AM
> Collections RMACHARL 08/08/2016 01:17:46 AM
RMACHARL 08/08/2016 01:17:38 AM
P AT 08/08/2016 01:08:55 AM
> Tools RMACHARL 08/07/2016 11:43:57 PM
> Setup LMANGALA 08/05/2016 09:79:23 AM
RMACHARL 08/05/2016 07:20:38 AM i

You can click (refresh) to fetch the latest data.
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4.6

4.6.1

Customer Service screen’s Account Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Account Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab. In addition, you can use this screen to derive various account level
business specific calculations and populate the computed values into the custom user defined
fields.

Calculate Parameters

The ‘Calculate Parameters’ button is available in the Account Information header. Clicking on
it calculates the Target parameters for Account and all Collaterals linked to the account and
populates the computed values in the custom user defined fields.

However, for system to populate data in custom fields, the following setup is required:
e The custom user defined fields have to be enabled in Setup > Administration > User >
Access > ‘Field Access Definition’ tab.

e Useraccess to these custom fields are to be granted in ‘Security User Access Definition
Details’ sub tab.

e If required, these fields can be customized in the ‘Label Configuration’ tab in Setup >
Administration > System > Label Configuration screen.

e Further, the custom fields are to be configured to compute specific business
calculations at Account level in Setup > Administration > System > User Defined
Parameters screen.

For more information, refer to specific section in Setup guides.

In the Account Information section click View.

ORACLE’ # Welcome ABSHEKAR  1gy sign out O
Financial Services Lending and Leasing

Customer Service x %] Close

Search  Customer Service: 20190100010061  Review Request (Pending: 0) | Queue Assignment

Account(s): 20190100010061: YADAV VIK [ view || 2 Audit
View v Formatv [ Freeze [ Detach Wrap W & @ curent O Show Al O Group Follow-up
Company Branch Sub Unit Account # Master Account #  Master Account Product Billing Cycle Purpose Days Past Due Currency
uso1 USR1 UNDEFINED 20190100010061 UNDEFINED N LINE HE (VR) MONTHLY VEHICLE LOAN O... -32 USD

»

Summary || Collections || Customer Service ~Account Details | Customer Details | Customer Preferences | Transaction History | Pmt Modes | Bankruptcy | Repo/Foreclosure || Deficiency || Collateral || Bureau | Tin > ~

Account Details | Statements Rate Schedule | Insurances | Condition Details | Contract Information | Trade Details

Account Information Z Edit || [H View || < Audit
» View v Format v [ Freeze [ Detach Wrap W & calculate Parameters
Stop Accrual Accrued Interest Index Type Index Rate Margin Rate Rate Last Rate Adj Dt Accrual Start Dt Last Accrual Dt Rate Startofithe &
N 65.17 PRIME RATE 12.00 499 1699 01/01/2019 07/11/2019 16.99 o

»

Account Information

<A Retum
“
Interest and Accruals Remaining Amt  50,150.00 Limit Utilization
Over Limit Year 0 Additional Place Holder Number 6 -50,050.00

Stop Accrual — Over Limit Life 0 GF+TOTAL TIER
Accrued Interest 65.17 Last Advance Dt 01/01/2019 Additional Place Holder Number 9
Index Type PRIME RATE Last Advance Amt  20,000.00 Additional Place Holder Number 10

Index Rate 12.00 Additional Place Holder Number 11 0.00

Margin Rate 4.99 Additional Place Holder Number 12 0.00

Rate 16.99 Start Date Additional Place Holder Number 13 0.00

Last Rate Adj Dt Expiry Date Additional Place Holder Number 14 0.00 =
Brerisl Shart D 010175010 T O

View the following information for Line of credit servicing product.
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4.6.2

Balances sub tab

The Account Balances sub tab displays a list of different balances maintained for the account
along with other details such as how the balance is derived in the system and capitalization
details indicating when the balance is capitalized to the principal of account.

To view Account Balances

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Account Details tab, then click Balances sub tab.

ORACLE’

Financial Services Lending and Leasing

# Welcome ABSHEKAR ~ o

Customer Service x

Account Details

Account Balances

View v Format v B Freeze
Chargeoff
Balance Type s
N ADVANCE / PRINCIPAL ~ CHGOFF BA...
EXPENSE BANKRUPTCY  CHGOFF BA.
EXPENSE REPOSESSION/F... CHGOFF BA...
EXPENSE SERVICING CHGOFF BA
FEE ADVANCE CHGOFF BA
FEE DELAY CHGOFF BA...
FEE LATE CHARGE CHGOFF BA
FEE MEMBERSHIP CHGOFF BA
FEE NSF CHGOFF BA...
FEE OVER CREDIT LIMIT  CHGOFF BA

Summary | Collections = Customer Service =~ Account Details = Customer Details = Customer Preferences | Transaction History =~ Pmt Modes = Bankruptcy

Balances | Statements = Rate Schedule | Insurances = Condition Details = Contract Information | Trade Details

Ef Detach

Writeoff Method

WAIVE
WAIVE
WAIVE
WAIVE
WAIVE
WAIVE
WAIVE
WAIVE
WAIVE
WAIVE

=] view
Wrap @

Reschedule Method ~ Sort Billed Accrued Capitalize Frequency Gre
ROLLOVER BALANCE 100 Y Y N UNDEFINED 0
ROLLOVER BALANCE 401 N N N UNDEFINED 0
ROLLOVER BALANCE 402 N N N UNDEFINED 0
ROLLOVER BALANCE 403 N N N UNDEFINED 0
ROLLOVER BALANCE 304 N N N UNDEFINED 0
ROLLOVER BALANCE 317 N N N UNDEFINED 0 «
ROLLOVER BALANCE 301 N N N UNDEFINED 0
ROLLOVER BALANCE 306 N N N UNDEFINED 0
ROLLOVER BALANCE 302 N N N UNDEFINED 0
ROLLOVER BALANCE 305 N N N UNDEFINED 0 v

[ Close

Repo/Foreclosure | | Deficiency || Collater: > ~

3. Inthe Balances section, click View to view the following information:

In this field:

View:

Balance Type The type of account balance maintained.
Chargeoff Method The type of method to charge-off the balance.
Writeoff Method The type of method to write-off the balance.

Reschedule Method

The applicable reschedule method.

Sort The sort sequence maintained.
Billed Y/N indicating if the balance is billable to customer.
Accrued Y/N indicating if interest is accrued on the balance.

over

Non Performing Roll-

Rollover indicates that this balance is moved to non-per-
forming balance.

Non Performing Bal-

Indicated as NON PERFORMING if the balance is

ance Type expected to be charged-off in the future.

Capitalize Y/N indicating if the balance is capitalized to principal.
Frequency The frequency with which the balance is capitalized.
Grace Days The number of grace days allowed for capitalization.

Next Cap Run Date

The next scheduled balance capitalization date.
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4.6.3

Statements sub tab

The Statements sub tab facilitates to view the list of statements generated for the account till
date. In case of Master Account, you can view the list of consolidated statement of Master
Account along with the associated accounts.

The Statements sub tab contains Statements, Transactions, and Messages sections. The
Statements section displays a list of all statements generated during life of the account. The
Transaction section displays monetary transactions applied to the account from closing date
of the previous statement through closing date of the current statement. The Messages
section displays user-defined message that appears in the statement.

To view the Statements screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click the Account Details tab, then click Statements sub tab.

ORACLE'
Financial Services Lending and Leasing
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Previous Balance(+)  New Advances(+) Fees(+) FinanceCharge(+)  OfherCharges  Payment/Credits New Bal Amt Past Due Amt Minimum Due Creditlmt  Credit Avalcble  Avg Daly
No data to display.
b i '
Statements  Transactions | Messages
Statement Details Elvien | « Audt
view ¥ Format~ [P Freeze i Detach irap o)
Account = PreviousBalance(+)  New Advances(+) Fees(4) Finance Charge(4) Other charges  Payment/Credits New Bal Amt Past Due Amt Minimum Due Credtlmit  cre
o dta to display.
4 5 =

3. Select either ‘Current’ or ‘Consolidated’ option.

Note the following:

The ‘Current’ or ‘Consolidated’ option is available only for Master Account to filter
and view the list of statements for current Master Account and consolidated
statements of Master Account and Associated Accounts.

On selecting ‘Consolidated’, an additional section ‘Consolidated Statement Details’
is enabled to display the list of consolidated statements for Associated Accounts
having the ‘Statement Consolidation’ flag enabled in Account details.

By default, only those accounts having the same currency of Master Account are
displayed.

The consolidated Account statements associated for each Master Account is
generated on executing the batch job MASTER ACCOUNT STATEMENTS
GENERATION in batch job set SET-ODD?2.

4. In the Statements section, click View.

View the following information:

In this field: View:
Closing Dt The statement closing date.
Due Dt The statement due date.
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In this field:

View:

Generation Dt

The statement generation date.

In the Consolidated Statements Details section, select Loan / Line / Lease option to
group and view the consolidated statements based on Product/Funding type. The default
Product type is Master Account Product type.

Click View and view the following information:

In the Statements Details section, select the statement and click View.

View the following:

Click Transactions sub tab and click View

View the following information:

In this field: View:

Account # The Customer Account number.
Txn Dt The transaction effective date.
Post Dt The transaction posted date.
Transaction The type of transaction.

Type

Amount The transaction amount.

Click Messages sub tab and click View.

10. View the following information:

In this field: View:

Account # The Customer Account number.
Sequence The sequence number.
Message The message.

Rate Schedule sub tab

The Rate Schedule section contains information about rate adjustments, such as the
sequence and number of adjustments.

To view the Rate Schedule screen
Open the Customer Service screen and load the account you want to work with.

1.
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2. Click the Account Details tab, then click Rate Schedule sub tab.

ORACLE"
Financial Services Lending and Leasing

& Welcome, VAVAIDYA + =}

Custamer Service

> DashBoard

Search| G

> Collections
> wre
> Tools
> setup

Account(s): 20151200011200: MURRAY RICHARD

View- Tomt - B (L] Ficece

o @ G ® Curent O Show Al O Group Follow up
Account = Product Doys Past Due Curency Pay Off Amt Amount Due Status
2015120001200 LINE UNSECURED (VR) 10 Usp 3601783 0.00 ACTIVE

ory | Pt Modes | Bankruptcy | RepojForeclosure || Deticiency || Bureau | Cross/Up Sell Activities

e

Bl view || 2 uit

Period % of Adjustments.

Rl Close

Oldest Due Dt
01/01/2016

o Audit

The Rate Schedule section only applies to variable rate loans.

3. In Rate Schedule section, click View.

4. View the following information:

In this field:

View this:

Seq

The sequence number for rate adjustment.

Adjustment Frequency
Type

The rate adjustment frequency type.

Period

The rate adjustment period for the frequency.

# of Adjustments

The number of rate adjustments for the frequency.

Insurances sub tab

If insurance information was entered on Funding screen during Line of credit origination, you
can view financed insurance information on the Customer Service screen’s Insurances
screen. The Insurances screen displays the details of all financed insurances, including
cancellation and refund information whenever applicable. It also displays the insurances that
were financed after funding of Line of credit using the Customer Service screen’s

Maintenance screen.

To view the Insurances screen

1. Open the Customer Service screen and load the account you want to work with.
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2. Click the Account Details tab, then click

Insurances sub tab.

ORACLE"
Financial Services Lending and Leasing

BSHEKAR = 1 Signout &

@ Customer Service x

Search | Customer Service: 20170800010909  Review Request (Pending: 0)

Queue Assignment

Escron Transactions
Account Documents
Colateral Management
Reports
Froducers
Vendars
Batch Transactions
Advances
Payments
Fess
Interfaces
AP Transactions
GL Transactions
Conversion Accounts

Account Details

Insurance Information
Contractual Insurance Type

No data to display.
«

View v Format v

Insurance Information

Freeze fiDetach | ¢ Wrap

Statements | RaieSchedus  Insurances | Condition Detais

Company

Policy Information

> DashBoard
> Origination Account(s): 20170800010909: KALLAM NAVEEN 9 [Elview | o Audt
. View v Format + Freeze i Detach rap 8, ® Curent Show Al @) Group Follow-p
Servicing & Bl ® &
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due St
Servidng uso1 UsHQ UNDEFINED 2017080001080 LINE UNSECURED (VR) -1UsD 25,399.11 oo}
Customer Service = = w =
Securitization
Transaction Authorization
Sy Summary | Colections || Customer Service  Account Details | Customer Detais | Customer Preferences || Transaction Hstory | PmtModes | Bankruptcy | RepofForedosure | Defidency | BL > ™
0st Date Che

Contract Information

C]

Poiicy *

Status
Sub Status

(Bl view || o Audit

Effective Dt Premium Amt Term Status

GaRetun

Refund Allowed __
Grace Days Cancelation Fee _

Contractual _ Insurance Mode Alowed
Insurance Type Phone Cancelation Fee
Insurance Plan Phane 2 Complete Refund __
T S Term Remaining
Policy # 2 Refund Calaation Method
5 v Expiry Dt
PHEL S Effective Dt Taw Grace Days
> WP Premium Amt Commission Amt Estimated Refund Amt
> Tools Commission Rule Cements Received Refund Amt
Primary Beneficiary Itemization
b Setupi Cancellation/Refund

Secondary Beneficary Polcy Cancaliation Dt Deduct Fee From -

3. Onthe Insurances screen, view the following information in Insurance Information

section:

In this field:

View:

Contractual

If selected, indicates that the insurance policy is required by
contract.

Insurance
Type

The insurance type.

Company

The insurance company.

Policy#

The insurance policy number.

Effective Dt

The insurance effective date.

Premium Amt

The insurance premium amount.

Term

The insurance term.

Status

The insurance status.

Click View and view the following information:

In this field:

View:

Policy Information section:

Contractual

If selected, indicates that the insurance policy is
required by contract.

Insurance Type

The insurance type.

Insurance Plan

The insurance plan.

Company

The insurance company.

Policy#

The insurance policy number.
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In this field:

View:

Effective Dt

The insurance effective date.

Premium Amt

The insurance premium amount.

Commission Rule

The rule of commission.

Primary Beneficiary

The primary beneficiary of the insurance.

Secondary Benefi-
ciary

The secondary beneficiary of the insurance.

Status

The status.

Sub Status

The sub status.

Insurance Mode

The insurance mode.

Phone The insurance company’s primary phone number.
Phone 2 The insurance company’s alternate phone number.
Itemization The contract itemization.

Expiry Dt The insurance expiry date.

Term The term of insurance.

Commission Amt

The insurance commission amount.

Comments

The comments regarding the insurance policy.

Cancellation/Refund section:

Policy Cancellation Dt

The insurance cancellation date.

Refund Allowed

If selected, a refund is allowed. A selected box indicates
that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

Grace Days Cancella-
tion Fee Allowed

If selected, indicates that cancellation fees during grace
period is allowed.

Cancellation Fees

View amount of the cancellation fee to be charged when
the insurance is cancelled.

Complete Refund

If selected, a complete refund is allowed.

Term Remaining

The remaining term on the insurance at cancellation.

Refund Calculation
Method

The refund calculation method.

Grace Days

View the number of grace days allowed for cancellation
without charging a cancellation fee.

Estimated Refund Amt

The estimated insurance refund.

Received Refund Amt

The insurance refund received.
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In this field: View:

Itemization The contract itemization.

4. Inthe Insurance Tracking section, click Create Tracking. The system loads insurance
tracking parameters in the Insurance Tracking section.

5. If you want to reduce the list of parameters, select a sub attribute in the unlabelled Sub
Attribute box next to Create Tracking button.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

6. Click Edit and complete the Parameter and Value fields.

7. Click Save.

Condition Details sub tab

The Customer Service screen’s Condition Details tab displays the detailed log report of
Account Vs Queue configuration changes i.e. every time an account has been changed from
one queue/user/condition to another.

To view Condition Details

1. Open the Customer Service screen and load the account you want to work with.

2. Click Account Details tab, then click Condition Details sub tab.

ORACLE’ ABSHEKAR ~ 1§ Signout &
Financial Services Lending and Leasing
> DashBoard Customer Service [3] Close:
> Origination Summary || Customer Service | Account Details | Customer Details | Transaction History || PmtModes | Bankruptcy | RepofForedosure | Defidenc > ~
Servicing = =
AccountDetsils | Statements | Rate Schedule | Insuwrances  Condition History | Securitization | Contract Information
Servicing -
Customer Service
Seauritization Condition History
Transaction Authorization E View > Format~ Fresze i Detach Wrap et}
Post Date Checks User Responsibility Account Condition Queue Desc Changed Dt Reason
Escrow Transactions RMACHARL SUPERUSER PAYOFF/TERMINATION IN PROGRESS PAYOFF/TERMINA .. 07/14/2016 06:01: .. INTERNAL-QUEUE - 7
Account Documents. i RMACHARL SUPERUSER PAYOFF/TERMINATION IN PROGRESS PAYOFF/TERMINA... 07/14{2016 05:01:... INTERNAL-QUEUE
Collsteral Management RMACHARL SUPERUSER PAYOFF/TERMINATION IN FROGRESS PAYOFF/TERMINA... 07/14/2016 04:01:... INTERNAL-QUELE ...
Reports 9 RMACHARL SUPERUSER PAYOFF/TERMINATION IN PROGRESS PAYOFF/TERMINA .. 07/14/2016 03:01 INTERNAL-QUEUE
Producers RMACHARL SUPERUSER PAYOFFTERMINATION IN PROGRESS PAYOFF/TERMINA . 07/14/2016 02:05:.. INTERNAL-QUEUE
Vendors RMACHARL SUPERUSER PAYOFF/TERMINATION IN PROGRESS PAYOFF/TERMINA... 07/14/2016 01:01:... INTERNAL-QUELE ... L
Batch Transactions RMACHARL SUPERUSER PAYOFF /TERMINATION TN PROGRESS PAYOFF/TERMIMA . 07/14/2016 12:01: . INTERMAL-QUEUE 1
Advances RMACHARL SUPERUSER PAYOFF [TERMINATION IN PROGRESS PAYOFF/TERMINA . 07/14/2016 11:01: .. INTERNAL-QUEUE
T, RMACHARL SUPERUSER PAYOFF/TERMINATION IN PROGRESS PAYOFF/TERMINA... 07/14/2016 10:56:... INTERNAL-QUELE
Fees RMACHARL SUPERUSER PAYOFF/TERMINATION IN FROGRESS PAYOFF/TERMINA... 07/13/2016 04:01:... INTERNAL-QUELE ...
S E RMACHARL SUPERLSER. PAYOFF fTERMINATION IN PROGRESS PAYOFF/TERMINA .. 07/13/2016 03:51: .. INTERMAL-QUEUE
” Collections RMACHARL SUPERUSER PAYOFFTERMINATION IN PROGRESS PAYOFF/TERMINA... 07/13/2016 01:01:... INTERNAL-QUEUE
> WFP RMACHARL SUPERUSER PAYOFF[TERMINATION IN PROGRESS PAYOFF/TERMINA... 07/13/2016 12:01:... INTERNAL-QUELE ...
ot RMACHARL SUPERUSER PAYOFFfTERMINATION IN PROGRESS PAYOFF/TERMINA .. 07/13/2016 11:01:... INTERNAL-QUELE
e RMACHARL SUPERUSER PAYOFFTERMINATION IN PROGRESS PAYOFF/TERMINA ... 07/13/2016 10:0%:... INTERNAL-QUELE .. ~

The Condition Details tab is further categorized into following sections:

e Condition/Queue
e Condition/Queue History

Condition/Queue

The Condition/Queue section displays the closed Conditions, Queues and User changes
which were defined initially and later re-assigned to different Queues with Hard Assigned
Users.

A current active Condition can be opened in any of the following cases:

e When a Call Activity is posted with Conditions on account
e When Conditions are posted by specific batch events

e When Conditions are posted by specific transactions (For example, Borrower on Military
duty)
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The Condition/Queue section displays the following information:

e User (Current Queue Assigned User If any)
e Responsibility (Current User Responsibility)
e Account Condition

e Queue Description

e Condition Start Dt

e Queue Start Dt

e User Start Dt

Condition/Queue History

The Condition/Queue section displays only the closed Conditions which were defined on the
account and later was re-assigned to different Queues with Hard Assigned Users.

The Condition/Queue History section displays the following information:
e User (Old Queue Assigned User If any)
e Responsibility (Old User Responsibility)
e Account Condition
e Queue Description
e Start Date
e EndDate
e Changed Date
e Change Reason
e Reason (specified in Queue Assignment tab)

In the Condition/Queue History section, select the required record and click ‘View’.

4.6.7 Contract Information sub tab

The Customer Service screen Contract sub tab enables you to view contract and truth-in-
lending information recorded during the funding process. It's a display only version of the
same information found on the Funding screen’s Contract screen.

To view an account’s contract information
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Account Details tab, then click Contract Information sub tab.

ORACLE
Financial Services Lending and Leasing

# Welcome, VAVAIDYA v P ] &
E 3 B

ey Customer Service ®close
 Origination Search  Customer Service: 2015120011200 Review Request (Pending: 1)
Servicing
Senidia Account(s): 20151200011200: MURRAY RICHARD [Elvien || auit
Customer Senice View~ Fomatv [ Freeze EfiDetach | dwap W) & @ Curent O ShowAll O Group Follow-up
Secuiization Company ranch Sub Unit Acount = Product Days Past Due Currency Pay Off At Amount Due Status Oldest Due Dt
Transaction Authorization Ust1 UsH UNDEFINED 0151200011200 LINE UNSECURED (VR 10 UsD 3601783 0,00 ACTIVE 01/01/2016

Post Date Checks

Escrow Transactions
Summary | CustomerService | Account Details | Customer Detalls | Transaction History Pt Modes  Bankruptcy | RepojForecosure | Deficency | Bureau | Cross/Up Sell Actvities

Account Documents
Colateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
6L Transactions
CASA Reconcilation
Comversion Accounts

Account Details ~ Statements Rate Schedule Insurances  Contract Information

Contract Information
Vienw Fomaty [

Freeze  §fi Detach e @

Contract Dt Credit Limit Drav Term Reprt Tem
1122015 3580000 200 6000
Contract Information

Contract Dt 12/12/2015
Credit Limit 35,900.00

DrawTerm 24,00
Repmt Term 60.00
Tem €0.00

Maturiy Dt 12/0/2020
Index PRIMERATE
IndexRate 899
Vargin Rate (+) 499
Interest Rate (=) 1398
IstPmt Dt 01/01/2016
DueDay 100
Contract Recvd Dt 12/12/2015
Contract Verify Dt 12/12/2015
Contract Verified By DEMOSUPR
Tnstrument  LINE OF CREDIT URSECURED

Term Maturity Dt Index
60.00 12/01/2020 PRIVE RATE

Base Method ACTUAUACTUAL
¥in Initial Advance 1,000.00
Max Titial Advance 10,000.00
Hin Advance 1,000.00
HaxAdvance 10,000.00

Promotion

Promation NONE
Tipe NONE
Period 0.00

Tndex
Index Rate 0.00
MarginRate (+) 0,00
Promotional Rate (=) 0.00

[E] view

IndexRate  Margin Rate (+)  Interest Rate (=) 1st Pt Dt Du
] 49 1398 03/01/2016

Caetum

MaxRate Increase / Life 5.00

Max # Adjustments | Year 99.00

Max # Adju Life 999.00

Vi Inteest Rate (Floor) 500

Max Interest Rate (Celing) 20.00

Draw Term 6illing Method PERCENTAGE OF PRINCIPAL PLUS
INTEREST

Drawi Term Pt % 2.00
Repmt Term Biling Method PERCENTAGE OF PRINCIPAL PLUS
INTEREST

Repmt Term Payment % 2,00
Hinimum Pt 50,00

Min Finance Charge 1,00
Tolerance Amt 10,00
Tolerance % 000

i Rate Cap & Adjustment
Rl Strt Dt Bosis EFFECTIVEDATE S AN
= Accrual Past Maturity
> WFP Start Days 0 Max Rate Increase f Year 2.00 Vaturity Index. PRIVE RATE
Accrus Method AVERAGE DAILY BALAN
Sraly ccrual Method AVERAGE DAILY BALANCE Maturity Margin Rt 499
> Setup =

3. Line of credit Use the following sub tabs to view more information about the contract, if
available:

e Contract

e Repayment

e Itemization

e Trade-In

e Insurances

e ESC

e Compensation
e Subvention

e Proceeds

e Disbursements
e Fees

e ACH

e Coupon

o PDC

e References

e Real Estate

For more information on the sub tabs of the Contract tab, refer the section Contracts tab in
Funding chapter of the Origination User Guide.

Trade Details sub tab

Oracle Financial Services Lending and Leasing provides a end-to-end framework for trading
of accounts and transfer of equity from an existing (old) account to a new account. To know
in detail about process and workflow, refer to ‘Appendix - Trading of Accounts’ section.
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The Trade Details sub tab in Account Details tab displays account level Trade related
information. This is a ‘View-Only’ screen and consists of the following two sections:

e Trade Details - indicates ‘“Trade Equity’ information with ‘Equity In’ and ‘Equity Out’
details of the traded accounts and Revenue Recognition information captured as part of
batch job processing.

e Equity Transfer Details - indicates equity transfer between From and To accounts, the
‘Equity Transferred’ value and ‘Status’ of Trade.

To view the Trade details

1. Open the Customer Service screen and load the account you want to work with.
2. Click Account Details tab, then click Trade Details sub tab.

ORACLE’ # Welcome ABSHEKAR ~ 1g. sign out O
Financial Services Lending and Leasing

Customer Service x %] Close:

Search | Customer Service: ASSO_RAH_AFTR_INT_0002 Review Request (Pending: 0)  Queue Assignment

Account(s): ASSO_RAH_AFTR_INT_0002: DOE JOHN Bl view || &2 audit
View v Formatv [ Freeze E4] Detach Wrap W & @ curent O Show All O Group Follow-up () Assodiated Accounts
Company Branch Sub Unit Account # Master Account #  Master Account  Product Billng Cycle Purpose Days Past Due Currency
NLO2 NBO1 UNDEFINED ASSO_RAH_AFTR__... MASTER RAH_AF... N LOAN INTEREST ACCRUED MONTHLY 16 NzD
Summary = Collections = Customer Service ~ Account Details = Customer Details = Customer Preferences =~ Transaction History =~ Pmt Modes = Bankruptcy | Repo/Foreclosure ~ Deficiency = Collateral | Bureau = Timeli > ~

Account Details | Statements = Rate Schedule | Insurances = Condition Details | Securitization = Contract Information = Trade Details

Trade Details [l view || « Audit
View v Format v [} Freeze [ Detach Wrap ®
Trade . Current Qualification Month End i Date of Previous
Eoulty Equity In Equity Out RevRec Equity Terget RevRec Equity - Qualfication Tnd D2t of Qualfication oS50 LT
0.00 8,705.00 0.00 0.00 0.00 =
»
Equity Transfer Details (=l view || & Audit “
View v Format v [P Freeze [ Detach Wrap 20}
From Account # To Account # Equity Transferred Trade Type
ASSO_RAH_INT_0002 /ASSO_RAH_AFTR_INT_0002 8,705.00 UPGRADE

3. Inthe Trade Details section, view the following details:

In this field: View:

Trade Equity View the value of current Account Trade Equity.

This is calculated using the configurable calculation value
defined for ACC_EQUITY_AMT in Setup > User Defined
Parameters screen.

This value is re-calculated during trade transaction.

Equity In View the total of all Equity transferred ‘from’ different old
account(s) contributing to trade.

This field is updated when ‘Equity In Transfer Transaction’ is
processed during trade.

Equity Out View the total of all Equity transferred ‘to’ different new
account(s) as part of trade.

This field is updated when ‘Equity Out Transfer Transaction’ is
processed during trade.
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In this field:

View:

The below fields indicate the Revenue Recognition details of the Account and are
populated on executing the ‘Revenue Recognition Processing Batch Jobs’.

Note: In Vacation Ownership Industry, Vendors recognize revenue when equity becomes
greater than or equal to threshold value (X)% of net sale price of the asset on the con-
tract. Once the revenue is recognized, Account is marked as Qualified (i.e. Target Reve-

nue is recognized).

RevRec Equity

View the Account Revenue Recognition Equity Amount. The
value is populated based on calculation defined in User
Defined Parameters.

Target RevRec
Equity

View the Account Target Revenue Recognition Equity Amount.
The value is populated based on calculation defined in User
Defined Parameters.

Current Qualification
Ind

View the Account Revenue Recognition Qualifier indicator.
Here 'Y’ indicates that the Contract Equity is ‘greater than or
equal to’ Account Revenue Recognition Equity.

Month End Qualifica-
tion Ind

View the Account Revenue Recognition Qualifier Month End
indicator. Here ‘Y’ indicates that account qualification is
required at end of month.

Date of Qualification

View the Account Revenue Recognition Qualifier Date.

Date of Previous
Qualification

View the Last Account Revenue Recognition Qualifier Date
when the account was previously qualified.

Revenue Recognition Processing Batch Jobs

Following are the Revenue Recognition processing batch jobs:

Note that, both the batch jobs picks-up all the accounts only with ‘ACTIVE’ status, the Trade
Equity greater than zero and Master Account indicator set as ‘N’.

e DAILY REVENUE RECOGNITION PROCESSING (SET-REV1 Batch Job Set)
This batch job is processed daily and is used to validate if Account Revenue

Recognition Equity is ‘greater than or equal to’ Target Revenue Recognition Equity. If
yes, the Current Qualification Indicator is set to ‘Y’. However, the above validation is
ignored and Current Qualification Indicator is always set to ‘N’ if the account is having
any condition listed in the lookup code REVREC QUALIFIER EXCLUSION ACCOUNT
CONDITION.

e MONTH END REVENUE RECOGNITION PROCESSING (SET-REV2 Batch Job Set)

This batch job is processed monthly and is used to validate the status of ‘Account
Revenue Recognition Qualifier indicator’ and update the following fields as indicated in
below table.

— Account Revenue Recognition Qualifier Month End indicator (after month end
processing)

— Account Revenue Recognition Qualifier Date
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— Last Account Revenue Recognition Qualifier Date

Account Revenue Last
Account . Account
Recognition Account
Revenue o Revenue
Date of o Qualifier Month o Revenue
. Recognition s Recognition o
Processing e End indicator (after o Recognition
Qualifier Qualifier e
g month end Qualifier
indicator . Date
processing) Date
01-Jan-19 N N
15-Jan-19 Y N
31-Jan-19 Y Y 31-Jan-19
01-Feb-19 N Y 31-Jan-19
28-Feb-19 N N 31-Jan-19
01-Mar-19 Y N 31-Jan-19
31-Mar-19 Y Y 31-Mar-19
01-Apr-19 Y Y 31-Mar-19
30-Apr-19 Y Y 31-Mar-19
01-May-19 N Y 31-Mar-19
15-May-19 Y Y 31-Mar-19
31-May-19 Y Y 31-Mar-19

4. In the Equity Transfer Details section, view the following details:

In this field:

View:

From Account #

Existing (old) account number or Source account number.

To Account #

New account number or Target account number.

Equity Transferred

Value of Equity transferred to new account as part to trade.

Trade Type

Type of Trade transaction processed as one of the following:
UPGRADE

SPLIT

COMBINE

For more details on Trade Type, refer to ‘Trade Transaction’
section.

Status

Status of Trade transaction processed as one of the following:
OPEN

COMPLETED

FAILED

5. Click Refresh to update the latest details on screen.
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Customer Service screen’s Associated Accounts tab

The Associated Accounts screen displays all the accounts associated with the selected
Master Account in the ‘Associated Account Details’ section along with a summary of rolled-up
balances for the accounts being displayed.

In the ‘Associated Account Details’ you can use a combination of following type of filters to
sort and display the matching account(s).

e Product Type - Here you can either select a specific product or select ‘All’ to display
corresponding accounts in combination of Master and associated accounts. However,
system defaults this option based on the product type of Master Account.

Command

Button: Action Performed:

Loan If selected, system filters and displays all Loan accounts associated
with Master Account. The ‘Summary’ section displays consolidated/
rolled-up balance of all accounts including Master account if the same
is also a ‘Loan’ account.

Line If selected, system filters and displays all Line accounts associated
with Master Account. The ‘Summary’ section displays consolidated/
rolled-up balance of all accounts including Master account if the same
is also a ‘Line’ account.

Lease If selected, system filters and displays all Lease accounts associated
with Master Account. The ‘Summary’ section displays consolidated/
rolled-up balance of all accounts including Master account if the same
is also a ‘Lease’ account.

All If selected, system displays all accounts associated with Master
Account of same currency. The ‘Summary’ section displays consoli-
dated/rolled-up balance of all accounts including Master account.

e Statement Consolidation Only - If check box is selected, system filters and displays ALL
or Product Type specific accounts having the Statement Consolidation indicator
enabled. The ‘Summary’ section displays consolidated/rolled-up balance of all
displayed accounts including Master account if the same also has the statement
consolidation indicator enabled.

— By default this check box is not selected and system displays ALL/selected Product
Type irrespective of the Statement Consolidation indicator (Enabled or Disabled).

e All Currencies - By default, system displays only those accounts having the same
currency as that of Master Account. Clicking on this check box displays all the accounts
associated with Master Account irrespective of the currency with which the account is
operated. Also if checked, only the Accounts counters are updated in ‘Summary’ section
and Dues are reset to zero.

e Agreement Number - This option provides a drop-down list with all unique agreement
numbers present in the sorted list of account(s). On selecting any of the Agreement
Number from the drop-down list, system filters and displays only those accounts
associated with the selected agreement number.

At the bottom of the grid, you can view the Count with total number of records displaying in
Associated Account Details.

To view associated account details
1. Open the Customer Service screen and load the account you want to work with.
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2. Click ‘Associated Accounts’ sub tab.

ORACLE’
Financial Services Lending and Leasing

NextGenUl & Welcome ABSHEKAR v i Sign Out [PrOD] &

Customer Service x

Search ~ Customer Service: NAVEENA || Review Request (Pending: 0) | Queue Assignment

Account(s): NAVEEN4: NAPHADE 3 PAVAN

& view

(3] Close

< Audit

View v Fomat+ [ Freeze  Hf Detach Wrap W & O curent O Show All O Group Follow-up @) Associated Accounts  pgreement Number v o
Company Branch Sub Unit Account # Master Account # Sales Order Number Master Account Product
SAD3 SAHQ1 UNDEFINED NAVEEN4 NAVEEN4 Y LOAN-VE-PAVAN

AGREDITS105

»
View v Format =

Summary

Total Delq Due
Total LC Due
Total NSF Due
Total Other Due
Total Due

Total Due(ine]
current due)
Tt Do

Summary = Collections

Associated Account Details

=

Select ] .
Al — Account #

Dues
0.00
0.00
0.00
0.00
0.00
0.00

ann

Count: 1

Customer Service  Account Details ~ Associated Accounts  Customer Details ~ Customer Preferences ~ Transaction History ~ Pmt Modes Bankruptcy Repo/F > ™

----------- Product (C) Loan () Lease () Line (@ All Statement Consolidation [ Al mg
Freeze [ Detach Wrap 5t} Type only -] i B2 agreement Number
Title Product Currency Billing Cydle Delg Days Pay Off Amount  Amount Due Oldest Due 1"+
3
Accounts
No. of Active
Accounts 4
No. of closed
Accounts
No. of Paid Off

Accounts

A brief description of ‘Associated Account Details’ are given below:

In this field:

View this:

Account # The account number.
Clicking on the hyperlink opens the respective account
in Customer Servicing screen.
Title The title of the account.
Product The type of product associated with the account.
Currency The disbursement currency.

Billing Cycle

The billing frequency.

Delq Days

The number of days the account has been delinquent.

Pay Off Amount

The total pay off amount on the account.

Amount Due

The total amount due on the account.

Oldest Due Dt

The oldest payment due date on the account.

Status The status of the account.
Asset Type The type of asset associated with the account.
Asset Sub Type The asset sub type.

Collateral Description

Details of primary collateral associated with account.

In case of Home Collateral, no Collateral Description is
displayed.

Identification #

The identification number of the asset.

Company

The portfolio company.
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In this field:

View this:

Branch

The portfolio branch.

Statement Consolidation

If checked, this account will be part of Consolidated
‘MASTER CUSTOMER/BUSINESS STATEMENT’ gen-
erated at Master Account. Else, this account is not
included in Consolidated ‘MASTER CUSTOMER/BUSI-
NESS STATEMENT.

Linked Account

The linked Account number.

The same is displayed as UNDEFINED if the account is
neither marked as ‘Master Account’ nor ‘Linked to
Existing Associated Account’.

The ‘Summary’ section displays the rolled-up balances of the following fields in all accounts

displayed:

In this field:

View this:

Dues section - This section displays the total number of accounts available for the
selected filter combination of Master and Associated accounts.

Total Delq Due

The total of delinquent amount due on all the filtered
accounts at Associated Account Details tab.

Total LC Due

The total non-sufficient fee due amount on all the
accounts.

Total NSF Due

The total of non-sufficient funds fee due on all the
accounts.

Total Other Due

The total of any other dues pending on all the accounts.

Total Due

The total of all dues including payment amount and all
applicable fees on all the accounts.

Total Due (incl current due)

The total of additional due of current month (included
based on pre-bill days) on all accounts.

Total PayOff Amount

The total amount payable by the borrower of all
accounts if the same is to be paid off as per the current
date.

Accounts section - This section displays the total number of accounts available for the
selected filter combination of Master and Associated accounts.

No. of Active Accounts

Total Number of Active accounts.

No. of closed Accounts

Total Number of Closed accounts.

No. of Paid Off Accounts

Total Number of Paid Off accounts.
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4.8

Customer Service screen’s Customer/Business De-

tails tab

Open the Customer Service screen and load the account you want to work with. Click the

Customer/Business Details tab to view the sections under it.

If the selected account belongs to an individual Customer, this tab is displayed as ‘Customer
Details’ and if there is no customer linked and only a business is involved in the account, this
tab is displayed as ‘Business Details’. In case both Customer and Business are involved in

the account, this is still displayed as ‘Customer Details tab’ and both the sub tabs ‘Customer’

and ‘Business’ are displayed.

Customer/Business Details screen displays the information gathered on application entry
process regarding the customer and customer’s address, employment data, phone numbers
and credit score. Using this screen, you can update or add to a customer’s address,
employment information, or phone listing. Whenever you add or edit the details, a system
generated comment will be posted in the account to keep record of old and new details.

Note that the ‘Edit’ option on this screen has user level security defined and based on your
responsibility, you can either edit a few or all of the fields. The difference is that, you may
either have access to edit only non-PlII (Personal Identifiable Information) fields or edit all
possible fields as per the customer maintenance transaction.

The list of possible editable fields in both these scenarios is given below:

Edit non-PlIl fields

All editable fields

Marital Status

Birth Date

Language Marital Status
Education Language
Mother's Maiden Name Education

Class Type Mother's Maiden
Email Class Type
Stop Correspondence Email

Disability Stop Correspondence

Skip Disability

Privacy opt out Skip

Existing CIF Privacy Optout
Existing CIF

Identification Details like

Passport

Issue Date

Expiry Date
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4.8.1

Edit non-PlIl fields

All editable fields

Visa #

Nationality

National ID

SSN

License #

License State

Customer sub tab

Using the Customer sub tab, you can view and update the existing Customer details. When
an existing record is updated and saved, the same becomes the current/primary details of the
customer and the current indicator is set to ‘Y’ by default. In such a case, the previous
customer details are disabled (set to N). You can select the ‘Show All' check box in Customer
Information section to view the disabled records along with current record.

To view or edit customer information

1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.
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In the Customer Information section, click ‘Edit’. You can also perform any of the Basic

Operations mentioned in Navigation chapter. A brief description of the fields are given

below:

In this field:

View this:

Customer Information section

Customer #

Customer number.

Relation

Customer ‘s relation with the bank.

ECOA

The Equal Credit Opportunity Act code.
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In this field:

View this:

Name

Customer’s name.

Birth Dt

Customer’s date of birth.

Marital Status

Customer’s marital status.

Enabled Status of the account.
Language Customer’s language.
Education Customer’s education.

Mother’s Maiden
Name

Customer’s mother’s maiden name.

Class Type

Customer’s class type.

Email

Customer’s e-mail address.

Stop Correspond-
ence

Customer’s stop correspondence indicator. If selected, this indi-
cates that the system will not send the customer any correspond-
ence, such as monthly statements. This is selected using the
Maintenance screen.

Disability Customer’s disability indicator.

Skip Customer’s skip indicator. If selected, this indicates that the cus-
tomer is a skip debtor. This is selected using the Maintenance
screen.

Bankruptcy Customer’s bankruptcy indicator.

Privacy Opt-Out

Privacy opt-out indicator. If selected, indicates that the applicant
has elected to refrain from the non-public sharing of information.

Insurance Opt Out

Insurance Opt Out indicator. If selected, indicates that the appli-
cant has elected to refrain from insurance related inquiries.

Marketing Opt Out

Marketing Opt Out indicator. If selected, indicates that the appli-
cant has elected to refrain from marketing related inquiries.

Share Credit Opt
Out

Share Credit Opt Out indicator. If selected, indicates that the appli-
cant has elected to refrain from financial information and share
credit related inquiries.

Existing CIF

If selected, indicates that the customer is an existing CIF.

Update Customer
Info

If selected, indicates that the system was allowed to override the
existing customer information with the latest address and commu-
nication details during account creation.

Identification Details section

Passport # Customer’s passport number.
Issue Dt Passport issue date.
Expiry Dt Passport expiry date.
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In this field:

View this:

Visa # Customer’s visa number.

Nationality Customer’s nationality.

National ID Customer’s national identification.

SSN Customer’s social security number. If the organizational parame-
ter UIX HIDE RESTRICTED DATA is settoY, this appears as a
masked number; for example, XXX-XX-1234.

License # Customer’s licence number.

License State

State where the licence was issued.

Payment Hierar-
chy

The payment hierarchy is auto-populated by the system based on
following conditions:

e While funding an application with new customer details, the
payment hierarchy is populated with value specified in system
parameter PMT_HIERARCHY_CODE.

e While funding an application with existing customer details, the
same payment hierarchy selected for existing customer record
is populated.

The auto populated payment hierarchy can be modified by select-
ing the required value from the drop-down list. This list is popu-
lated based on the hierarchy definitions maintained in Setup >
Administration > User > Payment Hierarchy screen.

Military Service

Active Military
Duty

Active military duty indicator. If selected, indicates that customer is
on active military duty and may qualify for rates in accordance with
the Service members Civil Relief Act of 2003 (SCRA).

Effective Dt

The effective date

Order Ref # The order reference number.
Release Dt The release date.
Customer The deceased date of the customer. You can also post a non mon-

Decease Date

etary transaction to indicate if a customer is deceased. Refer to
section Mark Customer as Deceased for more information.

KYC section

Reference #

Specify the reference number of KYC document.

Status Select the status of KYC document from drop-down list.
FATCA section

Birth Place Specify the birth place of the applicant.

Birth Country Select the country of birth of the applicant from drop-down list.
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In this field:

View this:

Permanent US
Resident Status

Check the box to indicate if the applicant has permanent US resi-
dent status.

Power of Attorney section

Power of Attorney

Check the box to indicate that the applicant holds Power if Attor-
ney.

Holder Name

Specify the holder name of the power of attorney.

Address Specify the address of the attorney holder.

Country Select the country of the power of attorney holder from drop-down
list.

Nationality Select the country of the power of attorney holder from drop-down

list.

Telephone Number

Specify the telephone number of the power of attorney holder.

Credit Limit Details section

Max Limit

View the maximum credit limit amount sanctioned for this cus-
tomer.

Total Utilized Amt

View the total credit limit amount utilized.

Available Amt View the credit limit available amount from the sanctioned limit.
Hold Amt View the credit limit amount on Hold.

Suspended Amt View the credit limit amount suspended.

Grade View the grade of the customer.

Max Late Charge

View the maximum amount of late charge that can be levied for
this customer. However, there is no system validation performed
based on the amount specified.

Limit Expiry View the credit limit expiry date.
Limit Next View the date when credit limit has to be renewed.
Renewal

Utilization Details

% of Utilization

View the percentage of credit limit used to fund the account
against the customer.

Utilization Amount

View the amount of credit limit contribution of customer towards
Account current balance.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

When military duty transaction is posted on an account, the system does the following:

e Restricts the user from posting repossession/ foreclosure and bankruptcy activities on

the account.
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48.1.1

Posts “DO NOT CHARGE OFF” condition on that account to exclude the account from

Auto Charge Off process.

Addresses sub tab

1. Inthe Address sub tab, click ‘Add’. You can also perform any of the Basic Operations
mentioned in Navigation chapter. A brief description of the fields are given below:

In this field: View this:

Type The address type.

Current If selected, indicates that this is the customer’s current address.

Confirmed Check this box to indicate that the address is confirmed by the
customer.

Mailing Check this box to indicate that this is the customer’s mailing

address.

Permission to
Call

Check this box if customer has provided permission to contact
through the specified phone number.

Permission to
Text

Check this box if customer has provided permission to contact

through text message.

Country

The country.

Postal Address
Type

The postal address type.

Address #

The address.

Street Pre

The street pre.

Street Name

The street name.

Street Type

The street type.

Street Post

The street post.

Apt # The apartment number.
Address 1 The customer’s address.
Address 2 The customer’s address.
Address 3 The customer’s address.
Zip The zip code.

Zip Extn The zip code extension.
City The city.

State The state code.

Phone The phone number.
Address The address.
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In this field: View this:

Time Zone View the customer time zone auto populated form
TIME_ZONE_CD lookup code.

Census Tract/ The census tract/BNA code.

BNA Code

MSA Code The metropolitan statistical area (MSA) code.
Comment Comments regarding the address.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.1.2 Telecoms sub tab

When you add new Telecom details or update existing details and save the record, the same
becomes the current/primary Telecom of the customer and the current indicator is set to Y’
by default. In such a case, the previous Telecom details are disabled (set to N).

1. Inthe Telecom sub tab, click ‘Add’. You can also perform any of the Basic Operations
mentioned in Navigation chapter. A brief description of the fields are given below:

In this field: Do this:

Type Select the telecommunication type.

Phone Specify the phone number.

Extn Specify the phone extension.

Current Select if this telecom number is current.

Permission to Check this box if customer has provided permission to con-

Call tact through the specified phone number.

Permission to Check this box if customer has provided permission to con-

Text tact through text message.

Time Zone Select the applicant’s time zone.

Start Time Specify the best time to call start time.

End Time Specify the best time to end the call.

Period Specify the time period.

Best day to call | Select the preferred day of the week to contact the cus-
tomer from the drop-down list.

End Time Specify the best time to end the call.

Period Select the time period for the best time to call end time, AM
or PM, from the drop-down list.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.8.1.3 Employments sub tab

1. Inthe Employment sub tab, click ‘Add’. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields are given
below:

In this field: | View this:

Current If selected, indicates that this is the customer’s current address.

Permission Check this box if customer has provided permission to contact

to Call through the specified phone number.

Permission Check this box if customer has provided permission to contact

to Text through text message.

Type The occupation.

Employer The employer’s name.

Occupation The occupation.

Title The title.

Department | The department of the employment.

Country The country.

Address # The address line.

Address The employer’s address.

Line 1

Address The employer’s address.

Line 2

Zip The zip code.

Zip Extn The zip code extension.

City The city.

State The state.

Phone The work phone number.

Extn The work phone number extension.

Comment Comments regarding the employment.

Pay Day View or select the payment day of the month using the adjoining cal-
endar.
For OFSLL generated accounts, system propagates the Pay Date
defined in Origination > Application Entry > Applicant Tab > Employ-
ments Sub Tab and is editable.
For conversion accounts, you need to select the payment day.
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48.1.4

4.8.1.5

In this field: View this:

Next Pay The next payment day is auto populated based on the Pay Day and
Day Frequency specified. When ‘Pay Day’ is selected, system posts a
non-monetary transaction - EMPLOYMENT ADDRESS MAINTE-
NANCE to calculate the next payment day after the current date has
elapsed.

Frequency Select the income frequency from the drop-down list.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Tracking Attributes sub tab

You can add tracking attribute information to an application at any time on the Customer
Details screen’s Customer Tracking Attributes section.

The Tracking Attributes for Line of credit accounts in this screen can also be loaded in bulk

through file upload process. While doing so, ensure that the input data file definitions are in

sync with attribute names. Before processing the bulk upload, system validates if the Tracking
Attributes are already loaded. If not, system loads the Tracking Attributes and then updates
the details.

In the Tracking Attributes section, click Edit

When you click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute
box.

e If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the Parameter display.

e specify the requested parameter in the Value field and click Save.
Save any changes you made to the account.

Customer Score

Customer score or FICO score, also referred to as ‘Fair Isaac & Company’ credit score is a
numeric summary of credit history compiled by the three major credit bureaus - Equifax, Trans
Union, and Experian. This is obtained during Credit bureau pull and is one of the indicator for
a customer (SSN) in the entire credit report.

The Customer Score tab displays all the customer FICO score data maintained in the system.
Though the customer score is recorded while funding, the same can be captured and updated
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4.8.2

regularly during the life cycle of Line of credit to get a snapshot of credit score movements in

recent history.

m
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The customer score can be updated on required intervals by posting ‘Customer Credit Score
Update’ non-monetary transaction and the data is populated into this screen. For more
information, refer to Customer / Business Credit Score Update section.

In the ‘Customer Score Information’ section, select the required record and click ‘View’.

A brief description of the fields are given below:

In this field:

View this:

Txn Dt

View the transaction posted date.

Score Received Dt

View the date when customer score was received from credit
bureau.

Relation Type Code

View the account relation type (Primary, Spouse, and so on)
which are attached to account.

Source View the name of credit bureau from where the credit score is
received.
Score View the customer credit score value.

Reference Number

View the reference number associated with the credit score.

Reason Code

View the reason for posting this transaction.

Comments

Additional information if any.

Business sub tab

If this is a SME or Business Line of credit, information gathered on the application entry
process regarding the business and business’s address, partners data, affiliates data, phone
numbers and business credit score appears on the Customer Service screen’s Business sub

tab.

4-67

ORACLE



Using the Business sub tab, you can add new business details to an account and/or update
the existing business’s address, partners and affiliates information, or phone listing. New
business details can be added even after an account is created and is usually done in case
when the existing business is taken over by another business.

When you add new business or update existing details and save the record, the same
becomes the current/primary business of the customer and the current indicator is set to Y’
by default. In such a case, the previous business details are disabled (set to N). You can
select the ‘Show AII’ check box in Business Details section to view the disabled records along
with current business details.

On adding a new business, the Business # is auto generated by the system and other details
such as business’s Addresses, Telecoms, Partners and so on are to be manually updated.
Also, if there is a pre-defined Customer Credit Limit allocation to an existing business, the
same is reinstated to new business automatically.

You can also add/update business details by posting a non monetary transaction. For more
information, refer to Add/Update Business Customer Details section in Appendix chapter.
To add or edit business information

1. Open the Customer Service screen and load the account you want to work with.

2. Onthe Customer Service screen, click the Customer Details tab and then click Business.
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3. Inthe Business Details section, click ‘ADD’. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields are given

below:

In this field: View this:

Current ‘Y’ indicates that it is the current / primary business of
customer associated with the account. ‘N’ indicates a
non primary Business.

Business # View the system generated business number. This
field is displayed only while you update existing Busi-
ness details

Organization Type Select the Organization type from the drop-down list.
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In this field:

View this:

Type of Business

Select the Type of the business from the drop-down
list.

Business Category

Select the Business category from the drop-down list.

Name of the Business

Specify the name of business.

Legal Name Specify the legal name of the business.
Tax Id # Specify the Tax identification number.
Start Dt Select the Business start date from adjoining calendar.

# of Employees (Cur)

Specify the current number of employees at the busi-
ness.

# of Employees

Specify the number of employees at the business after
financing.

Contact Person

Specify the contact person at the business.

Business Checking
Bank

Specify the bank name of the business’s checking
account.

Bank Acc #

Specify the bank account number of the business.

Avg Checking Balance

Specify the average checking balance.

# of Locations

Specify the number of locations where the business is
established.

Management Since

Specify the year the current management was estab-
lished.

Payment Hierarchy

The payment hierarchy is auto-populated by the sys-
tem based on following conditions:

e While funding an application with new customer
details, the payment hierarchy is populated with
value specified in system parameter
PMT_HIERARCHY_CODE.

e While funding an application with existing customer
details, the same payment hierarchy selected for
existing customer record is populated.

The auto populated payment hierarchy can be modi-
fied by selecting the required value from the drop-
down list. This list is populated based on the hierarchy
definitions maintained in Setup > Administration >
User > Payment Hierarchy screen.

Stop Correspondence

Stop correspondence indicator. If selected, Oracle
Financial Services Lending and Leasing will not send
correspondence to the business.

Skip

Business’s skip indicator. If selected, indicates that the
Business has debts and the customer is a skip debtor.
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In this field:

View this:

Bankruptcy

Business’s bankruptcy indicator.

Privacy Opt-Out

Privacy opt-out indicator. If selected, indicates that the
business has elected to refrain from the non-public
sharing of information.

Insurance Opt Out

Insurance Opt Out indicator. If selected, indicates that
the business has elected to refrain from insurance
related inquiries.

Marketing Opt Out

Marketing Opt Out indicator. If selected, indicates that
the business has elected to refrain from marketing
related inquiries.

Share Credit Opt Out

Share Credit Opt Out indicator. If selected, indicates
that the business has elected to refrain from financial
information and share credit related inquiries.

Update Business Info

Value is auto populated and if selected, indicates that
the system was allowed to override the existing busi-
ness details with the latest address and communica-

tion details during account creation.

Email

Business’s e-mail address.

4. The below fields are displayed only while editing the details of an existing business and
information within the fields are populated from Origination > Customer Credit Limit

section:

Credit Limit Details section

Max Limit

View the maximum credit limit amount sanctioned for
this business.

Total Utilized Amt

View the total credit limit amount utilized.

Available Amt View the credit limit available amount from the sanc-
tioned limit.

Hold Amt View the credit limit amount on Hold.

Suspended Amt View the credit limit amount suspended.

Grade View the grade of the business.

Max Late Charge

View the maximum amount of late charge that can be
levied for this business. However, there is no system
validation performed based on the amount specified.

Limit Expiry

View the credit limit expiry date.

Limit Next Renewal

View the date when credit limit has to be renewed.

Utilization Details

% of Utilization

View the percentage of credit limit used to fund the
account against the business.
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Utilization Amount View the amount of credit limit contribution of Business
towards Account current balance.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.2.1 Addresses sub tab

1. Inthe Address sub tab, click ‘Add’. You can also perform any of the Basic Operations
mentioned in Navigation chapter. A brief description of the fields are given below:

In this field: View this:

Current If selected, indicates that this is the customer’s current address.

Permission to call Check this box if customer has provided permission to contact
through the specified phone number.

Permission to Text | Check this box if customer has provided permission to contact
through text message.

Confirmed Check this box to indicate that the address is confirmed by the
customer.

Mailing Check this box to indicate that this is the customer’s mailing
address.

Address Type Address type.

Country Country code.

Address # Address number.

Postal Type Postal type.

Pre Pre

Street Name Name of street.

Street Type Type of street.

Post Post box number.

Apt # Apartment number.

Address 1 Address.

Address Line 2 Address Line 2

Zip Zip code.

Zip Extn Zip extension.

City City.

State State.

Phone Phone number.

Ownership Ownership type.
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In this field: View this:

Time Zone View the business time zone auto populated form
TIME_ZONE_CD lookup code.

Comment Additional comments.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.2.2 Telecoms sub tab

When you add new Telecom details or update existing details and save the record, the same
becomes the current/primary Telecom of the business and the current indicator is set to ‘Y’ by
default. In such a case, the previous Telecom details are disabled (set to N).

1. In the Telecom sub tab, click ‘Add’. You can also perform any of the Basic Operations
mentioned in Navigation chapter. A brief description of the fields are given below:

In this field: View this:

Permission to Check this box if customer has provided permission to contact
call through the specified phone number.

Permission to Check this box if customer has provided permission to contact

Text through text message.

Telecom Type Select the Telecommunication type from the drop-down list.

Phone Enter the business phone number.

Ext Enter the phone extension.

Current Check this box to indicate that this is the current record.

Time Zone Select the business time zone from the drop-down list. The list is pop-

ulated with values form TIME_ZONE_CD lookup code.

Best day to call | Select the preferred day of the week to contact the business from the
drop-down list.

Start Time Specify the start time after when you can contact the business.
Period Select the period as AM/PM from drop-down list.

End Time Specify the end time before which you can contact the business.
Period Select the period as AM/PM from drop-down list.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.2.3 Partners sub tab

1. Inthe Partners sub tab, click ‘Add’. You can also perform any of the Basic Operations
mentioned in Navigation chapter. A brief description of the fields are given below:

In this field: View this:

Permission to | Check this box if customer has provided permission to contact
call through the specified phone number.
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In this field:

View this:

Permission to
Text

Check this box if customer has provided permission to contact
through text message.

First Name Partner’s first name.

Mi Partner’s middle name.

Last Name Partner’s last name.

Suffix Partner’s suffix.

SSN Partner’s social security number.

Birth Dt Partner’s birth date.

Birth Place Partner’s birth place.

Director Ind If selected, indicates that partner is the director of the business.
Networth Partner’s net worth.

Gross Income

Partner’s gross income.

Language Partner’s language.

Nationality Partner’s nationality.

Title Partner’s title.

Ownership Percentage of ownership held by the partner.
(%)

Email Partner’s e-mail.

Phone Partner’s phone.

Extn Partner’s phone extension.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8.2.4 Affiliates sub tab

1.

mentioned in Navigation chapter. A brief description of the fields are given below:

In the Affiliates sub tab, click ‘Add’. You can also perform any of the Basic Operations

In this field:

View this:

Organization
Type

Affiliate’s organization type.

Legal Name

Affiliate’s legal name.

Name of the Busi-

ness

Affiliate’s business name.

Tax ID #

Affiliate’s tax identification.

Ownership (%)

Affiliate’s percentage of ownership.

4-73

ORACLE



4.8.2.5

4.8.2.6

In this field: View this:

# of Employees Affiliate’s number of employees.

NAICS CODE Affiliate’s North American Industry Classification System code.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Tracking Attributes sub tab

You can add tracking attribute information to an application at any time on the Business
Details screen’s Business Tracking Attributes section.

The Tracking Attributes for Line of credit accounts in this screen can also be loaded in bulk

through file upload process. While doing so, ensure that the input data file definitions are in

sync with attribute names. Before processing the bulk upload, system validates if the Tracking
Attributes are already loaded. If not, system loads the Tracking Attributes and then updates
the details.

In the Tracking Attributes section, click Edit

When you click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute
box.

e If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the Parameter display.

e specify the requested parameter in the Value field and click Save.
Save any changes you made to the account.

Business Score

Business score or business credit score is a numeric summary of business credit history
compiled by the three major credit bureaus - Equifax, Trans Union, and Experian. This is
obtained during Credit bureau pull and is one of the indicator for a business account in the
entire credit report.

The Business Score tab displays all the business score data maintained in the system.
Though the business score is recorded while funding, the same can be captured and updated
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4.9

regularly during the life cycle of business Line of credit to get a snapshot of credit score
movements in recent history.

ORACLE & Welcome ABSHEKAR ~ 1 Signout
Financial Services Lending and Leasing

Customer Service 3 3] Close

Business

Business Details

o add | PEdt | [E] view | o Audit

View v Format + % Freeze ﬂ' Detach Wrap @ﬂ Show Al []
Current Business # Organization Type  Type of Business Business Category  Name of the Business Legal Name
¥ 0000004003 C CORP CORPORATE SEED INFOTECH >5EED INFOTECH

4 m *

Addresses | Telecoms = Partners = Affiiates = Tracking Attributes  Business Score

Business Score Information [El view | o Audit
Wiew ¥ Format v % Freeze i Detach Wrap @ﬂ
Tun Dt Score Received Dt Source Score Reference Number  Reason Code Comments
05/02/2019 03f23/2018 EFX 950 123 CHECKING

The business score can be updated on required intervals by posting ‘Business Credit Score
Update’ non monetary transaction and the data is populated into this screen. For more
information, refer to Customer / Business Credit Score Update section.

In the ‘Business Score Information’ section, select the required record and click ‘View’.

A brief description of the fields are given below:

In this field: View this:

Txn Dt View the transaction posted date.

Score Received Dt View the date when business score was received from credit
bureau.

Source View the name of credit bureau from where the credit score is
received.

Score View the business credit score value.

Reference Number View the reference number associated with the credit score.

Reason Code View the reason for posting this transaction.

Comments Additional information if any.

Customer Service screen’s Customer/Business Pref-
erences tab

The Customer/Business Preferences tab allows you to define the customer communication
preferences at an account level for each relation type associated with the account. The details
of this tab are populated to Customer Service > Collections tab for further action.

If the selected account belongs to an individual Customer, this tab is displayed as ‘Customer
Preferences’ and if there is no customer linked and only a business is involved in the account,
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this tab is displayed as ‘Business Preferences’. In case both Customer and Business are
involved in the account, this is still displayed as ‘Customer Details tab’.

However, if any of the following transactions are posted on the account the defined customer
communication preferences are disabled and can be manually enabled in specific conditions:

e Customer marked as ‘Deceased’

e Changed relation to primary customer

e Disabled/enabled non primary customer relationship

e Swapped relationship

To view or edit customer/business preferences

1.

Open the Customer Service screen and load the account you want to work with.

2. Click Customer/Business Preferences sub tab.
ORACLE'

Financial Services Lending and Leasing

Customer Serviee .
summary | Collections | Customer Service | Account Details

Customer Preferences
View = Format~ P Freeze i Detach

Relation Type Communication Mode

PRIMARY EMAILL ADDRESS

P

Customer Preferences

*Relation Type PRIMARY

* Commurication Mode | ADHOC TELECOM

@

Customer Detals

Email

TEST@TEST.COM

*Phone 898(713)-211-5123
Extn 93758

Permission to Call ¥

[ Save and add

Customer Preferences | Transaction Hstory | FmtMades | Barkiupicy | RepofForedosure | Deficency | Collateral || Bureau

L

Phone

Hsaveand sty

StartTime 00:05
Period PM

EndTime 00:05

7 edit
o it

Exin Permission to Call  Time Zone

[ ssve nd Retum

Timeline || CrossjUpsel >~

3] Close

b

Carewmn

=

+Type GTHER HOME PHONE &

Time Zone  US/PACIFICHEW [=l Period PM [=]

BestDay to Call FRIDAY = * enabled []

3. Inthe Customer/Business Preferences section, click ‘ADD’. You can also perform any
of the Basic Operations mentioned in Navigation chapter. A brief description of the fields

are given below:

In this field:

View this:

Relation Type

Select the account relation type from the drop-down list. The list
displays only those relationship types which are attached to
account and are enabled (excluding deceased customer rela-
tions).

Communication
Mode

Select the preferred mode of communication as one of the follow-
ing from the drop-down list.

EMAIL ADDRESS - if selected, system displays the email ID
associated with the selected contact in view mode and allows you
to enable/disable the customer preference record.

TELECOM - if selected, you can further select the type of commu-
nication option as Telecom type, Address or Employment for
which the permission to call indicator is “Y’. On selection, the other
details are auto-populated based on the details maintained in Cus-
tomer Service > Telecom, Address and Employment tabs. You can
also enable/disable the customer preference record.

ADHOC TELECOM - if selected, you can specify the following
field information.
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In this field:

View this:

Type

Select the preferred type of communication option from the drop-
down list. The list displays the options maintained in TELECOM_-
TYPE_CD lookup.

Phone

Specify the phone number of the selected contact.

Note: On saving the record, system updates the specified phone
number into ‘Telecom’ tab by internally posting a non-monetary
transaction ‘EMPLOYMENT ADDRESS MAINTENANCE'.

Extn

Specify the extension (if any) for the selected contact.

Permission to Call

This check box is selected by default and indicates that the cus-
tomer has provided permission to contact through the specified
phone number.

Time Zone

Select the contact’s time zone.

Best Day to Call

Select the preferred day of the week to contact the customer from
the drop-down list.

Start Time Specify the start duration after which the contact can be called.
Period Specify the time period (AM/PM).

End Time Specify the end duration before which the contact can be called.
Period Specify the time period (AM/PM).

Enabled Check this box to enable the customer preference record.

Note: You can always enable only one record of a particular com-
munication mode and for a particular relation type at any given
point.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Clicking ‘EDIT’ in the Customer/Business Preferences section allows you to only enable
or disable the customer preference record.
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410

4.10.1

Customer Service screen’s Transaction History tab

Open the Customer Service screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

ORACLE & Welcome, PRAKRRAO v (X
Financial Services Lending and Leasing

Transaction Authorization x  Customer Service x. [3€] Close

DashBoard

Search | Customer Service: 20150900014275  Review Request (Pending: 0)

Accouni(s): 20150900014275: RODRIGUEZ MILDRED [E view ||« audit
View ~ Format- [Ep Freeze gt Detach wrap W & @ curentO Show Al O Group Follow-up

Company Branch Sub Unit Account = Product Days Past Due Currency Pay OFf Amt

usot ustQ. UNDEFINED 20150900014275  LINE HE (FR) 122 usD 19,748

< >

= | Account Details | Customer Details || Transaction History | PmtModes | Bankruptcy | Repo/Foreclosure | Deficiency || Collateral | Burea > +

Payment Rating || Due Date History || Repayment Schedule || Work Orders

Balance Group

Balance Group Tan Period
® current Balance ) Deficiency Balance ) Non-Performing Balance () Terminate Balance @ 1m0/cTD O YTR
View v Fomatv [ Freeze i Datach Wrap
il =y Balance Type Opering Balance Posted Paid Balance Waived Charge OfF Adjusted (-}
i A ADVANCE | PRINCIPAL 18,900 o 8 0 o A
INTEREST 832 o o 0 ) o
ok Accounts g FEE LATE CHARGE o o o 0 ) o ‘
FEE NSF
FEE ADVANG
FEE OVER CREDIT LT 0 o o
FEE MEMBERSHIF o o

Fel

FEE DELAY

EXPENSE BANKRUPTCY
<

ONE PAY [
A ov

Current Balance 19,732
Total

Promotion and Insurance Details B view || o audit
View v Formatv B Freeze 5 Detach Wrap 5]
Promation Type Rate Term Start Dt End Dt Insurance Status Suk
NONE NONE o © 01/30/2016 12/31/4000
< >

> Collections
> WEFP

> Tools

> Setup

Balances sub tab

Details of an account balance can be viewed on the Balances sub tab.

The Balance Group in Balances section consists of the following four action buttons:
e Current Balance
e Deficiency Balance
e Non-Performing Balance
e Terminate Balance

By default, the Current Balance option is selected. In case the status of an account is
‘Charged Off’, then the system defaults to ‘Deficiency Balance’ option.

Depending on which one you select, a different set of balance information appears. In all
cases, the Balance screen can be viewed in the following two transaction period modes:
e ITD/CTD (Inception-to-date/Cycle-to-date)
e YTD (year-to-date)
To view account balance information
1. Open the Customer Service screen and load the account you want to work with.
2. Click Transaction History tab, then click Balances sub tab

3. Inthe Balance Group section, select the balance you want to view.

Current Balance displays the current balances for accounts with an status of ACTIVE.

In this field: View:

Balance Type The balance type.
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In this field: View:

Opening Balance The opening balance amount.

Posted The amount posted (in addition to the opening balance).

Paid Balance The amount paid.

Waived The amount waived.

Charged Off The amount charged off.

Adjusted (-) The amount adjusted (negative adjustments).

Adjusted (+) The amount adjusted (positive adjustments).

Capitalized (-) The capitalization amount deducted from specific balance.

Capitalized (+) The capitalization amount added to principal balance.

Balance The current (closing) balance. The total active balance of
the account is displayed at the bottom.

Deficiency Balance displays the current balances for accounts with an status of CHARGED
OFF. If you click Deficiency Balance, the following information appears:

In this field: View:

Balance Type The balance type.

Opening Deficiency The opening deficiency balance.

Chg off Posted The additional charged off amounts posted.

Recovery The amount of deficiency balance paid.

Deficiency Balance The current (closing) deficiency balance. The total defi-
ciency balance of the account is displayed at the bottom.

Non-Performing Balance displays the current balance for accounts with status as NON-
PERFORMING. Non-Performing accounts fall between CHARGED OFF accounts and ACTIVE
accounts. These accounts are treated as active when dealing with the customer, but for
accounting purposes are treated differently as they are expected to charge off in the future.
Fee and interest balances are not expected to be collected in full and therefore are not
recognized as income. If you click Non-Performing Balance, the following information
appears:

In this field: View:

Balance Type The balance type.

Opening Non-Performing | The opening non performing balance.

Paid / Terminate The amount of non performing balance paid or termi-
nated.

Paid Excess The additional non performing amounts posted.

Waived The amount waived.
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4.10.2

In this field:

View:

Adjusted (-)

The amount adjusted (Negative adjustments).

Adjusted (+)

The amount adjusted (Positive adjustments).

Balance

The current (Closing) non performing balance. The
total non-performing balance of the account is dis-
played at the bottom.

Terminate Balance displays the current balance for accounts with a status of TERMINATE.

Selecting Terminate Balance option displays the following account details.

In this field:

View:

Balance Type

The balance type.

Opening Balance

The opening non performing balance.

Posted The balance amount posted on the account.
Paid The amount of non performing balance paid.
Waived The amount waived.

Charge Off The additional charged off amounts.

Adjusted (-)

The amount adjusted (Negative adjustments).

Adjusted (+)

The amount adjusted (Positive adjustments).

Capitalized (-)

The capitalization amount deducted from specific balance.

Capitalized (+)

The capitalization amount added to principal balance.

Balance

The current (closing) balance. The total active balance of the
account is displayed at the bottom.

4. Inthe Txn Period Balance section, select how you want to view the balance:

Select ITD/CTD to view transactions by Inception-to-date /Cycle-to-date:

_O r-

Select YTD to view the transactions by year to date.

Transactions sub tab

The Transactions screen displays all transactions that have occurred over the life of account.
Transactions can be sorted by when the transaction was created (Post Dt) or the effective
date of transaction (Txn Dt). You can choose to view all transactions, filter System / User
posted transactions, export account transaction details to a file, or reverse certain
transactions. This information comes from the payments and advances applied to the
account, maintenance tasks, and nightly processes such as billing.

To view the transaction history of an account
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Transaction History tab, then click Transactions sub tab.

ORACLE
Financial Services Lending and Leasing

ABSHEKAR ¥ i Sign Qut o

Summary | Colections | Customer Service | AccountDetls | Customer Details | Customer Preferences  Transaction History | PmtModes  Bankruptcy | RepojForedosure || Defidency  Collateral | Bureau | Timelne | CrossiUpsell > ™

Balances | Tramsactions | PaymentRating | DueDate History | Repayment Schedule | Work Orders

Transactions Elvien | o it
System @ User ) Al Txns

SortBy @ FPostDt@ TanDt  viewOptions () Good Payments ) All Payments () Good Fees () All Fees () Good Trns @ Al Txns  view

Customer Service (3 Close
Search | Customer Service: 20170600011222 | Review Request (Pending: 0) | Queve Assigrment &
Account(s): 20170600011222: COLLECTION LINE Bl vew || o Audit
View = Format~ [Ep Freeze  EfiDetach ap &, @ current®) Show All © Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt. Amount Due Status Oldest Due Dt ot
uso1 usHQ UNDEFINED 0170600011222 | LINEHE (WR) 61D 25,341.02 136,71 ACTIVEDELQ 07012017 15TF
« w v =

View = Format~ B Freeze i Detach tieap W Reverse | Export fo Excel
Post Dt Txn Dt Description Currency Amount Details Balance Amt Payment Currency Payment Amt Payment Type Reference  Mode Reason Posted By
08/29/2017 08[11/2017 LATECHARGE  USD 15.00 25,000.00 USD JAYANTA «
08/25/2017 08/13/2017 BILLDUEDATE  USD 105.35 DUE DT 03/01/20 17 25,000.00 USD IAYANTA
08/29/2017 08/11/2017 INTEREST BILLED USD 105.95 DUE DT 09/01/2017 25,000.00 USD JAYANTA
08/25/2017 08/11/2017 INTEREST ACC... USD 105.95 25,000.00 USD JAYANTA g
08/25/2017 07/11/2017 LATE CHARGE usb 15.00 25,000.00 USD JAYANTA 1 i
08/25/2017 07/11/2017 BILL/DUEDATE  USD 105.95 DUE DT 08/01/2017 25,000.00 USD JAYANTA
08/29/2017 07/11/2017 INTEREST BILLED USD 105.95 DUE DT 08/01/2017 25,000.00 USD JAYANTA
08/29/2017 07/11/2017 INTEREST ACC... USD 105.95 25,000.00 USD JAYANTA il

3.
to view on the Transactions screen.

If you select this: | The system displays:

In the View Options section, select type of transactions in this account’s history you want

Good Payments

All valid payments that was neither voided nor reversed.

All Payments

All transaction involving payments.

Good Fees

All valid fees that was neither voided nor reversed.

All Fees

All transaction involving fees.

Good Txns

All transactions that was neither voided nor reversed.

All Txns All transactions.

4.
System or User. Selecting ALL transactions displays all the transactions.

If you select this: | The system displays:

All system posted transactions filtered based on View
option selection are displayed.

System

User All User posted transactions filtered based on View option

selection are displayed.

All Txns All posted transactions filtered based on View option

selection are displayed.

5.
order of when the transaction was made effective.

_Or_
Select Txn Dt to sort the entries on in Transactions section in order of when the
transaction was created.

7. In View Option section, click View to view the following information:

In the View section, you can further filter the list of transactions which are posted by

In the Sort Option section, choose Post Dt to sort entries on in Transactions section in

In this field: View:

Transactions section
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In this field:

View:

Post Dt The transaction posting date.
Txn Dt The transaction effective date.
Description The transaction details.
Currency The currency of the transaction.
Amount The transaction amount.
Details The transaction details.

Balance Amt

The balance amount. This is the principal balance, not the total
balance amount.

Payment Currency

The payment currency.

Payment Amount

The payment amount.

Payment Type The payment type.

Reference The reference number associated with the transaction.

Mode The mode of the transaction.

Reason The reason for the transaction.

Posted By Indicates if the transaction is either system posted (marked as

INTERNAL) or user posted (marked with User ID)

Allocation Details

Txn

The transaction allocation details.

Amt

The transaction allocation amount.

4.10.2.1 To Reverse (or Void) a Transaction

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Transaction History tab and then click

Transactions.

In the Transactions section, select the transaction you want to reverse.

4. Click Reverse. A confirmation dialog is displayed.

5. Click ‘Yes’ to reverse the transaction. On confirmation, the reversal is posted for

processing.

Some transactions cannot be reversed. If a transaction cannot be reversed, the Reverse
button will be dimmed when transaction is selected. If the Reverse button is unavailable, the
transaction anniversary cannot be reversed.

Access to the Reverse button can be restricted by user responsibility and account’s product
type using the PAYMENT REV transaction code (Super Group: ACCOUNT MONETARY
TXN) on the Administration screen.
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4.10.2.2

4.10.2.3

(For more information, see Txn Codes tab (Transaction Super Group screen) section of
the Administration (System) Setup chapter in the Oracle Financial Services Lending and
Leasing Setup Guide).

Voiding an Account

To void an account

Oracle Financial Services Lending and Leasing can be configured to void an account using
the Reverse button on the Transaction screen.

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Transaction History tab and then click
Transactions.

In the Transactions section, select ACTIVE entry in the Description field.

4. Click Reverse.

On the Transactions screen, Oracle Financial Services Lending and Leasing creates an entry
of REVERSE ACTIVE and reverses all transactions. The system also changes status of the
account to CLOSED: VOID and changes status of the application to APPROVED-VOID (or
whatever the account’s last status was before funding).

To use this feature, ACTIVE REV transaction code must be enabled and set to manual on
the Transaction Super Group screen for your user responsibility and account’s product type.
(For more information, see the Txn Codes tab (Transaction Super Group screen) section
of the Administration (System) Setup chapter in the Oracle Financial Services Lending
and Leasing Setup Guide).

In case of migrated accounts maintained in the system, OFSLL has a dummy ACTIVE
transaction created by the automated batch job process. Reversing this transaction posts
RECESSION / VOID transaction and updates all balances to zero. Any Good Transactions
posted after the ACTIVE transaction are reversed as part of RESCISSION / VOID process.

However, this behaviour of creating a dummy ACTIVE transaction is controlled based on
system parameter AUTO_GEN_ACTIVE_TXN_CONV (AUTO GENERATE ACTIVE
TRANSACTION FOR CONVERSION PROCESS). If the parameter is enabled, the scheduled
batch job process creates a dummy ACTIVE transaction record with the transaction date as
conversion date. Also both the indicators - TXN_PRIMARY _IND and
TXN_BACKDATE_ALLOWED_IND are set to Y’ facilitating for RESCISSION /VOID posting
on the migrated account. If the parameter is not enabled, RECESSION / VOID is not allowed
on migrated accounts since there is no active transaction.

Export Account Transaction Details

In the Transactions sub tab, you can export the required account transactions and allocation
details to a file.

To export account transaction details

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Transaction History tab and then click
Transactions.

In the Transactions section, select the required transaction.

4. Click Export to Excel. The details are exported to a .xls file with options to save or open.
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410.4

Payment Rating sub tab

To view the transaction history of an account
1. Open the Customer Service screen and load the account you want to work with.

2. Click Transaction History tab, then click Payment Rating sub tab.

ol

RACLE
Financial Services Lending and Leasing

Customer Service x [EE=

DashAcard

Searen

Saiancas

The Payment Rating section displays month and year of payment and rating reported to
credit bureaus through Metro 2 file for the past 24 months, including the following:

In this field:

View this:

Pmt Rating

The payment rating.

Rating Description

The payment rating description.

Acc Status

The credit bureau account status.

Status Description

The credit bureau account status description.

Month/Year Rating

The month/year of payment rating.

Due Date History sub tab

The Due Date History tab provides a delinquency history, by payment, by displaying a history
of all due dates, along with when actual payment was made for that due date and the
subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

Due Date History sub tab displays all the dues that have crossed the system date and also
the history that is currently available in Transaction History > Due Date History sub tab.

1. Open the Customer Service screen and load the account you want to work with.

4-84 ORACLE



2. Click Transaction History tab, then click Due Date History sub tab.

SORACLE"
Financial Services Lending and Leasing

Customer Service

Due Date History
=

View ~ Format~ B

Due bt Due Amt Last Pt O
0271412016 413
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;;;;;;; o = || Account Details || Gustomer Detoils || Tramsnction 1listary | Pt Modes || Bankruptey || RepeiTersciosure | | Deficiency || Golisteral || Dures >~

Work Orders

In Due Date History section, click View

View the following:

In this field: View this:

Due Dt The due date.

Due Amt The due amount.

Last Pmt Dt The last payment date.
Pmt Amt The payment amount.

Balance Amt The balance amount.

Days Past Due | The days past due.

Pmt Received

If selected, indicates the payment was received.

4.10.5 Repayment Schedule sub tab

The Repayment Schedule section contains information about schedule of repayment such

as the date and payment amount.

1.
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2. Click Transaction History tab, then click Repayment Schedule sub tab.
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View the following information:

In this field: View this:

Repayment Schedule section

Seq The payment sequence number.

Date The repayment date.

# of Pmts The number of payments.

Pmt Amt The payment amount.

Generated If selected, indicates that the repayment schedule has been

generated.

Repayment Schedule Details section

Date The repayment date.
Payment Amt The payment amount.
Principal Amt The amount paid to principal.
Interest The amount paid to interest.

Balance Princi- The balance of the principal.
pal

Work Order sub tab

To expedite repossessions and foreclosures, the display only Vendor Work Order screen
enables you to view all the work orders issued to different vendors for an account.

To view the vendor work order screen
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Transaction History tab, then click Work Order sub tab.
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In the Vendor Work Order section, click View

View the following display only information:

In this field: View this:

Work Order The assigned work order type.

Type

Dt The assignment date.

Estimated The estimated dollar amount of work order.

Vendor The vendor number and name.

Status The assigned status.

Total Amt The total estimated dollar amount of all work orders.

You can create/view and maintain vendor work orders related to an account.

e To create and maintain vendor work orders, click Create Work Order. The system
opens Vendor Management screen. You can perform tasks and record additional
information, such as changing the work order’s status and adding comments in the Work
Orders section.

If vendor screen is already opened in the main screen and user tries to create new work order
or open an existing work order, system displays the warning message as “Vendor
management screen is already open. Please close it and retry”.

e To view more detailed information about vendor work order, select the work order you
want to view and click View Work Order. The View Work Order button appears faded
if the responsibility does not allow access to the Vendor Work Order screen.

3. Click Close on the Vendor Management screen to return to the Customer Service screen.

For more information about using the Vendor Management screen, please refer to the Vendor
chapter in the User Guide.
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Customer Service screen’s Pmt Modes tab

Open the Customer Service screen and load the account you want to work with. Click the
Pmt Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click ACH sub tab.
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The system displays the ACH details depending on the following option selected:

e Recurring - Select ‘Recurring’ to display all the Recurring ACH details.
e One-Time Phone - Select this option to display one time ACH details.
e All - Select ‘All’ to display both recurring and one-time phone ACH details.

If you have selected ‘Recurring’ or ‘One-Time Phone’ option, you can further Add, Edit, or
Copy the details and perform any of the Basic Operations mentioned in Navigation chapter.
On save, the system will automatically post the transaction capturing the current transaction
date along with a comment as 'Direct Record Update' for the particular ACH transactions.

If you have selected ‘Recurring’ option, the following fields are displayed:

In this field: View this:

Reference # The unique reference number.

Bank Name The bank name.

Bank City Specify the city where the bank exist.

Bank State Select the state where the bank exist form the drop-down list.
Routing # The routing number.
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In this field: View this:

Payment For an active Recurring ACH record, the payment mode selected in
Mode Contract tab is automatically populated. If not, select the type of repay-
ment mode to indicate the type of ‘Autopay/Direct Debit’ using any of
the following option from the drop-down list. The list is populated from
REPAYMENT_PMT_MODE_CD lookup code.

- AUTOPAY (ACH)
- AUTOPAY (CREDIT CARD)
- AUTOPAY (DEBIT CARD)

For an AUTO PAY type of Payment Mode, ensure that at least one
active ACH record exist and for CHECK type of Payment Mode, there
are NO active ACH records.

Account Type | The type of account.

Name On Specify the name of the account.
Account
Account # The account number. If the organizational parameter UIX HIDE RE-

STRICTED DATA is set to Y, this appears as a masked number; for
example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used
for identifying bank accounts across national borders with a minimal of
risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based on
modulo 97. On save, system automatically validates the IBAN number
length based on country code, characters, white spaces, and check-
sum. Validation is also done during posting non-monetary transaction
(ACH Maintenance).

You can maintain the IBAN length and other details required as per the
country code in the user defined table (Setup > Administration > Sys-
tem > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT _NL) is defined by
default with length of IBAN as 18.

Sequence System displays the current Sequence Type of the selected account.
Type Depending on the nature of direct debit, the sequence type can be one
of the following:

- First - First time direct debit

- Recurrent - Subsequent repayments after first direct debit

- Final - Final repayment

- One-off - One time bullet contract repayment

However, during the life cycle of the payment processing, the direct
debit sequence type for an account can change.

Pmt Day The payment day.
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In this field:

View this:

Pmt Amt The Payment amount.
Pmt Amt The excess payment.
Excess
Pmt Freq The payment frequency.
Fee Amt The amount charged as fees.
Direct Debit If selected indicates that the fees is debited directly.
Fee
Start Dt The date the system began using ACH payments for this account
End Dt The ACH end date.
Default If selected indicates that this ACH is the default ACH for the account.
Status The status of the account.
Note

This information can be edited using the Maintenance screen and the non monetary trans-
action ACH MAINTENANCE.

If you have selected ‘One-Time Phone’ or ‘All’ option, the following fields are displayed:

In this field:

View this:

Reference #

The unique reference number.

Bank Name

The bank name.

Bank City

The bank city.

Bank State

List of available states.

Routing #

The routing number.

Payment
Mode

For an active ‘One-Time Phone’ or ‘All’ ACH record, the payment mode
selected in Contract tab is automatically populated. If not, select the
type of repayment mode to indicate the type of ‘Autopay/Direct Debit’
using any of the following option from the drop-down list. The list is
populated from REPAYMENT_PMT_MODE_CD lookup code.

- AUTOPAY (ACH)
- AUTOPAY (CREDIT CARD)
- AUTOPAY (DEBIT CARD)

For an AUTO PAY type of Payment Mode, ensure that at least one
active ACH record exist and for CHECK type of Payment Mode, there
are NO active ACH records.

Account Type

The type of account.
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In this field:

View this:

Name On The account name.

Account

Account # The account number. If the organizational parameter UIX HIDE RE-
STRICTED DATA is set to Y, this appears as a masked number; for
example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is used
for identifying bank accounts across national borders with a minimal of
risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based on
modulo 97. On save, system automatically validates the IBAN number
length based on country code, characters, white spaces, and check-
sum. Validation is also done during posting non-monetary transaction
(ACH Maintenance).

You can maintain the IBAN length and other details required as per the
country code in the user defined table (Setup > Administration > Sys-
tem > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined by
default with length of IBAN as 18.

Sequence System displays the current Sequence Type of the selected account.

Type - First - First time direct debit
- Recurrent - Subsequent repayments after first direct debit
- Final - Final repayment
- One-off - One time bullet contract repayment
However, during the life cycle of the payment processing, the direct
debit sequence type for an account can change.

Debit Dt The debit date.

Pmt Amt The Payment amount.

Direct Debit If selected indicates that the fees is debited directly.

Fee

Secret Ques-
tion

Select the secret question from the drop down list.

Provided To The person to whom the ACH is concerned.
Whom

Reference Additional reference if any.

Drawer Rela- | The withdrawer relation to ACH.

tion Type

Drawer Name

The name of withdrawer.
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In this field: View this:

Drawer Address of withdrawer,
Address1
Drawer Address of withdrawer,
Address2

Drawer City City of withdrawer,

Drawer State State of withdrawer,

Drawer Zip Zip of withdrawer,
Status The status of the account.
Note

This information can be edited using the Maintenance screen and the non monetary trans-
action ACH MAINTENANCE.

Copying ACH Details

You can copy and maintain ACH details from Pmt Modes sub tab of Customer Service
screen. Copy option is available only when you have selected the ACH option as either
Recurring or One-Time Phone.

To copy the ACH details
1. Select a record and click Copy.

2. A confirmation message is displayed as ‘Do you want to Copy ACH Record?’. Click OK
to copy and create a new record.

On confirmation, the system creates a new row with new reference number, Status as ‘Active’,
Default as ‘N’, Start Dt as ‘System Dt + Pre note days’ and all the other details as maintained
in the copied record. When a new record is created using the Copy function, the system will
post a ‘New ACH Transaction’ capturing the current transaction date along with a comment
as 'Direct Record Update'.

Coupon sub tab

The Coupon section displays information regarding coupons associated with the account.

To view the coupon screen
1. Open the Customer Service screen and load the account you want to work with.
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2. Click Pmt Modes tab, then click Coupon sub tab.
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View the following:

In this field: View this:

Order If the coupons are ordered for the selected account.

Coupon Start- | The starting number of coupon ordered for the customer.
ing #

Order Date The order date of the coupon.

# of Coupons | The total number of coupons ordered for the customer.

Ordered By The person who ordered the coupons

4.11.3 Post Dated Checks sub tab

The Post Date Check section enables you to view any post dated check information for the
account, if PDC is a method of repayment.

To view the post dated checks details screen

1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click Post Dated Checks sub tab.
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View the following:

In this field: | View this:

PDC Type The type of post dated check in use.

Status The status of the post dated check.

Check # The check number of the post dated check.

Check Dt The check date of the post dated check.

Check Amt The check amount of the post dated check.

Bank Name | The bank name of the post dated check.

Account The account type of the post dated check.
Type

Account # The account number of the post dated check.

Comments Additional information as comments, if any.

4.11.4 Payment Arrangement sub tab

The Payment Arrangement section enables you to define and calculate the payment amount
for the account with status Charge-off. An alert message will be displayed in the Customer
Service screen when the user tries to view the payment arrangement for account other than
charged off status.

To view the Payment Arrangement details screen
1. Open the Customer Service screen and load the account you want to work with.

2. Click Pmt Modes tab, then click Payment Arrangement sub tab.

ORACLE
Financial Services Lending and Leasing
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The Payment Arrangement section is enabled only when the Payment Arrangement .

3. Inthe Payment Arrangement section, click View to view the following details:

In this field: Do this:
Frequency Displays the payment frequency.
Start Date Enter the start date from when the customer pays.
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In this field: Do this:

Terms Enter the number of payments. Note that if the term is speci-
fied as zero “0”, an error message is displayed.

End Date View the end date of the payment.

Plan Amount View the payment amount which the customer plans to pay.
Outstanding View the outstanding amount.

Amount

4. In the Details section, click View to view the following details:

In this field: | View this:

Date View the start date of the payment plan.

Frequency View the payment frequency.

Plan View the planned payment amount.

Amount

Paid View the paid amount.

Amount

Satisfied Indicates that the customer done the payment arrangements.

Ind

Broken Ind Indicates that the customer did not make the payment arrangement.

Enabled Ind | Indicates that the arrangement is active

On Clicking Deactivate, the account will be deactivated.

To add a new payment rearrangement plan, previous plan has to be manually deactivated
otherwise the system displays an error message. This condition applies to the payment
arrangement previous plan even when the 'Broken Indicator' is selected.

Only one Payment arrangement plan can exist at a time. If a schedule broken by the customer

make another payment arrangement, the first payment arrangement has to be deactivated
and only then, the other payment can be added.

Customer Service screen’s Bankruptcy tab

The Bankruptcy screen enables you to record the details of a bankruptcy. This information
usually is supplied from the customer/business or customer’s/business attorney. You can
track each stage of the bankruptcy process based on its follow-up date and record information
using the Details and Tracking sections.

As there are occasions when a borrower files bankruptcy more than once during tenure of the
Line of credit, you can record information for multiple bankruptcies. The Add button enables
you to create a new bankruptcy record with different start and end dates. You can also use
the Bankruptcy screen to view previous bankruptcy record using Next and Previous buttons
in Detail section. The Current box in Detail section indicates the current bankruptcy details.

When a Bankruptcy condition is opened on an account, the system defaults a detailed
tracking record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
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‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to detail tracking record when the bankruptcy

condition is closed.

To enter bankruptcy details for an account

1. Open the Customer Service screen and load the account you want to work with.

2. Click Bankruptcy tab.

3. Inthe Bankruptcy Details section, select the bankruptcy record you want to work with.

_O r_

4. Select Add to refresh the Bankruptcy screen to create

ORACLE’
Financial Services Lending and Leasing

a new record.

2 Welcome ABSHEKAR + ©

Customer Service

Search  Customer Service: MASTER_BTIAP_AQO1  Review Request (Pending: 0) ~ Queue Assignment

Account(s): MASTER_BTIAP_A001: DREW AKS

Viewv Formatv [ Freeze [ Detach Wrap WM & ®curentO show Al Group Follow-up O Associated Accounts
Company Branch Sub Unit Account # Master Account # Master Account Product
ARGOL AROL UNDEFINED MASTER BTIAP_A.. MASTER BTIAPA... Y LINE WITH CREDIT LIMIT

<

Bankruptcy Details

View~ Format~ [ Freeze [ Detach Wrap 5]
» Current Followup Dt Disposition Type Customer/Business _ Relation Comment
7 12/31/4000

Bankruptcy Details

* Current []
* Followup Dt 12/31/4000 B
* Disposition PETITION e
Type UNKNOWN BANKRUPTCY TYPE [+
Customer/Business AKS DREW JR =

Tracking
View v Formatv [ Freeze B} Detach Wrap 20} e Load Tracking

Summary  Collections | Customer Service  Account Details  Associated Accounts | Customer Details ~ Customer Preferences | Transaction History | Pmt Modes  Bankruptey | Repo/Foreclosure | Deficency | Collaterz >

[3€] Close

~

[E] View || & Audit

Billing Cycle Purpose Days Past Due Currency

MONTHLY 114 ARS
>

4k Add | 7 Edit View Audit
File Received Dt Bankruptcy Start Dt Bankruptcy End Dt

10/30/2019
[ saveandadd | [ saveand stay | [ Save and Return || (a Retun

Relation PRIMARY
Comment

File Received Dt [£Y
Bankruptcy Start Dt 10/30/2019
Bankruptcy End Dt [

/ Edit View Audit

5. In the Bankruptcy Details section, enter, view or edit the following information:

Field: Do this:

Current Select to indicate this is the current bankruptcy record.

If selected, system disables the current indicator for any
previous record for the same relation.

Follow up Dt Enter the follow-up date for the bankruptcy.

Disposition Select the bankruptcy disposition.

Type Select the bankruptcy type.

Customer/Busi- Select the customer/business from the drop-down list
ness

Relation Based on Customer/Business selected, system displays

tion associated to account.

either the type of customer relation or as business rela-

Comment Enter a comment.

File Received Dt Select the file received date for the bankruptcy.

Bankruptcy Start Select the bankruptcy start date.
Dt
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Field: Do this:

Bankruptcy End Select the bankruptcy end date.
Dt

6. Click Save.

7. Inthe Tracking section, click Load Tracking. The system loads the bankruptcy tracking
parameters.

8. Ifyou want to reduce the list of parameters, select a sub attribute in the Sub Attribute field.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in parameter display.

9. Complete the Create Tracking section by entering information regarding bankruptcy in
the Value field for each corresponding Parameter, click Save on the Bankruptcy screen.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Repo/Foreclosure tab

The Repossession/Foreclosure screen enables you to record information regarding
repossessions/foreclosure in a manner similar to how bankruptcies are recorded on the
Bankruptcy screen. You can track each stage of repossession/foreclosure process based on
the follow-up date and record information using the Details and Tracking section.

Repossession sub tab

On occasion, a lender performs multiple repossessions for the same Line of credit. The

Create New Repossession button on the Repossession screen enables you to create a new
repossession record for a different collateral and different start and end dates. You can also
use the Repossession screen to view previous repossession information using the Next and
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Previous buttons in the Details section. The Current box in Details section indicates the
current repossession record for each asset.

This tab will be available only when the collateral type associated with the Line of credit
account is a Vehicle.

You can update the current record, but previous records cannot be modified.

When the REPO call activity is posted, system defaults the primary collateral details and
current status will be checked.

When a Repossession condition is opened on an account, the system defaults a detailed
tracking record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The
‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking
record. No processing will be done with respect to the detail tracking record when the
repossession condition is closed.

To Specify repossession details for an account
1. Open the Customer Service screen and load the account you want to work with.
2. Click the Repol/Foreclosure sub tab, then click Repossession.

3. Inthe Repossession Details section, select the repossession record you want to work
with.
_or_

4. Click Add to refresh the Repossession screen to create a new record.
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5. In the Details section, add view or edit the following information:

In this field: Do this:

Current Select the check box to indicate if this is the current repos-
session record.

Followup Dt Specify the follow-up date for the repossession from the
adjoining calendar.

Type Select the repossession type.

Collateral Select the collateral involved in the repossession.
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In this field: Do this:

Disposition Select the repossession disposition.

File Received Select the file received date for the repossession.
Dt

Repo Dt Select the repossession start date.

Repo End Dt Select the repossession end date.

Comment Specify a comment.

Case Repo Details - This section displays the following details based on the
case response received from the interfaced third party system.

Case# Displays the case number of the repossession.
National For- If checked, indicates that National Forwarder carrier is
warder equipped in the repossession.

Condition If checked, indicates that the condition report exist.
Report Status

Condition Displays the date when condition report was received.

Report Recd Dt

Mileage Displays the mileage of the vehicle.

Key Status Indicates if the vehicle key(s) is available.

Field Agent Displays the name of the field agent involved in the repos-
Name session.

Address Displays the address of the field agent.

Phone Displays the contact number of the field agent.

Storage Loca- Displays the location where the vehicle is currently stored.
tion

Repo Location | Displays the repossession location.

Police Dept Displays the name of police department involved in repos-
Name session.

6. Inthe Tracking section, click Load Tracking. The system loads the repossession
tracking parameters.

7. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

8. Complete the Tracking section by entering information regarding repossession in the
Value field for each corresponding Parameter, then click Save.

Foreclosure sub tab

The Foreclosure screen enables you to record information regarding foreclosure in a manner
similar to how bankruptcies are recorded on the Bankruptcy screen. You can track each stage
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of the repossession process based on follow-up date and record information using Details and
Tracking section.

A lender can perform multiple foreclosures for the same Line of credit. The Create New
Foreclosure button on the Foreclosure screen enable you to create a new foreclosure record
for a different collateral and different start and end dates. You can also use the Foreclosure
screens to view the previous foreclosure information using Previous and Next buttons in
Details section. The Current box in Details section indicates the current foreclosure record for
each asset.

This tab will be available only when the Collateral type associated with the Line of credit
account is home.

You can update the current record, but previous records cannot be modified.

To enter foreclosure details for an account

1. Open the Customer Service screen and load the account you want to work with.

2. Click the RepolForeclosure sub tab, then click Foreclosure.

3. Inthe Foreclosure Details section, select the foreclosure record you want to work with.
-or-

4. Click Add to refresh the Foreclosure screen to create a new record.
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5. Inthe Foreclosure Details section, enter view or edit the following information:

In this field:

Do this:

Current box

Select to indicate this is the current repossession/foreclosure
record.

Followup Dt

Select the follow-up date for the repossession/foreclosure.

Disposition

Select the foreclosure disposition.
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In this field:

Do this:

Type

Select the foreclosure type.

Collateral

Select the foreclosure asset.

File Received Dt

Enter the file received date for the foreclosure.

Foreclosure Start
Dt

Enter the foreclosure start date.

Foreclosure End
Dt

Enter the foreclosure end date.

Comment

Enter a comment.

6. Inthe Tracking section, click Load Tracking. The system loads the foreclosure tracking

parameters.

7. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.
If your system has been configured to use the Sub Attribute field, only attributes in a
particular group appear in the parameter display.

8. Complete the Tracking section by entering information regarding foreclosure in the Value
field for each corresponding Parameter, then click Save.

Analysis sub tab

The Analysis screen enables you to create and analyze possible scenarios for re marketing
and sale of the asset. This enables you to calculate the possible gain or loss in the sale of an
asset. Expenses already incurred on the asset are displayed on Expenses sub screen. You
can change the numbers if you expect more expenses by the time asset is sold. You can have
up to three Repo/Foreclosure and three Sales analyzes on each Analysis screen.

To complete a repossession/foreclosure analysis or sales analysis for an account

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service screen, click Repo/Foreclosure tab and then click Analysis.

3. Inthe Analysis section, select the analysis record you want to work with and click Load.

_O r-
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4. Click Add to refresh the Foreclosure screen to create a new record.
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5. Inthe Analysis section, select the Current box if you wish to indicate that this is current
analysis worksheet.

6. Inthe Analysis section, use the Level field to select analysis level you want to use,
ACCOUNT or ASSET.

— Select Account if you want analysis to use value of the entire account.
- Or -
— Select Asset if you want analysis to use the value of a particular asset.

7. In the Analysis section, enter, view, or edit the following information:

In this field: Do this:

Current Ind Current Indicator. Select the check box if analysis is current.

Level Select the Analysis level from the drop down list.

Balance % Specify balance allocation percentage.

Analysis Dt View the analysis date.

Current View the asset current total value.

Value

Asset If you want to perform an analysis for a particular asset, select the asset.
Comment Specify comment associated with the analysis.

8. Specify all the required information in Analysis or Bid section, depending on the type of
incident you are analyzing.

9. Complete the details in Expenses and Refunds sub screens, corresponding to analyze
or bid number on the Analysis screen. The data here is loaded to the analysis and bid
columns as ‘expenses’ and ‘refunds’.
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— To complete the Expenses sub screen:

In this field: Do this:

Expense Type Select the expense type.

Manual Indicates that the expense was entered manually.

Analysis1 Amt | Specify the expense amount for analysis1.

Analysis2 Amt | Specify the expense amount for analysis2.

Analysis3 Amt | Specify the expense amount for analysis3.

Bid1 Amt Specify the expense amount for bid1.

Bid2 Amt Specify the expense amount for bid2.

Bid3 Amt Specify the expense amount for bid3.
— To complete the Refunds sub screen:

In this field: Do this:

Refund Type Select the refund type.

Manual Indicates that the refund was entered manually.

Analysis1 Specify the refund amount for analysis1.

Amt

Analysis2 Specify the refund amount for analysis2.

Amt

Analysis3 Specify the refund amount for analysis3.

Amt

Bid1 Amt Specify the refund amount for bid1.

Bid2 Amt Specify the refund amount for bid2.

Bid3 Amt Specify the refund amount for bid3.

10. Select the Corresponding Analysis/Bid to Load details Maintained in the Expense and
Refund sections.

11. Repeat steps 4 to 8 with information regarding other repossession/foreclosure or sales
analysis.

12. In Status field, select status of the analysis: APPROVED or REJECTED.

13. When you have decided which analysis or which sale bid you want to approve, select your
choice in either the Final Analysis or Final Bid section.

Note

You can approve only one analysis. Based on Analysis approved on ‘Save And Return’
Corresponding Radio button will be enabled in the Final section of Analysis details.

14. Click Save.
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Remarketing sub tab

In the Remarketing sub tab you can trigger remarketing request and auto generate resale
work orders. A collateral remarketing request is an instruction to the vendor of third party
auctioning system to pick-up the repossessed asset from the storage location and proceed
with auction.

In the Remarketing sub tab, you can do the following:

e Define Remarketing request
e View Remarketing Proceed Details
e Maintain Status History, Tracking Attributes, Expenses and Refunds.

For detailed information about the process of collateral remarkeing, refer to ‘Remarketing’
chapter in Collections User Guide.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Deficiency tab

The Deficiency screen enables you to record information about deficiency accounts i.e.
accounts that are no longer collectable. You can create and track specific details on status of
the charged-off account for timely follow-up and analysis. You can also track each stage of
the deficiency process based on its follow-up date and record information using the Details
and Tracking sections.

The Add button enables you to create a new deficiency record with different start and end
dates. You can also use the Deficiency Details screen to view deficiency information. The
Current field in Deficiency Details section indicates the current bankruptcy details. To view
the balance of a charged off account, click the Transaction History tab on Customer Service
screen, then click Balances. On the Account Details screen’s Balance Group section, click
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Deficiency. For more information on Deficiency Balance, see Balances sub tab section in
chapter.

this

When a Deficiency condition is opened on an account, the system defaults a detailed tracking

record with ‘Current’ field enabled and ‘Follow up date’ defaulted to system date. The

‘Disposition’ is defaulted as ‘NEWLY RECEIVED’. The system only adds a new detail tracking

record. No processing will be done with respect to the detail tracking record when the
deficiency condition is closed.

To enter deficiency details for an account

1. Open the Customer Service screen and load the account you want to work with.
2. Click Deficiency tab.
3. Inthe Deficiency Detail section, select the deficiency record you want to work with
_or_
4. Click Add to refresh the Deficiency screen to create a new record.
ORACLE' # Welcome, OFSUUSER v 1g signout O
Financial Services Lending and Leasing
b Customer serve x Hel
Se,wm? Account(s): 20160100010022: PATEL SEEMA [T view || o audt
ewe Fomaty [ e B etach & ® current O showAll © Growp Follov-up
e T S L S et T —
Djﬁ(ifnz::aailsﬁ —_—
Deficiency Details
[ soveandadd | [ save and stay || [ Sove and Retum | GaRetum
'i?(‘f'“ ) @ b
5. In the Deficiency Detail section, enter, view, or edit the following information:
In this field: Do this:
Current Select to indicate this is the current deficiency record.

Followup Dt

Specify the follow-up date for the deficiency.

Disposition Select the deficiency disposition.
Type Select the deficiency type.
Comment Specify a comment.

File Received Dt

Specify the file received date for the deficiency.

Charge Off Dt

Specify the deficiency start date.

Deficiency End
Dt

Specify the deficiency end date.

6. Click Save.
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7. In the Tracking section, click Load Tracking. The system loads deficiency tracking
parameters that track actions taken to collect on the account.

8. If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute
field. If your system has been configured to use the Sub Attribute field, only attributes in
a particular group appear in the parameter display.

9. Complete the Tracking section by entering information regarding deficiency in the Value
field for each corresponding Parameter, then click Save.

Call Activities sub tab

Call activity section includes calls from customer, calls you make regarding the account or
changes to the condition of the account. Entries in the Call Activities section are listed in
reverse chronological order of follow-up date.

For details on how to Record a Call Activity, refer Call Activities sub tab section in “Customer
Service screen’s Customer Service tab” section.

Comments sub tab

Oracle Financial Services Lending and Leasing enables you to record comments on the
Customer Service screen using Comments tab. These comments also appear under the
Comments sub tab.

For details on how to Record a Comment, refer Comments sub tab section in “Customer
Service screen’s Customer Service tab” section.

Due Date History sub tab

The Due Date History tab section provides a delinquency history, by payment, by displaying
a history of all due dates, along with when actual payment was made for that due date and
the subsequent balance. If a payment was delinquent, Due Date History section displays the
number of days the customer was delinquent against each due date.

For more details, refer Due Date History sub tab section in “Customer Service screen’s
Transaction History tab” section.

Customer Service screen’s Collateral tab

The Collateral screen displays collateral information regarding any assets associated with an
account. Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Vehicle/Home/Other and Seller sub tabs. The Vehicle and
Other sub tabs further consists of Valuation and Tracking sub tabs.

To view the collateral details

1. Open the Customer Service screen and load the account you want to work with.

2. Click Collateral tab. System displays the following screen:
If the account’s collateral is a vehicle, the Collateral screen opens at Vehicle tab:

— If account’s collateral is a home, the Collateral screen opens at the Home tab:

— If account’s collateral is neither a vehicle nor a home, the Collateral screen opens
at the Other Collateral:

Clicking on Asset # in the Vehicle sub tab takes you to Collateral Management screen

opening respective collateral. You can modify the details on Collateral Management screen
by clicking on ‘Edit’ and saving the record.
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Note

While adding Collateral to an account, you can either select/deselect the ‘Substitution’
check box. If selected (default), system marks all the other collaterals/assets linked to the
account as ‘Substituted’ and the same status is indicated in Collateral Management
screen. If deselected, then there is no change in the Asset status.

The system displays a warning message if the Collateral Management screen is already

open.

Valuation sub tab

With the Valuation sub screen, you can view the collateral or asset valuation for an account.

To view the collateral or asset valuation for an account

1. Open the Customer Service screen and load the account you want to work with.

2. Click Collateral tab and then Valuation.

3. Click the Valuation sub tab to view the following information:

In this field:

View this:

Value section

Current Select if this is the current valuation.
Valuation Dt The valuation date of the vehicle.
Source The valuation source.

Edition The valuation edition.

Supplement The valuation supplement.

Wholesale section

Wholesale Base

The wholesale value.

Usage

The usage. This pertains to Line of credit and usually is entered as
the current mileage.

Retail section

Retail Amt

Specify the retail base value.

Addons Amt (+)

The add-ons value.

Usage Value
Amt (+)

The usage value; that is, the monetary effect that current mileage
has on the value of vehicle.

Total Amt (=)

The total value.

Addons section

Addons/Attrib- Select the add-on/attribute.
utes
Value The value of the attribute.
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In this field:

View this:

Amount

The add-on amount.

Note

Assets can have exactly one current valuation.

Tracking sub tab

With the Tracking

sub screen, you can view collateral or asset tracking details to an account,

such as the location of title, liens, and insurance information.

The Tracking Attributes for Line of credit accounts in this screen can also be loaded in bulk
through file upload process. While doing so, ensure that the input data file definitions are in

sync with attribute

names. Before processing the bulk upload, system validates if the Tracking

Attributes are already loaded. If not, system loads the Tracking Attributes and then updates

the details.

To view the colla

teral or asset tracking for an account

1. Open the Customer Service screen and load the account you want to work with.

On the Customer Service screen, click Collateral tab.

2
3. On the available screen (Vehicle, Home, or Other), click the Tracking sub tab.
4

On the Tracking sub screen, enter, view, or edit the following information:

In this field:

View this:

Tracking Items section

Select

If selected, indicates that this is the current record.

Tracking Item

The tracking type.

Disposition The disposition.

Start Dt The tracking start date.
End Dt The tracking end date.
Followup Dt The next follow-up date.
Comment Comments if any.

Tracking Item D

etails section

Enabled Select to track the information from start date in the Start Dt field.
Parameter The parameter.
Value The tracking parameter value.
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4.15.3 Vacation Ownership tab

In the Vacation Ownership sub tab you can capture and maintain ‘Timeshare’ specific
collateral details of an account. This tab is displayed only for ‘Home’ collateral and allows to
maintain only one record for the selected account.

In Vacation Ownership or Timeshare industry, ‘points’ represent monetary equivalent value
and in a points-based timeshare ownership system, members/owners use the allotted points
to exchange/trade collaterals. OFSLL uses these points for Asset Billing calculations while
deriving the transaction amount as detailed in Setup > Asset Billing Rate screen.

Also in Vacation Ownership or Timeshare industry, ‘Tiers’ are used to classify a membership
into different levels based on total points at Master Accounts. Each level of membership offers
more perks than previous level. OFSLL supports points-based ‘Tier Calculation’ at Master
Account level using the Formula parameters in Setup > User Defined Parameters screen.

Data in Vacation Ownership tab can also be populated from the following options:
e Create Collateral Web Service
e Create and Update Collateral Upload files
e API Process
e Account Onboarding
To maintain Vacation Ownership Elements for an account
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Collateral tab.
3. Click Home > Vacation Ownership sub tab.

ORACLE’
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4. In the Vacation Ownership Elements section, view, or edit the following information:

In this field: View this:
Club Name Select the Club Name from the drop-down list.
Points Specify the points up to two decimal digit.
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In this field:

View this:

Billing Points

View the auto populated billing points.

If the Asset Usage Type Sub Code is selected as FULL, this
field is populated with total Points available in Points field.

If the Asset Usage Type Sub Code is selected as HALF, this
field is populated with total Points/2 available in Points field.

For more details on how system consolidates the billing
points, refer to Consolidate Actual Points at Master section.

First Year Proration

Select the check box for first year proration.

Resort Identifier

Select the Resort Identifier from the drop-down list.

Association Id

Select the Association Id from the drop-down list.

Building

Select the Building from the drop-down list.

Room/Unit Type

Select the Room/Unit Type from the drop-down list.

Unit

Select the Unit from the drop-down list.

Week

Select the Week from the drop-down list.

Site of Inventory

Select the Site of Inventory from the drop-down list.

Phase Number

Select the Phase Number from the drop-down list.

Usage Type

Select the Usage Type from the drop-down list.

Usage Start Date

Select the Usage Start Date from adjoining calendar.

Plus Membership
Type

Check this box to indicate Plus Membership Type.

PR Marking

Check this box to indicate PR Marking.

Signature Grand
Father

Check this box to indicate Signature Grand Father.

Club Indicator

Check this box to indicate Club Indicator.

Expiration Date of
Asset

Select the Expiration Date of Asset from adjoining calendar.

This date is used for ‘Tier Calculation’ in the system.

Asset Travel Date

Select the Asset Travel Date from adjoining calendar.

Resale Indicator

Check this box to indicate Resale.

On disabling this check box system considers Asset Points
and Grand Father Points for ‘Tier Calculation’ using formula
Parameters.

Grand Father Points

Specify the Grand Father Points.

These points are used for ‘Tier Calculation’ in the system
using formula parameters.
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In this field: View this:

Additional Attributes - This section consists of additional 15 configurable fields as
indicated below

5 check boxes - Membership 1-5 Opt
5 drop-down lists - Other Attribute 1-5
5 Calendar fields - Other Attribute 5-10

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Tier Calculation

Based on the value defined for Expiration Date of Asset, Resale Indicator, and Grand Father
Points, OFSLL supports the following types of ‘Tier’ calculations at Master Account level using
pre-defined formula parameters in Setup > User defined Parameters screen.

Type Formula Parameter Calculation

Total Tier points at | $ASE_TIER_POINTS Sum of Asset Billing Points where

the Master ‘Resale Indicator’ is ‘N’ and ‘Expiration
account Date of Asset’ is ‘greater than’ GL Date.
Total Grand Father | $ASE_GRAND_FA- Sum of Grandfather Points where
Points at the Mas- | THER _POINTS ‘Resale Indicator’ is ‘N’ and ‘Expiration
ter Account Date of Asset’ is ‘greater than’ GL Date.

Note: For a non Master Account, system uses Master Account # to pick-up all Associated
Accounts.

Tracking Attributes sub tab

The Tracking Attributes screen enables you to link information to collateral that is not tracked
by default in the system. These attributes are loaded when user loads the tracking attributes
from Collateral > Collateral (Home) >Tracking tab.

To maintain the Tracking Attributes

1. On the Customer Service screen, click Collateral tab.

2. Click Home > Vacation Ownership > Tracking Attributes sub tab.

3. Complete Tracking section by entering the requested parameter in the Value field.
4

Save any changes you made to the account.

Seller sub tab

The Collateral link’s Seller Details screen enables you to view seller details of the collateral of
Line of credit. You cannot edit or modify details of the seller.

1. In Seller Details section, click View.

2. View the following:

In this field: View this:

Seller Details
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In this field:

View this:

Seller Type

The seller type.

Seller Name

The seller name.

Nationality

The nationality of the seller.

National Id

The national Id of the seller.

Authorized Signatory

The authorized signatory of the seller.

3. In Seller Address section click View.

4. View the following:

Seller Address

Mailing If selected, indicates that this address is the
mailing address.

Current If selected, indicates that this address is the
current address.

Country The seller’s country name.

Address # The seller’s address.

City The seller’s city name.

State The seller’s state name.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with the account that were pulled during servicing for account. You can also use
the Bureau screen to create and pull additional credit bureau reports and view the results as
a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Bureau tab.

3. Inthe View Report section:
— Click Servicing to view credit reports generated with the Customer Service screen.
-or-
— Click Origination to view credit reports generated during Line of credit origination.

4. In the Bureau Details section, select the report you want to view. The system displays
report as a text file in the Text Report section.

To request a manual credit bureau report
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Bureau tab.

3. Click Add to open New Request section.
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4.

Complete the following fields:

In this field: | Do this:

Customer Select the available customer from the drop-
down list.

Spouse Select the applicant’s spouse from the drop-
down list.

Bureau Select the credit bureau from the drop-down
list.

Report Select the credit bureau report type from the
drop-down list.

5. Inthe New Request section, click Create Request. The system displays this information
in the Bureau Details section and further information about customer in Customer Detail
section.

Note

7.

If you are requesting a report from Experian Credit Bureau for Premier Attribute Consumer
report, you can do so without impacting the consumer FICO score. To facilitate the same,
the ‘Soft Pull’ check box is to be selected in Bureau Details section. This option is available
only when the system parameter ‘EXP_PA_SOFT_PULL_IND’ is enabled in the System
Parameters screen and Bureau is selected as ‘EXP’ with Report as ‘PREMIER ATTRIB-
UTE’ in the Bureau Details section.

If you want to receive a copy of a previously pulled credit bureau report, enter credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section.

Click Save.

You can print the report by selecting the report and clicking on Print Report.

Customer Service screen’s Timeline tab

The Customer Service screen’s Timeline tab provides a graphical representation of specific
events on an account over a period of time, The events mainly include Transactions
(Monetary/Non Monetary), Payments and Call Activities that are posted on the account.

To view account timeline

1.

Open the Customer Service screen and load the account you want to work with.
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2. On the Customer Service screen, click Timeline tab.
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Setup.

The Timeline Details section facilitates and displays the following options:

e The timeline ranges from 1 month before the account start date till 1 month after the
current date.

e Each activity in timeline is arranged as per the transaction date on the account.

e The account activities are categorized as Monetary, Non-Monetary, Payments, and Call
Activities. You can filter to view them by selecting the required option or select ‘ALL’ to
display all the activities related to the account. By default, system displays ‘Monetary’
transactions.

e On selecting ‘Monetary’ and ‘Payments’ options, timeline displays only good monetary
transactions and good payments. More details of these transactions can be viewed in
Transaction History > Transactions tab by selecting ‘Good Txns’ and ‘Good Payments’
option.

e On selecting ‘Call Activities’ timeline displays all the call activities posted to the account.

e The Zoombar e iiiiis has options to view the timeline based on Hours, Days, Weeks,
Months, Quarters and Half Years.

e On hovering over the timeline, the arrows * and * helps you to scroll through the
timeline.

Customer Service screen’s Cross/Up Sell Activities
tab

The Customer Service screen’s Cross/Up Sell Activities tab enables you to view and edit all
the captured marketing trigger based events for respective customers linked primary
accounts.

Oracle Financial Services Lending and Leasing Application has been integrated with a third
party database marketing solutions provider to receive monitoring triggers related to
marketing based call activities. Primarily the active customer details are shared through an
input file and corresponding monitoring triggers data within the processed customer input file
are uploaded back into designated location of OFSLL database through an automated
interface.

The Customer Service screen’s Cross/Up Sell Activities tab displays the first 10 marketing

trigger based call activities with the opportunity details and follow-up requirements. You can
select View All check box to view all the ‘active’ and ‘closed’ call activities.
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Edit Cross/Up Sell Activity
To edit a reported Cross/Up Sell Activity

1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Cross/Up Sell Activities tab.

3. Select the record which you want to update and click Edit.
4

Complete the following fields:

In this field: Do this:

Trigger Dt View the date on which the activity has been recorded.
Product Select the product from drop-down list.

Trigger Action View the trigger action captured.

Trigger Description | View the description of the action.

Result Select the result of the action from the drop-down list.
Reason Select the desired reason for the result selected.
Appn'mnt Select the check box to indicate if a prior appointment is required

for next communication.

Followup Dt Select the agreed follow-up date from the adjoining calendar
icon.

Close If there is no follow-up and the opportunity is closed, you can
select this check box indicating the status of call activity as
closed.

Time Zone Select the time zone of the contact from the drop down list.

Comments Specify additional information, if any.

5. Click Save and Stay or any other save option as explained in Basic Actions section.

4.18.2 Create Simple Application

You can use the call activity data and directly initiate the Line of credit Origination process
from Cross/Up Sell Activities tab.

To create simple application
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Cross/Up Sell Activities tab.

3. Select the required call activity record and click Create Simple Application.

The system opens Origination > Simple Application Entry screen with Application
section capturing the details of call activity.

You can enter/edit the required details and continue creating credit application data into
Oracle Financial Services Lending and Leasing Application.

For detailed information, refer to Simple Application Entry chapter in Line of credit Origination
User Manual.
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Close Opportunity

You can close an opportunity based on the response received from customer and if there are
no follow-ups required. However, you can close an opportunity and de-link the same from an
account only when all the records are closed.

To close an opportunity
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click Cross/Up Sell Activities tab.

3. Ensure that all the records are marked as closed and click Close Opportunity.

Customer Service screen’s External Interfaces tab

The Customer Service screen’s External Interfaces tab displays the account specific
information derived from external system.

Oracle Financial Services Lending and Leasing has been integrated with a third party system
to explicitly fetch the account specific information through an input data file. A set of
automated batch jobs which are scheduled at regular intervals pulls the data shared by
external system and populates in the respective account in Customer Service > External
Interfaces tab. For more information on available Batch Jobs, refer to Setup Guide >
Administration > System > Batch Jobs section.
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In the External Interfaces tab, each input data file either new or an update to existing
information is displayed as individual record in the Interface section and the column definition
details (as sorted in Setup > Data Files screen) are displayed in Interface Details section.

In this field: View this:

Interface section

ID Unique case identification number.
Interface Name Name of the external interface.
File Name Input data file name appended with New (IBN) or Existing (IBU)

file identifier convention.

Status Current status of the record (None, Accepted, or Rejected).
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In this field: View this:

Creation Dt Date when the record was created.
Action Taken By User who has modified the record status.
Action Dt Date when the action was performed on the record.

Interface Details section

Parameter Name of header used in input data file corresponding to the
account information such as First Name, Last Name, Address
and so on.

Value Data fetched from external system for each header/parameter.

Along with the account specific updates, the records may also contain bankruptcy details
which needs you attention. You need to verify those details and confirm the authenticity by
either accepting or rejecting the bankruptcy information. If Accepted, system posts the
bankruptcy details on the corresponding customer accounts.

Accept or Reject Bankruptcy Details

In the External Interfaces tab you can Accept or Reject information of those records which are
specific to bankruptcy update and marked with status as ‘None’.

e To accept the bankruptcy details, you need to create a new record with tracking
attributes and then proceed with steps explained below.

e Toreject a record, you can select the record and click ‘Reject’ in the external interface
tab.

Post update, the status of record is marked as ‘Accepted’ or ‘Rejected’.
To Accept Bankruptcy Details

1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service screen, click External Interfaces tab.

In the Interface section, select the bankruptcy record with status ‘None’ for which action
has to be performed.

4. Verify the details displayed in Interface Details section.
Once confirmed, navigate to Customer Service screen > Bankruptcy tab.

6. Create a Bankruptcy record and load the tracking attributes as explained in ‘Customer
Service screen’s Bankruptcy tab’ section.

7. Click Accept in the action section and click ‘Yes’ in the confirmation dialog to accept
changes.

On confirmation, system updates the bankruptcy details based on either ‘SSN’ for new
bankrupt accounts or ‘Case Number’ for existing bankrupt accounts.

Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
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feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.

In this chapter, you will learn how to compete the following tasks:
e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request
e Responding to Review Request
e Reassign Review Request
e E-mailing Review Request
e Closing Review Request
e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request
tab in the Customer Servicing screen.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query .

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.
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Options Descriptions

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review
request.

Action Options Descriptions

Open Account Displays the Customer Service screen with the Account details
assigned for review.

Send Request Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response | Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All' option in the ‘Query’ section.

Complete Changes the status of review request to COMPLETED and can be
Request viewed by selecting ‘View All’ option in the ‘Query’ section.
Remove Filter Removes the selected filters applied to narrow the view of review

request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section enables you to send an email to either originator or receiver of the review
request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.
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The ‘Review Requests’ section in Customer Service screen displays the following information
for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.

Priority The request priority: HHGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.
Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are

tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer

RETURN TO ORIGINATOR - when reviewer has responded to
request

CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
Account # The Account number which needs review.

Days Past Due Total number of days elapsed past the due date.

Total Outstanding Displays either ‘Account outstanding principal balance’ for active
Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Customer Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account

review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.
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In the Comment History section, you can view the following details of the selected review
request:

Comments From | Descriptions

Type View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.

Sub Type View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request #> FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt View the Date and time when the comment was posted.

4.20.2 Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE
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2. In the Review Requests section, select ‘Originator’.
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3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:
Request # View the system generated request number.
Originator View the requester’s user ID auto generated by system upon

creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in

DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.
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4.20.4

Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.
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2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Account’. The Account details are displayed in Customer Service > Summary
tab.

4. Review the details in particular to the details specified in the comment (if any).

Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.
Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.
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Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as ‘INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed and click Edit.
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4. Select the required reviewer from ‘Receiver’ drop down list.

5. (Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

4-124 ORACLE



4.20.6

4.20.7

4.20.8

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_0 r'_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.
The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.
To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

4-125 ORACLE



4.21

4211

Queue Assignment

The Queue Assignment tab in Oracle Financial Services Lending and Leasing application
allows you to search and view the hard assigned customer service queues maintained in the
system. You can also view the queue assignment details with option to reassign users in a
hard assigned queue and track activity status posted on the account.

Customer Service Queues are maintained in Administration’s setup screen (Setup >
Administration > User > Queues > Customer Service). For more information on hard assigned
queues, refer to section “Using the Hard Assigned feature” in setup guide.

Navigating to Queue Assignment

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Queue Assignment.
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In this section, you will learn how to compete the following tasks:

e Using Queue Search

e Filter Queues in Queues sub tab

e Define criteria in Criteria sub tab

e View options in Queue Assignment sub tab
e Reassign Users in Queue

e Filter Accounts based on Queue Criteria

e View Accounts in Sort Order Sequence

e Track Activity Status

Using Queue Search

In the Search Criteria section, you can primarily use the ‘Search List By’ filter to search based
on either ‘Queues’ or ‘Users’ maintained in the system. Depending on the option selected, you
can further filter your search using the following list of parameters and query the database by
providing one or more parameter values.

Field: Do this:

Hard Assigned | Select the queue name from the drop-down list. The list displays both
Queue ‘Enabled’ and ‘Hard Assigned’ customer servicing queue definitions.
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Field: Do this:

Acc # Specify the account number to which the queue is assigned.

Responsibility | Select the user/queue responsibility from the drop-down list. The list
displays various user responsibilities as defined in Setup >
Administration > User > Queues > User Groups tab.

User Select the ‘User’ from the drop-down list. The list displays all the hard
assigned users maintained in the system.

Note

You need to specify a minimum of one parameter for the search to retrieve queues from
the database. Else system displays an error message.

Click ‘Search’. The search results for Queues are displayed in both the Queues & Queue
Assignment section. Whereas, the search results for a ‘User’ (selected in Search List By
option) is displayed in Queue Assignment section.

You can also click ‘Reset’ to clear the filters specified in Search Criteria.

Remove Account Filter

While searching for queues using Account number as the Search Criteria, the Queue
Assignment section displays the filtered search results along with the ‘remove Filter’ option in
the header.

Clicking on ‘remove Filter’ button will remove the account number filter and displays all the
accounts belonging to the selected queue.

Queues sub tab

The Queues sub tab displays the search results for the specified search criteria and contains
‘Enabled’ and ‘Hard Assigned’ customer servicing queues with the following details:

e Queue name

e Queue Desc

e Account Condition
e Priority

e Company

e Branch

e Hard Assigned

e Group Follow-up Ind
e Near Real-Time

e Dialer Extract

e Enabled

Criteria sub tab

The Criteria sub tab allows you to define account selection criteria and sort order to filter the
accounts displayed in Queue Assignment section.
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In the Criteria Definition section, click ‘ADD’. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields are given
below:

Field: Do this:

Name Specify a unique name to identify the criteria.
Description Specify the required description for the criteria.

Hard Assigned Queue Select the queue name from the drop-down list. The list

displays all the ‘Enabled Hard Assigned’ customer
service queues.

Enabled Check this box to enable the criteria.

The Criteria sub tab further consists of ‘Selection Criteria’ and ‘Sort’ tabs.

In the ‘Selection Criteria’ section, you can define the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter. A
brief description of the fields are given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list. The list

displays all the ‘Enabled’ attributes maintained in user
defined table which has both ‘Queue Assignment’ fields
and 36 activities defined in Queues > Activity Tracking
tab for selection.

Comparison Operator Select comparison operator from the drop-down list.
Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Specify logical operator from the drop-down list.
Enabled Check this box to enable the selection criteria.

Click ‘Check Criteria’ to validate the correctness of the SQL statement generated and to
resolve errors, if any.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the ‘Sort’ section, you can define the order to sort the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter. A
brief description of the fields are given below:

Field: Do this:
Seq Specify sequence number.
Sort field Select the sort field from the drop-down list. The list contains both

the ‘Queue Assignment’ fields and 36 customer call activities
defined in Queues > Activity Tracking tab for selection.
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Field: Do this:

Order Select sort order as either Ascending or Descending from the drop-

down list.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

4.21.4 Queue Assignment sub tab

The Queue Assignment section, displays the user accounts associated with the selected
queue and consists of the following details:

User Name
Account #
Replacement User
Queue Name
Queue Desc
Responsibility
Company

Branch

Date

Title

Products

Status
Delinquency Days
Amount Due
Outstanding Balance
Producer

Secured

Reason

In the Queue Assignment section, you can do the following:

Reassign Users in Queue

Filter Accounts based on Queue Criteria
View Accounts in Sort Order Sequence
Track Activity Status

Customer Service

Search Criteria

Hard Assigned Queue Acc# Responshiity User

REPOSSESSION QUELE: NEW REG ¥ -

Search List By
5 @ Queue © User

@Bsearch || @ Reset

Queves  Criteria
Queues
Freeze

£ Detach Wrap (5]

Queue Desc

View v Format~ B
Group

Folow-upInd Real-Tme
REPOSSESSION E AL AL ¥ |2 N N v

Queue name Account Condition Priority Company ~ Branch Hard Assigned Disler Extract Enabled

REPO REPOSSESSION QUELE: NEW REQUESTS

Queue Assignment
View v Format v [

Freeze  pff Detach &l Wrap @ ¥ @Ehaubmit P Reset
Queue Queue Delinquency Amount Outstanding
Name Desc Responsibiity Company Branch Date Title Products Status Days e Balance

USHQ  10/02/20... BOOP... LOAN .. ACTIV.. 702
USHQ 10/02/20... BOOP... LOAN ... ACTIV.. 690

483 Update Queue Sort Order Type [EB Eittered Account

Select [7] User  Account

o Replacement User Producer Secured Reasonf ADL ADS A5 ADS
Al Mame

[ pewo.. 201210

“

REPO REP.. SUPERUSER USD1 900.06 1,810.05 CA0D. N v

[ oewmo.. 201210.

]

REPO REP.. SUPERUSER USD1 87157 99419  CAQ0.. N v v

(3] Close
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4.21.5

4.21.51

4.21.5.2

4.21.6

4.21.7

Reassign Users in Queue

In the Queue Assignment tab, you can reassign a different user for a queue either individually
or in bulk and reassign the hard assigned queues. While doing so, you can state the reason
for change which later gets appended and displayed in the account conditions history log
(Customer Service > Account Details > Condition Details sub tab).

Replace User in Queue

1. On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Queue Assignment.

2. Search for the required Queue or User using the parameters in Search Criteria. The
search results are displayed in the Queues & Queue Assignment section.

3. Inthe Queue Assignment section, click on the ‘Replacement User’ drop-down list against
the required user and select the new user from the list. You can also use the ‘Search’
option within the list to search for the required user.

4. Specify the reason for change in the Reason column against the user selected.
Click Update Queue.

Bulk Replace Queue Users

1. On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Queue Assignment.

2. Search for the required Queue or User using the parameters in Search Criteria. The
search results are displayed in the Queues & Queue Assignment section.

In the Queue Assignment section, click ‘Select All’ check box.

4. Click on the ‘Replacement User’ drop-down list on the header and select the new user
from the list. You can also use the ‘Search’ option within the list to search for the required
user.

5. Specify the reason for change in the Reason field on the header.
6. Click Update Queue.

On successful user replacement, a system generated comment is posted on the account with
the following details:

e Alertflag as ‘N’
o Type
e Sub Type

e Comment Format QUEUE USER CHANGED FROM XXX TO YYY BECAUSE OF
<<REASON>> ON <<DATEFORMAT>>

Filter Accounts based on Queue Criteria

To filter the list of accounts in Queue Assignment section, select the required option in ‘Sort
Order Type’ drop-down list and click ‘Submit’. The list is populated based on the defined
Queue Criteria. You can also click ‘Reset’ to remove the filter and display all the account
associated to the queue.

View Accounts in Sort Order Sequence

In the Queue Assignment section the ‘Account # column is enabled with a link to directly
navigate and view the account details in the Customer Service screen.
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4.21.8

To view the next account in the same sequence as listed, click ‘Filtered Account’ button in the
Queue Assignment section header. The details are displayed in Customer Service screen’s
> Summary tab.

On reviewing the account details, you can further navigate to the subsequent accounts in the
sequence by clicking ‘Filtered Account’ button in Right-Splitter window > Quick Search
section. Successively, clicking ‘Filtered Account’ button displays all the accounts and when
the last account is reached, a message is displayed indicating ‘There is no account in this
queue’.

Track Activity Status

All the customer service call activities defined and enabled in setup screen (Setup >
Administration > User > Queues > Customer Service > Queue Activity tab) for the selected
Queue are listed against each account in separate columns. These activity fields are auto
updated with call activity results and gives a quick snap shot of all the activity status scheduled
and performed on the account.

Note

The activity status fields are available only when the accounts are populated from a Queue
search by selecting the ‘Search List By’ option as ‘Queue’.

When a particular call activity is posted on the account, the respective activity status field is
marked with a ' indicating that the activity is complete.

However, in case the activity duration has expired based on the ‘Activity Expiry Days’ defined

in Queue Activity tab, the activity field is disabled and status is not updated in Queue
Assignment section.
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5.1

5.2

5.2.1

5. Collections

Introduction

After an application has cycled through the Line of credit origination process, it becomes an
account. Account maintenance and collections tasks can be performed with Oracle Financial
Services Lending and Leasing’s Collection screen.

The Collection screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using Funding main tab or
convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Line of credit origination cycle and is funded or is ported
into the system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load customer details on the Collections screen.

e Use the Search screen by selecting Customer Centric option(s).
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5.3

5.4

5.5

5.5.0.1

5.6

e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in Account(s) and Customer(s) sections, open the Collections
screen and load the account you want to work with.

For details on this screen refer Customer Service screen section in Customer Service
chapter.

Customer Service screen’s Summary tab

Open the Collections screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Collection screen and load the account you want to work with. Click the Customer
Service tab to view the sections under it.

Recording a Call Activity

To record a call activity

1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Collections screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.
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5.6.1

5.7

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE’
Financial Services Lending and Leasing

Collects [®]Close.
» DashBoard firwirbirilitol
> Origination Search  Customer Service: 2015090014275 Review Request (Pendng;: 0)
- Servicng
Collections Account(s): 20150900014275: RODRIGUEZ MILDRED Elview || o Audt
P View v Formatw P Freeze i Detach 1] Wirap M & @ curent® show AlD Group Follow-up
Colections Company Branch  SubUnit  Account # Product Has P;j; Currency  Pay Off Amt Amont Due Status Oldest Due Dt
Bankrupto
RZ:D;L:DH USO1  USHQ  UNDEFL. 2015090001427 LINEHE (FR) 122 UsD 19,747.80 7,527.99 ACTIVERDELQ  09/27/2015
« n v
Deficiency
Reports
Producers Summary | Customer Servics || Account Details | Customer Detals | Transaction History | PmtModes | Colisteral | Buresu  CrossiUp Sel Activities
Vendors
Account Details | Statements || Rate Schedule | Insurances | Contract Information
Account Information Elven | o Audt
Vew: Fomats | [ | [rese hivend wer | @
Stop Accrual Index Type Index Rate Margin Rate Rate Last Rate Change Dt Acorual Start Dt Last Acarual Dt Hescttatot e, #t
N PRIME RATE 5.00 493 9.99 10/25/2015 09/05/2015 01/24/2016 13.98
4 ] n »
1
Account Information
Gafetun
Interest and Accruals # of Rate changes (Life) 1 Credit Details
Extn and Due Dates
Stop Acerual Credit Limit 18,500.00
IndexType PRIVE RATE # of Extensions (Year) 0 Hold () 0.00
IndexRate 5.00 # of Extensions (Life) € 18,300.00
MarginRate 4,39 = of Extension Term (Year, Suspended() 0.00
Rate 9.99 # of Extension Term Available Credit (=) 0.00
LastRate Change Dt 10/25/2015 # of Due Dt Changes(y Over Limit Year 0
Accrual Start Dt 09/05/2015 # of Due Dt Changesilife} 0 Over LinitLife 0
Last Accrual Dt 01/24/2016 LastExtn Dt LastAdvance Dt 03/05/2015
Rate Start of the Year 13.98 Due Day Chg Dt Last Advance Amt 18,900.00
#ofRate changes (Year) 1
> WP
’ Tools
» Setup

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Customer Service screen and load the account you want to work with. Click the
Customer tab to view the sections under it.

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on the Customer Details screen.
Using the Customer Service screen’s Customer Details tab, you can update or add to a
customer’s address, employment information, or phone listing. All the information about the
customer can be changed using Maintenance screen.

To view or edit customer information

1. Open the Customer Service screen and load the account you want to work with.

53 ORACLE



5.8

5.9

5.9.1

2. Click Customer Details sub tab.

ORACLE
Financial Services Lending and Leasing

. Collection: 3] Giese
> DashBoard =]
- Origination Search  Customer Service  Review Request (Pending: 0) o
> Serviding . .
Collections Accaml{s) [Ee | 2 At
- View v Format v By Freeze i Detach Wrap @ & O curent@ show AllD Group Falow-up
Collections Company Branch  SubUnit  Account % Product DavsPeet Currency  Pay OFF Amt Amount Due Status Oldest Due Dt
Barlapity No data to display.
Repossession = = ¢
Deficiency
Reports
Prokicers Summary | Customer Service || AczountDetals | Customer Details | Transaction Hstory || PmtModes  Buresu | Cross/Up Sell Activities
vendors
Customer  Business
Customer Information =
Pt |12 vew |[7 put
View - Fomat~ B Fresz ffiDemch | olwrr | @
Customer # Relation ECOA Name ssN Birth Dt Marital Status Enabled Lang
“ No data to display.
<[ i . 4
Customer Information
[ saveandstay || [ saveandReturn || {aRetumn
Customer
Identification Details xve
customer =
Relation Passport = Reference =
ECOA Issue Dt Status
Name Expiry Dt
Birth Dt Visa £ FATCA
Marital Status Nationality .
Enabled National ID b
= - Birth Country
i s P 1t US Resident Status
bt e ermanent US Resident Status
M M License State
S Mather's Maiden Name S A
Class Type g T
ilitary Service
> Tools Email Pawer of Attarney —
E Stop Correspondence g Holder Name )
Dkt = oo,

For details on this screen refer Customer Service screen’s Customer/Business Details tab
section in Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Customer Service screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.

and Leasin.

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Customer Service screen and load the account you want to work with. Click the
Pmt Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.
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2. Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

e Collections x (3] glos=
> Origination Search | Lustomer Service: 2015090001426/ | Review Hequest (Vendng: 1)
Account(s): 20150900014267: SIGG MARK Elview || <2 Audt
PR — Fresse [ Datach wrsp W B © curen £ Show A1l ©) Graup Falaw-un
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usor  usHa 20150900014267 LOAN VEHICLE (FR) isusD 1939724 5.209.00 ACTIVEIDELQ  10/01/2015
« i 1 v
Summary | Custemer Servics | Aczount Detals || Customer Detais | Tronsction Histery | Pemt Modes | Collateral | Burcou Croas/Up Sel Actities
AcH || Coupon || Post Dated Cheds || Payment Arrangement
ACH Information
4 add || ZEae || [=]ve 2 Audit
View v Format~ B Fresze fiDetach 0 wrap W ) Rearring® OneT
Refer sark ram bank Crty tark state +outng = Name On Account  Account = e wan

“ Mo data to dsplay.

ACH Information

<aRrewm

> wep
> Tools
> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

5.10 Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Home and Seller sub tabs.

To view the collateral details
1. Open the Customer Service screen and load the account you want to work with.
2. Click Collateral tab. The system displays the following screen:

ORACLE"
Financial Services Lending and Leasing

> DashBoard Soeraper i ls ko
 Origination Scarch  Customer Service: 0150900014275 | Revien Reauest (Pending: 0) 2
> Servicing
ot Account(s): 20150900014275: RODRIGUEZ MILDRED Elven || o audt
View v Format ~ Freese EfiDetach | ol viren B, @ Curent Show Al ©) Group Folow-up
Collections = = @ &
Collections Company Branch  SubUnit  Account # Product DarsPast Gurrency  Pay Off Amt Amount Due Status Oldest bue Dt
i‘:;:;z';“im USOL  USHQ  UNDEFL. 20150900014275 LINE HE (FR) 122 USD 19,747.80 7,527.99 ACTIVEDELQ.  09/27/2015
B n B
Deficiency
Reports
Producers Summary || Customer Service || Account Detaiis || Customer Detais | Transaction History || PmtModes || Collateral || Bureau || Cross/Up Sell Actvites
Vendors |2
Home || Seler
Home
G add || Pede || 5 vew || oF mue
View+ Fomat v | B | [[Fecee iemd | olwen | @
Primary Description Asset Class AssetType Sub Type Ocaupancy Lien Status lienEventDate  Second LienHolder Car
1 v 2015 INVERNIZZI ... NEW VEHICLE HoME SINGLE FAMILY .. OCCUPIED BY OW... UNDEFINED q
B w ’
Home
saveandstay | [ save andRetun || CaRetum
Type & Description Lien Details Deed Details
Primary ¥ Lien Status | UNDEFINED [&) Construction Permitot 0y30/2016 | B
Substitution Lien Event Date ) Deed Dt 01/30/2016 |
Asset# 14011
Second Lien Place of Issus AMESBLRY
* Asset Class NEW HOME [=] Holder
Property Boundaries
* Asset Type HOME (= Comments. From East
*5ub Type | SINGLE FAMILY HOME =] Lien Rﬁéﬁi"; = Morth
Occupancy  OCCLPIED BY OWNER AS PRINCIPA[x] Entity Name South
Census Tract /BriA West
> wrp Broperty
Ty MSA Code Address
GEO Code Width 1200
=t Status ACTIVE - * Country  UNITED STATES = e

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

55 ORACLE



5.1

5.12

5.12.1

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with account that were pulled during Line of credit servicing for the account. You
can also use the Bureau screen to create and pull additional credit bureau reports and view
the results as a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service link bar, click Bureau.

3. For details on this screen refer Customer Service screen’s Collateral tab section in
Customer Service chapter.

Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request
tab in the Customer Servicing screen.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:
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The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are

created, reviewed,

closed and completed by that user.

You can further filter the review request based on the following:

Query L

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review

request.

Action Options

Descriptions

Open Account

Displays the Customer Service screen with the Account details
assigned for review.

Send Request

Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response

Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request

Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete
Request

Changes the status of review request to COMPLETED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Remove Filter

Removes the selected filters applied to narrow the view of review
request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.
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Email Section

The Email section enables you to send an email to either originator or receiver of the review

request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Customer Service screen displays the following information

for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.

Priority The request priority: HIGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.

Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are
tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer
RETURN TO ORIGINATOR - when reviewer has responded to
request
CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.

Account # The Account number which needs review.

Days Past Due

Total number of days elapsed past the due date.

Total Outstanding
Balance

Displays either ‘Account outstanding principal balance’ for active
accounts, or ‘Deficiency balance’ for charge-off accounts.

Customer

Primary / Secondary (spouse) name associated to the account.
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Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account
review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review

request:

Comments From

Descriptions

Type

View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.

Sub Type

View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment

View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request # FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By

View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt

View the Date and time when the comment was posted.

5.12.2 Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.
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To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE
Financial Services Lending and Leasing

Customer Service x [®Close

Review Requests
[ Seveand add || [ Save andstay || [ SaveandRetum || GmRetum

Request # 12003 Sender Days Past Due 0
Originator. *Account # | 2000010011820 - Total Qutstanding Balance 330
*Priorty | HIGH [« *Reason | REVIEW BALANCES = Customer ALIVE PRI / DEA SPO
*Recsiver ANAND SHEKAR > ,\:::5: :;Z::“:D"Dﬁ&
- sus; JNEWYORK,MASSACHUSETTS, 34038
Comment. REVIEW ACCOUNT BALANCES Date 09/18/2017 12:23:39 AM Email EDW.SIRSI@GMAIL.COM
Send Request [

Comment History ] vie
View v Formatv [P Freeze i Detach a @
Type SubType Comment Comment By Comment Dt
No deta to display.

2. Inthe Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:
Request # View the system generated request number.
Originator View the requester’s user ID auto generated by system upon

creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.
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In this field:

View this:

Status View the status of review request auto updated by system
upon creating the request.
Date View the date and time when the request was created. Sys-

tem appends the current date by default.

Send Request

(Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in
DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.

5.12.3

Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE’

Financial Services Lending and Leasing

Customer Service x

Review Requests

Query

User

View ~ Format~ [P Freeze
Request
8002

<

Comment History

View > Format~ [
Type

REVIEW REQUEST
REVIEW REQUEST
REVIEW REQUEST
REVIEW REQUEST
REVIEW REQUEST

Search | Customer Service  Review Request (Pending: 1) | Queue Assignment

= Originator @ Receiver O Both

o | @

i Detach

Criginator
PRITAM JENA

22 EfiDetach

5ub Type
CRIGINATOR
RECEIVER

SYSTEM GENERATED
RECEIVER

SYSTEM GENERATED

B ese

dpadd | Pedt | [ view || o audt
Email

ViewAl [F] Forwarded Only

£ Origiator Receiver

(&) Open Account t  [BsendResponse [ CloseRequest [ Complete Request
Priority

HIGH

Recever
HARISH MACHA

Address
HOME - ADD&: newyork,

Phone Emai

9728663378

Reason
EDW SIRSIGGMAIL.COM  REVIEW ACCOUNT.

B

Comment
TESTRWD

FWD

REVIEW REQUEST : 8002 FORV/ADED FROM SURABHI DESAT TO NAVEEN REDDY
W

REVIEW REQUEST : 8002 FORV/ADED FROM NAVEEN REDDY TO HARISH MACHA

Comment By
FRITAM
SURABHT
INTERNAL
SURABHT
INTERNAL

Comment Dt
03/06/2017 09:32:30 AM
08/05/2017 09:33:45 AM
09/06/2017 09:33:45 AM
09/08/201 A
09/06/2017 09:3%:31 AM

2.

received.
3.

tab.
4.

In the Query section, click ‘Receiver’. System displays all open review request you have
Click ‘Open Account’. The Account details are displayed in Customer Service > Summary

Review the details in particular to the details specified in the comment (if any).

5.12.4 Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
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the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.
Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as INTERNAL’.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.
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3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests

Request # 8002
Originator PRITAM JENA
Priority HIGH

*Receiver HARISH MACHA -

Comment

Comment History

view v Format > Fresze  fDetach irap
Type Sub Type
REVIEW REQUEST ORIGINATOR

REVIEW REQUEST RECEIVER

Comment
TESTFWD
FWD

REQUEST SYSTEM GENERATED

REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAI TO NAVEEN REDDY

Sender MAVEEN REDDY
Account # 20000100011820
Reason REVIEW ACCOUNT

Status  WAITING FOR RESPONSE
Date 09/06/2017 02:32:11 AM

send Request [7]

[ save andstay | [ Save andReturn | {aReturn

Days PastDue 0
Total Qutstanding  28,806.94
Balance
Customer ALIVE PRI f DEA SPO

Phone 9728663378

Address  HOME - ADD&.

MNEWYORK, MASSACHUSETTS, 34038
Email EDW.SIRSI@GMAIL.COM

CommentBy Comment Dt
PRITAM 09/06/2017 09:32:30 AM
SURABHL 09/06/2017 09:33:45 AM

INTERNAL 09/06/2017 09:33:45 AM

REVIEW REQUEST RECEIVER,

FWD

SURABHL 09/06/2017 09:3% 31 AM

Select the required reviewer from ‘Receiver’ drop down list.

(Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send

Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING

FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator

field.

_0 r_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.

The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close

a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.

5-13
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3. Inthe Action section, click ‘Close Request’.

The system assigns the request as CLOSED and removes it from your Review Request
record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. In the Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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6.2.1

6. Bankruptcy

Introduction

After an application has cycled through the Line of credit origination process, it becomes an
account. Account maintenance and collections tasks can be performed with Oracle Financial
Services Lending and Leasing’s Bankruptcy screen.

The Bankruptcy screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Line of credit origination cycle and is funded or is ported
into the system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on the Bankruptcy screen.

e Use the Search screen by selecting Customer Centric option(s).
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e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open Bankruptcy
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter.
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6.5.1.1

Customer Service screen’s Summary tab

Open the Bankruptcy screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

ORACLE' o Welame, vavar: +  ERSTRGN O
Financial Services Lending and Leasing
i Close
Spere Callections ®
> Origination Search  Customer Service | Review Request (Pending: 0)
> Senvicing
Callistions Account(s) Elview | o aut
o Views Fomatw B[] Freze 5 Detach wap @ & O cument O showal O Group Follovup
ollections
Collecions Company ranch Sub Unit Account # Froduct Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
e Mo data to display,
Repossession
Deficency Summary | CustomerSenice | Account Details | Customer Details | Transaction History | PmtModes | Bureau | Cross/Up Sel Acivites
Reports
Producers
oo Nerts Conditions
Vendors
Alerts Conditions
Aert Condition Start Ot Followup Dt
o data to display. Mo data to display.
4 Account Details Other Information
{
Dues o
Customer Information
Mo data to display. Customer ;e Relation ssh Birth Dt Gender
o data to display.
Delq Due Total Due Future Pmt Dt b
L Due Todays Payoff Oldest Due Dt
NSF Due Future Payoff AmtFaid Bxcess
Other Due Future Payoff e email Disabilty Privacy Opt Out
Ji formati Language Ship Active ilitary Duty
Delinquency Information Warital Status Stop Time Zone
Late 30 60 %0 120 150 180 Category Days Correspondence
No data to display.
BP(Life) NsF(Life) Collector Address Information
BP(Year NSF{Year) N Permissi |
Type Cument (" Mailng. Address Phone
Activities Mo datato display.
Adive Dt A Last Pt At
5 WEP Last Actiity Dt Paid Off Dt Charge Off Dt Employment Information
K Due Day Effective Dt Hilitary Duty Permissi
> Todls Last Pmt Dt Current Pmt Customer Score Twe S toCall Eplop Kitie B
> Setup Customer Grade Last Bill Amt Behaviour Score lio data to display. v

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

With Call Activities section, the system enables you to record the details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding the account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user defined.

Each action and result has a code and description. The code for call action and call result is
what appears on the Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Bankruptcy screen and load the account you want to work with.
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2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

Summary ~ Collections ~ Customer Service ~ Account Details =~ Customer Details =~ Customer Preferences  Transaction History ~Pmt Modes  Bankruptcy — Repo/Foreclosure  Deficiency  Collateral  Bureau  Timeli > ¥

Call Activities  Maintenance ~ Comments = Promises ~ Checklists ~ Tracking Attributes ~ Field Investigation ~ References ~ Correspondence  Letters  Document Tracking — Scenario Analysis ~ Access History
Call Activities

H saveandAdd | [ save and Sty || [ Saveand Retum | (@ Retum

View v Format~ [ Freeze Detach Virap W
Dt Action Result Contact Reason Promise Dt Promise Am: i Am%ﬁ Caondition Appn'mt Followup Dt
11/05/2020 v v v v 0.00 12,583.05 v [ 1 mm/ddfyyyy
11/05/2020 CC CUSTOMER CA... NP NOPROMISE ~ ATTORNEY 1ST PAYMENT DE.. 0.00 12,583.05 DELINQUENT __ 11/08/2020
11/05/2020 DC DEALER CALLED PS PAYMENT SEN... ATTORNEY 1ST PAYMENT DE... 11/12/2020 5,000.00 12,583.05 DELINQUENT v 11/11/2020

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

Customer Service screen’s Account Details tab

Open the Bankruptcy screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE’
Financial Services Lending and Leasing

Collect 3] Close
» DashBoard okt
> Origination Search | Customer Service: 20150900014275 | Review Request (Pending: )
> Servicing
Collections Account(s): 20150900014275: RODRIGUEZ MILDRED [l view || o Audit
View v Format v F Detach o] Wrap B, @ curent @ Show All © Group Folow-uy
Colections & = = @ 8 @ - - oreee P
Collections Company Branch  SubUnit Account # Product L 'g"j; Currency  Pay Off Amt Amount Due Status Oldest Due Dt
2:::;1?;:0” USDL  USHQ  UNDEFL. 20150800014275 LINEHE (FR) 122 UsD 13,747.80 7,527.99 ACTVEDELQ  09/27/2015
« 0 ] v
Deficiency -
Reports
Producers Summary | Customer Service | Account Details | CustomerDetals  Transaction History | PmtModes | Colateral | Bureau  Cross/Up Sel Activities
Vendors
Account Details  Statements | RateSchedule  Inswances | Contract Information
Account Information (5 view || o Audit
View v Format v [ Freeze  ifDetach Wrap 5]
Stop Accrual Index Type Index Rate Margin Rate Rate LastRate Change Dt Accrual Start Dt Last Acorual Dt DEGRRL S g’; £of
N PRIME RATE 5.00 299 .99 10/25/2015 09/05/2015 01/24/2016 13.08
‘ il i ] v
«
Account Information
{aRetum
Interest and Accruals #of Rate changes (Life) 1 Credit Details
Extn and Due Dates
Stop Acarual CredtLimit 18,300.00
Index Type PRIME RATE £ of Extensions (Year) 0 Hald () 0.00
Index Rate 5.00 # of Extensions (Ufe) 0 Consumed (9 18,300.00
Margin Rate 499 # of Extension Term (Year) 0 Suspended() 0.00
Rate 9.99 # of Extension Term (Life) 0 Availsble Cradit (=) 0.00
LastRate Change Dt 10/25/2015 # of Due Dt Changes(Year) 0 OverLimit Year 0
Accrual Start Dt 09/05/2015 #0f Due Dt Changes{Ufe) 0 Over Limit Life 0
Last Accrual Dt 01/24/2016 Last Extn Dt Last Advance Dt 09/05/2015
Rate Start of the Year 13.98 Due Day Chg Dt Last Advance Amt 18,500.00
# of Rate changes (Year) 1
> WFP
» Tools
> Setup
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3. For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Customer tab to view the sections under it.

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on the Customer Details screen.
Using the Customer Service screen’s Customer Details tab, you can update or add to a
customer’s address, employment information, or phone listing. All the information about the
customer can be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE B
Financial Services Lending and Leasing
olection: Close
> DashBoard L i e
= e Search | Customer Service || Review Request (Pendng: 0) 7
> Servicing
[ Elvew || o audt
R Account(s) . - ) Bl & Auc
View v Formatv Freeze §fiDetach ] current &) show Al ©) Group Folow-up
Collections & L @ a
Collections Company Branch  Sublnit  Account % Product DeV= Pt Currency  Pay OFF Amt Amount Due Status Oldest Due Dt
gt No data to display.
Repossession = = %
Deficency
Reports
Prodicers Summary | Customer Service | AccountOetals | Customer Details | Transaction History | PmtModes | Bureau | Cross/Up Sell Actiities
vendors
Customer  Business
Customer Information B
L E i 7 Audi
View v Format~  [Ep Freeze  idiDetach W
Customer = Relation £coA Name ssn Birth Dt Marital Status Enabled Lanc
N data to dsplay.
<[ it v 1
Customer Information
(= save and stay Save andReturn || CaRetun
Customer
Identification Details KvC
Customer &
Relation Passport # Reference #
EcoA Issue Dt Status
Name Expiry Dt
Birth Dt Visa = FATCA
Marital Status Natianaiity -
o National ID el
ssn Birth Country
Language &= Permanent US Resident Status
Education License = =
Mother's M License State
wep Mother's Maiden Name P G R
> Class Type -
Military Service
> Tools il Power of Attorney
S Stop Correspondence o Dl Holder Name .
niahitty : Ardrace

3. For details on this screen refer Customer Service screen’s Customer/Business Details
tab section in Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Bankruptcy screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.
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6.10

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Bankruptcy screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

Collections »

Search | Customer Service: 20150900014267 | R

Account(:

ACH Information

> wep

> Tools
> Setup

For details on Pmt Modes tab refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

Customer Service screen’s Bankruptcy tab

The Bankruptcy screen enables you to record the details of a bankruptcy. This information
usually is supplied from the customer or customer’s attorney. You can track each stage of the
bankruptcy process based on its follow-up date and record information using the Details and
Tracking sections.

As there are occasions when a borrower files bankruptcy more than once during the tenure
of the Line of credit , you can record information for multiple bankruptcies. The Add button
enables you to create a new bankruptcy record with different start and end dates. You can
also use the Bankruptcy screen to view the previous bankruptcy record using Next and
Previous buttons in the Detail section. The Current box in Detail section indicates the current
bankruptcy details.

To enter bankruptcy details for an account
1. Open the Customer Service screen and load the account you want to work with.
2. Click Bankruptcy tab.

3. Inthe Bankruptcy Details section, select the bankruptcy record you want to work with.
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4. Select Add to refresh the Bankruptcy screen to create a new record.

For details on this screen refer Customer Service screen’s Bankruptcy tab section in
Customer Service chapter.

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The Collat-
eral screen contains the Home and Seller sub tabs. To view the collateral details

1. Open the Customer Service screen and load the account you want to work with.

— Click Collateral tab. The system displays the following screen:
ORACLE

Financial Services Lending and Leasing
= Close
> DashBoard ko g Iy ®
> Onigination Search  Customer Service: 20150900014375  Review Request (Pending: 0) -
> Servicing
e Account(s): 20150900014275: RODRIGUEZ MILDRED Bl view || o Audit
View v Format ~ =~ Freeze Detach Wrap g, @ Current ) Show All ©©) Group Follow-uy
Collections = o @ a " "
Calections Company Branch  SubUnit  Account Froduct DavsPest Curency  Pay Off Amt AmountDue Status Oldest Due Dt
pepy USOL  USHQ  UNDEFL. 0150500014275 LINEHE(FR) 122 UsD 18,747.80 7.527.93 ACTIVEIDELQ  08/27/2015
Repossession - e = 5
Deficency
Reports
Producers Summary || Customer Service | AccountDetails | Customer Detais | Transaction History | PmtModes || Collateral | Bureau | Cross/Up Sell Activities
Vendors S
Home  Seler
Home
4 add || eat View| [ i
View = Formatv % Freeze pfiDetach | ol Wrap [0}
Primary Description Asset Class AssetType b Type Ocaupancy Lien Status LienEventDate  Second Lien Holder  Cor
i Y. 2015 INVERNIZZT NEW VEHICLE HOME SINGLE FAMILY H. 'OCCUPIED BY OW... UNDEFINED ld
« v
Home
Saveand Stay | [ Save andRetun || CaRetun
Type & Description Lien Details Deed Details
Primary ¥ Lien Status | UNDEFINED [=] Construction Permit Dt 01/30/2016 | B
Substitution Lien Event Date £ DeedDt 0y30/2016 b
Asset# 14011
= Second Lien Place of Issue  AMESBURY
* Asset Class  NEW HOME =)
Property Boundaries
= hsset Type | HOME = Comments =
*Sub Type | SINGLE FAMILY HOME =) D = North
Ocaupancy OCCUPIED BY OWNER A5 PRINCIPALE]) ok south
Census Tract /BNA West
> WEP Goge Property
MSA Codk Address
> Tools s
GEO Code Width 1200 T
Satuy| * Country UNITED STATES - =
> setup Status ACTIVE v [oion [+

— If the account’s collateral is a vehicle, Collateral screen opens at the Vehicle tab:
— If the account’s collateral is a home, Collateral screen opens at the Home tab.

— If the account’s collateral is neither a vehicle nor a home, Collateral screen opens
at the Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with account that were pulled during Line of creditservicing for the account. You

can also use the Bureau screen to create and pull additional credit bureau reports and view
the results as a text only file.

To view an existing credit bureau report

1. Open the Customer Service screen and load the account you want to work with.

2. On the Customer Service link bar, click Bureau.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.
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Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request
tab in the Customer Servicing screen.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query o

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.
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Query .

Options Descriptions

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.

Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review
request.

Action Options Descriptions

Open Account Displays the Customer Service screen with the Account details
assigned for review.

Send Request Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response | Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete Changes the status of review request to COMPLETED and can be
Request viewed by selecting ‘View All’ option in the ‘Query’ section.
Remove Filter Removes the selected filters applied to narrow the view of review

request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section enables you to send an email to either originator or receiver of the review
request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.
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The ‘Review Requests’ section in Customer Service screen displays the following information
for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.

Priority The request priority: HHGH, NORMAL, or LOW.

Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.
Address Applicant’s address in the review request.

Email Applicant’s email in the review request.

Status The current status of review request. Following status are

tracked in this column:
WAITING FOR RESPONSE - when request is sent to reviewer

RETURN TO ORIGINATOR - when reviewer has responded to
request

CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
Account # The Account number which needs review.

Days Past Due Total number of days elapsed past the due date.

Total Outstanding Displays either ‘Account outstanding principal balance’ for active
Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Customer Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account

review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.
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In the Comment History section, you can view the following details of the selected review
request:

Comments From | Descriptions

Type View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.

Sub Type View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.

Comment View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request #> FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt View the Date and time when the comment was posted.

6.13.2 Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE'
Financial Services Lending and Leasing

Customer service x [gose

Review Requests

equest ¥ 12003 Sender
* Account 0000100011820

LIVE PRI  DEA SPO
728663378

ress HOM
Status NEWIYORK,MASSACHUSETTS, 34038
ment. REVIEW ACCOUNT BALANCES Date 09/18/2017 12:23:38 AM Email EDW.SIRSI@GMAIL.COM
send Request [F]

Comment History
View~ Format > [Ep Fresze i Detach @
Type SubType Comment Comment By Comment Dt
No diata to display.

2. Inthe Review Requests section, select ‘Originator’.
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3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:
Request # View the system generated request number.
Originator View the requester’s user ID auto generated by system upon

creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in

DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.
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6.13.3

6.13.4

Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service [ Cose

Search | Customer Service | Review Request (Pending: 1) | Queue Assignment

Review Requests
dpadd | Zedt | [Fuew || of audt

Query Emall

User =l ©Originator @ Receiver OBoth  View Al [[] Forwarded Oriy [1] & Onignator | | g Receiver

View v Formatv [y Freeze  ifiDetach ap W  Dopen Accont st [§ SendResponse [ CloseRequest [ Complete Request
Request Crignator Priority Receiver Phore Address Emal Reason
L PRITAM JENA HIGH HARISH MACHA 9728663378 HOME - ADD& ;newyork,... EDW.SIRSIGGMAIL,COM  REVIEW ACCOUNT L
< i = 3
Comment History B yew
view v Formatv [ Freeze EfDetach » @

Type Sub Type Comment. Comment By Comment Dt

REVIEW REQUEST CRIGINATOR TESTFWD PRITAM 0/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER SURABHI 03/06/2017 09:33:45 AM
REVIEW REQUEST SYSTEM GENERATED INTERNAL /

REVIEW REQUEST RECETVER SURABHI
REVIEW REQUEST SYSTEM GENERATED INTERNAL

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Account’. The Account details are displayed in Customer Service > Summary
tab.

4. Review the details in particular to the details specified in the comment (if any).

Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.
Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.
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6.13.5

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.

When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as ‘INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[l save andstay | [ Save andReturn | {aReturn

Request # 5002 Sender NAVEEN REDDY Days Past Due 0
Originator PRITAM JENA Account # 2000010001120 Total Qutstanding 28,806.94
Priority HIGH Reason REVIEW ACCOUNT Bt

oG | MATTA, = Customer ALIVE PRI / DEA SPO

Phone 9723663378

Status WAITING FOR RESPONSE .
Comment Date 09/06/2017 09:32:11AM Ak 1 A
ate 09/08/ [NEVIYORK, MASSACHUSETTS, 34038
Send Request [ Emall EDW.SIRSIEGMAILL.COM

Comment History = View

View v Formatv B Fresze fDetach owap @
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST ORIGINATOR TESTFWD PRITAM 03/06/2017 09:32:30 AM

REVIEW REQUEST RECEIVER FWD SURABHL 09/06/2017 09:33:45 AM
| REQUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAT TO NAVEEN REDDY INTERNAL 09/06/2017 09:33:45 AM
REVIEW REQUEST RECEIVER FWD SURABHL 09/06/2017 09:34:31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

5. (Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.
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6.13.6

6.13.7

6.13.8

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_O r-

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.
The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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7.1

7.2

7.21

7. Repossession

Introduction

After an application has cycled through the Line of credit origination process, it becomes an
account. Account maintenance and collections tasks can be performed with Oracle Financial
Services Lending and Leasing’s Repossession screen.

The Repossession screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Line of credit origination cycle and is funded or is ported
into the system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on Repossession screen.

e Use the Search screen by selecting Customer Centric option(s).
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7.3

e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about customer(s) attached to the account. The
information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open Repossession
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter.
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7.4

7.5

7.5.1

7.51.1

Customer Service screen’s Summary tab

Open the Repossession screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

ORACLE' o Welame, vavar: +  ERSTRGN O
Financial Services Lending and Leasing
i Close
Spere Callections ®
> Origination Search  Customer Service | Review Request (Pending: 0)
> Senvicing
Callistions Account(s) Elview | o aut
o Views Fomatw B[] Freze 5 Detach wap @ & O cument O showal O Group Follovup
ollections
Collecions Company ranch Sub Unit Account # Froduct Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
e Mo data to display,
Repossession
Deficency Summary | CustomerSenice | Account Details | Customer Details | Transaction History | PmtModes | Bureau | Cross/Up Sel Acivites
Reports
Producers
oo Nerts Conditions
Vendors
Alerts Conditions
Aert Condition Start Ot Followup Dt
o data to display. Mo data to display.
4 Account Details Other Information
{
Dues o
Customer Information
Mo data to display. Customer ;e Relation ssh Birth Dt Gender
o data to display.
Delq Due Total Due Future Pmt Dt b
L Due Todays Payoff Oldest Due Dt
NSF Due Future Payoff AmtFaid Bxcess
Other Due Future Payoff e email Disabilty Privacy Opt Out
Ji formati Language Ship Active ilitary Duty
Delinquency Information Warital Status Stop Time Zone
Late 30 60 %0 120 150 180 Category Days Correspondence
No data to display.
BP(Life) NsF(Life) Collector Address Information
BP(Year NSF{Year) N Permissi |
Type Cument (" Mailng. Address Phone
Activities Mo datato display.
Adive Dt A Last Pt At
5 WEP Last Actiity Dt Paid Off Dt Charge Off Dt Employment Information
K Due Day Effective Dt Hilitary Duty Permissi
> Todls Last Pmt Dt Current Pmt Customer Score Twe S toCall Eplop Kitie B
> Setup Customer Grade Last Bill Amt Behaviour Score lio data to display. v

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter.

Customer Service screen’s Customer Service tab

Open the Repossession screen and load the account you want to work with. Click the
Customer Service tab to view the sections under it.

Call Activities sub tab

With the Call Activities section, system enables you to record the details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding the account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user-defined.

Each action and result has a code and description. The code for the call action and call result
is what appears on Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Repossession screen and load the account you want to work with.
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2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

Summary ~ Collections ~ Customer Service ~ Account Details =~ Customer Details =~ Customer Preferences  Transaction History ~Pmt Modes  Bankruptcy — Repo/Foreclosure  Deficiency  Collateral  Bureau  Timeli > ¥

Call Activities  Maintenance ~ Comments = Promises ~ Checklists ~ Tracking Attributes ~ Field Investigation ~ References ~ Correspondence  Letters  Document Tracking — Scenario Analysis ~ Access History
Call Activities

H saveandAdd | [ save and Sty || [ Saveand Retum | (@ Retum

View v Format~ [ Freeze Detach Virap W
Dt Action Result Contact Reason Promise Dt Promise Am: i Am%ﬁ Caondition Appn'mt Followup Dt
11/05/2020 v v v v 0.00 12,583.05 v [ 1 mm/ddfyyyy
11/05/2020 CC CUSTOMER CA... NP NOPROMISE ~ ATTORNEY 1ST PAYMENT DE.. 0.00 12,583.05 DELINQUENT __ 11/08/2020
11/05/2020 DC DEALER CALLED PS PAYMENT SEN... ATTORNEY 1ST PAYMENT DE... 11/12/2020 5,000.00 12,583.05 DELINQUENT v 11/11/2020

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter.

7.6 Customer Service screen’s Account Details tab

Open the Repossession screen and load the account you want to work with. Click the
Account Details tab to view the sections under it.

7.6.1 Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE’
Financial Services Lending and Leasing

Collect 3] Close
» DashBoard okt
> Origination Search | Customer Service: 20150900014275 | Review Request (Pending: )
> Servicing
Collections Account(s): 20150900014275: RODRIGUEZ MILDRED [l view || o Audit
View v Format v F Detach o] Wrap B, @ curent @ Show All © Group Folow-uy
Colections & = = @ 8 @ - - oreee P
Collections Company Branch  SubUnit Account # Product L 'g"j; Currency  Pay Off Amt Amount Due Status Oldest Due Dt
2:::;1?;:0” USDL  USHQ  UNDEFL. 20150800014275 LINEHE (FR) 122 UsD 13,747.80 7,527.99 ACTVEDELQ  09/27/2015
« 0 ] v
Deficiency -
Reports
Producers Summary | Customer Service | Account Details | CustomerDetals  Transaction History | PmtModes | Colateral | Bureau  Cross/Up Sel Activities
Vendors
Account Details  Statements | RateSchedule  Inswances | Contract Information
Account Information (5 view || o Audit
View v Format v [ Freeze  ifDetach Wrap 5]
Stop Accrual Index Type Index Rate Margin Rate Rate LastRate Change Dt Accrual Start Dt Last Acorual Dt DEGRRL S g’; £of
N PRIME RATE 5.00 299 .99 10/25/2015 09/05/2015 01/24/2016 13.08
‘ il i ] v
«
Account Information
{aRetum
Interest and Accruals #of Rate changes (Life) 1 Credit Details
Extn and Due Dates
Stop Acarual CredtLimit 18,300.00
Index Type PRIME RATE £ of Extensions (Year) 0 Hald () 0.00
Index Rate 5.00 # of Extensions (Ufe) 0 Consumed (9 18,300.00
Margin Rate 499 # of Extension Term (Year) 0 Suspended() 0.00
Rate 9.99 # of Extension Term (Life) 0 Availsble Cradit (=) 0.00
LastRate Change Dt 10/25/2015 # of Due Dt Changes(Year) 0 OverLimit Year 0
Accrual Start Dt 09/05/2015 #0f Due Dt Changes{Ufe) 0 Over Limit Life 0
Last Accrual Dt 01/24/2016 Last Extn Dt Last Advance Dt 09/05/2015
Rate Start of the Year 13.98 Due Day Chg Dt Last Advance Amt 18,500.00
# of Rate changes (Year) 1
> WFP
» Tools
> Setup

-4 ORACLE



7.7

7.8

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter.

Customer Service screen’s Customer Details tab

Open the Repossession screen and load the account you want to work with. Click the
Customer tab to view the sections under it.

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on Customer Details screen. Using
the Customer Service screen’s Customer Details tab, you can update or add to a customer’s
address, employment information, or phone listing.All the information about the customer can
be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE B
Financial Services Lending and Leasing

> DashBoard Collcrtmine & e
I Dncnation Search  Customer Service || Review Request (Pending: 0) e
> Servicing
R Account(s) | Sl yew || o Audt
View = Format v Freeze [fiDetach g, Current ) show All &) Group Folow-up
Collections & L @ a
Collections Company Branch  Sublnit  Account % Product DeV= Pt Currency  Pay OFF Amt Amount Due Status Oldest Due Dt
gt No data to display.
Repossession 5 - 5
Deficiency
Reports
Producers Summary | Customer Service || Account Detals | Customer Details | Transaction Hstory || PmtModes | Burcau | Cross/Up Sell Activities
vendors
Customer | Business
Customer Information £
L E i 7 Audi
View v Format~  [Ep Freeze  idiDetach W
Customer % Relation Econ Name ssn Birth Dt Marital Status Enabled Lane
No data to display.
< it v "
Customer Information
(= save and stay Save andReturn || CaRetun
Customer
Identification Details Kve
Customer &
Relation Passport # Reference #
Econ Issue Dt Status
Name Expiry Dt
Birth Dt Visa = FATCA
Marital Status Nationziity .
o National ID el
SN Birth Country
Language &= Permanent US Resident Status
Education License = —
Mother's M License State
= Mother's Maiden Name R
> Class Type -
Military Service
> Tools il Power of Attorney
— Stop Correspondence e Holder Name i
Diahiity £ Arddrace

For details on this screen refer Customer Service screen’s Customer/Business Details tab

section in Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Repossession screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.
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7.9

7.9.1

7.10

7.10.1

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Repossession screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays information about automated clearing house and electronic
fund transfers.

To view the ACH information screen

1. Open the Customer Service screen and load the account you want to work with.

Click Pmt Modes tab, then click ACH sub tab.

ORACLE"
Financial Services Lending and Leasing

= Close
T Collections 1)

> Origination Search | Customer Service: 0150900014267 | Review Request (Pending: 0)

Account(s): 20150900011267: SIGG MARK Elvew || o2 A

View v romat v | B e i Detach Wi Y

Company Branch SubUnit  Account # Product e
uso1 usHQ 20150900014267 LOAN VEHICLE (FR)

@ Current © Show All © Group Follow-up.

s Pa:

urrency  Pay OFf Amt. Amount Due Status Oldest Due Dt

=
P,
[
113 UsD 19,397.24 509,00 ACTIVEIDELQ  10/01/2015

summary | | Customer servies | Account Detalls | Customer Detalls | Trensaction History | Pmt Modes || Collateral | Bureau | Cross/Up Sell Actvities

Ach || Coupon || PostDatad Checks || Payment Arrangement

ACH Information
a4 add || Pt View || o7 Audt
View - Format~ Freeze  EfiDetach - a
Reference = Baric Name Bank City Bank state Routing = Account Type Name On Account  Account = sic AN
i No data to display.

ACH Information

Status

> wep

> Tools
> Setup

For details on this screen refer Customer Service screen’s Pmt Modes tab section in
Customer Service chapter.

Customer Service screen’s Repo/Foreclosure tab

The Repossession/Foreclosure screen enables you to record information regarding
repossessions/foreclosure in a manner similar to how bankruptcies are recorded on the
Bankruptcy screen. You can track each stage of the repossession/foreclosure process based
on the follow-up date and record information using Details and Tracking section.

Repossession sub tab

On occasion, a lender performs multiple repossessions for the same Line of credit . The
Create New Repossession button on the Repossession screen enables you to create a new
repossession record for a different collateral and different start and end dates. You can also
use the Repossession screen to view previous repossession information using the Next and
Previous buttons in Details section. The Current box in Details section indicates the current
repossession record for each asset.

This tab will be available only when the collateral type associated with the Line of credit
account is a Vehicle.
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You can update the current record, but previous records cannot be modified.

To Specify repossession details for an account

1.
2.

4.

Open the Repossession screen and load the account you want to work with.
Click the Repo/Foreclosure sub tab, then click Repossession.

In the Repossession Details section, select the repossession record you want to work
with.

_0 r_

Click Add to refresh the Repossession screen to create a new record.

ORACLE’ 3 Welcome, VAVAIDYA + T?
Financial Services Lending and Leasing
Close
P Repossession x [@d
' Origination search @ + 20160100013159 # Request (Pending: 0)
> Servidng
Collections Account(s): 20160100013159: LT17 LI17 Q.WEIV o Audit
rors Views Formatv B [|Fresze i Detach wap @ & 1 curent O showall O Group Folloveup
ollections
Collections Company ranch Sub Unit Account £ Froduct Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Bankouptey st UsHQ 2016010013159 LOAN VEHICLE (FR) 13 USD 36,004.99 000 02/03/2016
Repossession
Deficency Summary | Customer Service | Account Details  Customer Details  Transaction istory | Pt Modes  Repo/Foreclosure | Collateral | Bureau | Cross/Up Sell Adtvities
Reports
Producers Repossession  Analysis
Vendors
Repossession Details deadd | Zeit | [Eview | o audt
Viewv Formatv B (1] Freszz EfiDetach wee @
Curent Followup Dt Type Callatera Disposition File Received Dt Repo Dt Repo EndDt  Comment
¥ 12/31/4000 0 TOYOTA COROLA
Y 02032016 DEFAULT CUSTOMER REDEEMED VEHICLE 0003206 0032016 020292016
Repossession Details
[ saveandadd | [ saveand stay | [ Save and Retun | Ca Return
‘
* Current * Collseral 0 TOYOTA COROLA v Repo Ot B
Folowup Dt 123174000 B * Dispositon v Repo End Dt B
Type File Received Dt 2 Comment
4
Tracking ZEit | [E]view | o auit
Views Formatv [ Freeze G Detach Wiap @) o Load Tracking
SubParameter  Parameter Value
No data to display.
Call Activities  Comments ~ Due Date History
Call Activities dad | ZEit | 5 view | o At
View Fomatv B [[] Freeze i Detach @
Adtion Reault Contact Reason CancelProise Dt Promise Amt. Condition Appointr Followup Dt Time Zone Adj Followup Ot
> WEP ® oRP ATTORNEY N 0.00 NONE N 0030t 02/02/2016 12:30:00
> Tools 4
> Setup -

For details on this screen refer Customer Service screen’s Repo/Foreclosure tab section in
Customer Service chapter.

Customer Service screen’s Collateral tab

The Collateral screen displays information regarding any assets associated with an account.
Collateral can be a vehicle, home, or something else, such as household goods. The
Collateral screen contains the Home and Seller sub tabs.

To view the collateral details

1.

Open the Repossession screen and load the account you want to work with.
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— Click Collateral tab. The system displays the following screen:

Financial Services Lending and Leasing
olfection:s Close
> DashBoard = b [ ®
e Onoination Search  Customer Service: 20150900014275 | Review Request (Pending: 0) -
5 Servicing
Collections: Account(s): 20150900014275: RODRIGUEZ MILDRED S vew || o Audit
Pt View v Formatw Freeze fffiDetach Wirap @ & @ curent® show all® Group Follon-up
Collections Company Branch  SubUnit  Account# Product DayrsPast Currency  Pay Off Amt Amount Due Status Oldest Due Dt
Banaupicy
R:;;u:;s;m USOL  USHQ  UNDEFL.. 2015090014275 LINEHE (FR) 122 UsD 19,747.80 7,527.99 ACTIVEIDELQ  09/27/2015
« i ,
Deficiency
Reports
Preducers Summary || Customer Service || Account Detais || Customer Detals | Transaction History || PmtModes || Collateral | Bureau | Cross/Up Sell Activities
Vendors =
Home | Seler I
Home
o add || Zear || [Huew || o2 audn
Veww Fomatv | B} | [[[]Frecz= [ivetach » | @
Primary Description Asset Class AssetType b Type Ocaupancy Lien Status LienEventDate  Second Lien Holder  Cor
1 ¥ 2015 INVERNIZZ .. NEW VEHICLE HOME SINGLE FAMILY H... OCCUPIED BY OW... UNDEFINED q
w v
Home
[ save andStay | [ Save andReturn || (aRetum
Type & Description Lien Details Deed Details
Primary ¥ Lien Status | UNDEFINED [=) Construction Permitot 0y30/2016 | B
Substitution — Lien Event Date ) Deed Dt 01/30/2016 |
Asset# 14011
Second Lien Place of Issue  AMESBURY
* Asset Class  NEW HOME [=] Holder
Property Boundaries
* Asset Type HOME [=] Comments From East
*5ub Type | SINGLE FAMILY HOME =] Lien Rﬁé‘ﬁf‘fi = Morth
Occupancy | OCCUPIED BY OWNER AS PRINCIPALx] Entity Name oy
Census Tract /BNA West
> WP Code Property
MSA Cod Address
> Tools o
GEO Code Width 1200 e
Set \ * Country UNITED STATES - o
> setup Stane ACTIE B =

— If the account’s collateral is a vehicle, the Collateral screen opens at the Vehicle
tab:

— If the account’s collateral is a home, the Collateral screen opens at the Home tab.

— If the account’s collateral is neither a vehicle nor a home, the Collateral screen
opens at the Other Collateral.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Customer Service screen’s Bureau tab

The Customer Service screen Bureau screen enables you to view credit bureau reports
associated with the account that were pulled during Line of credit servicing for the account.
You can also use the Bureau screen to create and pull additional credit bureau reports and
view the results as a text only file.

To view an existing credit bureau report
1. Open the Customer Service screen and load the account you want to work with.
2. On the Customer Service link bar, click Bureau.

For details on this screen refer Customer Service screen’s Collateral tab section in Customer
Service chapter.

Review Request

The Review Requests screen is primarily a work flow tool used to flag an Account for the
attention of another Oracle Financial Services Lending and Leasing user and ask for review /
feedback. It allows the system users to send and receive requests (including e-mail)
commenting on a specific Account. The Review Request tab supports iterative review of
selected Account and also to process the review with multiple reviewers.

In this chapter, you will learn how to compete the following tasks:

e Filter and View Review Requests
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e Create and Send Review Request
e Reviewing a Request

e Responding to Review Request

e Reassign Review Request

e E-mailing Review Request

e Closing Review Request

e Complete Review Request

Note

You can complete the above tasks for an Account Review Request using Review Request
tab in the Customer Servicing screen.

Filter and View Review Requests

The Review Requests tab contains the following sections:
e Query Section
e Action Section
e Email Section
e Comment History Section

Query Section

The Query section enables you to filter records based on User and type of review requests
using any of the following options:

The ‘User’ drop-down lists your User ID along with your Supervisor ID if the same has been
defined in User Definition screen (Setup > Administration > User > Users). If you are the
supervisor, you can view all your subordinates User ID’s along with yours for selection.

On selecting a particular User ID from the list, system displays all the requests which are
created, reviewed, closed and completed by that user.

You can further filter the review request based on the following:

Query o

Options Descriptions

Originator Displays the records of all the active review requests created by the
selected User.

Receiver Displays the records of all the active review requests received by the
selected User.

Both Displays all the review requests records created as well as reviewed by
the selected User with the status other than ‘CLOSED’ and ‘COM-
PLETED'.

View All Displays all the review requests records created as well as reviewed by
the selected User with all the statuses.

Forwarded Displays all the review requests records which are forwarded by the

Only selected User to another user for review.
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Action Section

The Action section enables you to Send (create), Respond, Close, or Complete the review
request.

Action Options Descriptions

Open Account Displays the Customer Service screen with the Account details
assigned for review.

Send Request Sends a review request to another Oracle Financial Services Lend-
ing and Leasing user.

Send Response | Sends a response to a review request received from another Ora-
cle Financial Services Lending and Leasing user.

Close Request Changes the status of review request to CLOSED and can be
viewed by selecting ‘View All’ option in the ‘Query’ section.

Complete Changes the status of review request to COMPLETED and can be
Request viewed by selecting ‘View All’ option in the ‘Query’ section.
Remove Filter Removes the selected filters applied to narrow the view of review

request. The option is available when a review request is accessed
from DashBoard > My Pending Review Requests section.

Email Section

The Email section enables you to send an email to either originator or receiver of the review
request if an email setup is configured. However, note that a review request cannot be
responded or replied back from email recipient.

Email Descriptions

Options P

Originator Sends an email of review request information to the person listed in the
Originator column on Review Request page.

Receiver Sends an email of review request to the person listed in the Receiver
column on Review Request page.

The ‘Review Requests’ section in Customer Service screen displays the following information
for each record:

Fields Descriptions

Request # View the system generated review request number. The same
can be used to query and track the review requests.

Originator The user id of the review request originator.
Priority The request priority: HIGH, NORMAL, or LOW.
Receiver The recipient of the review request.

Phone Applicant’s phone number in the review request.
Address Applicant’s address in the review request.
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Fields Descriptions

Email Applicant’s email in the review request.

Status The current status of review request. Following status are
tracked in this column:

WAITING FOR RESPONSE - when request is sent to reviewer

RETURN TO ORIGINATOR - when reviewer has responded to
request

CLOSED - when the request is closed
COMPLETED - when the request is completed

Date The date and time when the review request was created.
Account # The Account number which needs review.

Days Past Due Total number of days elapsed past the due date.

Total Outstanding Displays either ‘Account outstanding principal balance’ for active
Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Customer Primary / Secondary (spouse) name associated to the account.

Comment History

The ‘Comment History’ section displays the log of comments or additional information added
by originator or receiver while creating or reviewing a request.

During an iterative review, where there are multiple trails of communication exchanged
between originator and receiver, the ‘Comment History’ section tracks all the updates as
individual records for reference.

The Comment History section also allows you to know the actually reviewer when an Account
review request is forwarded to multiple reviewers and is reviewed or completed by second or
third person other than the one assigned by originator.

In the Comment History section, you can view the following details of the selected review
request:

Comments From | Descriptions

Type View the type of request and is indicated as REVIEW REQUEST by
default as maintained in ‘COMMENT_TYPE_CD’ lookup code.

Sub Type View the sub type of request which can be ORIGINATOR,
RECEIVER, or SYSTEM GENERATED as maintained in COM-
MENT_SUB_TYPE_CD lookup code.

Note: The sub type ‘SYSTEM GENERATED’ is automatically posted
by the system when the review request is forwarded to another user
by the assigned reviewer. The same is also updated with a com-
ment in the next column.
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Comments From

Descriptions

Comment

View the Originator’s or Reviewer’s comment.

SYSTEM GENERATED comments are posted in the format -
REVIEW REQUEST: <Request #> FORWADED FROM <first
assigned user id> TO <next assigned user id>.

Comment By

View the user who has posted the comment.
SYSTEM GENERATED comments are marked as ‘INTERNAL'.

Comment Dt

View the Date and time when the comment was posted.

7.13.2

Create and Send Review Request

The review request tab primarily allows you to flag an Account for the attention of another
OFSLL user through a request asking for review / feedback. While doing so, you can either
choose to send it to the reviewer immediately on creating the request or only create the
request and later send for review.

To Create and Send Review Request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE’

Financial Services Lending and Leasing

Customer Service x

Review Requests

Request # 12003
Origator

*Priority | HIGH
*Recsiver ANAND SHEKAR

Comment History
Vew~ Fomate | Bp

Type
No data to display.

ment REVIEW ACCOUNT BALANCES

Feew Pivenh | Jwen | @

SubType Commen t Comment By Comment Dt

m || GaReturn

0000100011820
LIVE PRI [ DEA SPO
728663378
Address HOME - ADD&:
Status [NEVYORK, MASSACHUSETTS, 34038
Date 09/18/2017 12:23:35 AM Emsil EDW.SIRSI@GMAIL.COM
Send Request (]

= *Reas

evtew saLAvCES =

2. In the Review Requests section, select ‘Originator’.

3. Click ‘ADD’. You can also perform any of the Basic Operations mentioned in Navigation
chapter. A brief description of the fields are given below:

In this field: View this:

Request # View the system generated request number.

Originator View the requester’s user ID auto generated by system upon
creating the request.

Priority Select the priority of review request as High, Normal, or Low
from the drop-down list. This helps the reviewer to prioritize
the request while responding but does not affect the order in
which messages are sent or received.

Receiver Select the user ID of the reviewer from the drop-down list.
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In this field: View this:

Comment Specify additional details for review (if any) which can be sent
to the reviewer along with the review request.

Sender View the user ID of previous reviewer, if a request has been
forwarded to another reviewer.

Note: A forwarded review request can only be viewed in the
review request tab by filtering user ID of previous reviewer
and selecting ‘Forwarded only’ check box.

Account # Select the Account to be reviewed from the drop-down list.
The following fields are auto-populated based on selection:

Days Past Due

Total Outstanding Balance
Customer

Phone

Address

Email

Reason Select the purpose for request from drop-down list.

Status View the status of review request auto updated by system
upon creating the request.

Date View the date and time when the request was created. Sys-
tem appends the current date by default.

Send Request (Optional) Select this check box to send it to reviewer immedi-
ately on creating the request.

However, if the request still need changes, retain the check
box unselected and proceed to create the request. The same
can later be sent for review by selecting ‘Send Request’
option from the action section.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The review request(s) appear on the recipient’s ‘My Pending Review Request’ window in
DashBoard and also on the ‘Review Request’ tab header with (Pending: <count of unseen
requests>). The status of request is updated as WAITING FOR RESPONSE.

7.13.3 Reviewing a Request

When you receive a review request, the system notifies you by creating an entry in ‘My
Pending Review Requests By Priority’ section in DashBoard with the number of unseen
messages. Clicking on the Account # link opens the Review Request tab.
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7.13.5

To review requests

1. On the Oracle Financial Services Lending and Leasing Application home page, click

Servicing > Customer Service screen and select ‘Review Requests’ tab.

ORACLE'
Financial Services Lending and Leasing

Customer Service x 3 Cose

Search  Customer Service  Review Request (Pending: 1) Queue Assignment £

Review Requests
dp add || Zedt || [Elvew |[ of audt
Query

Email

User = Originator @ Receiver ©'Both  View Al [F] Forwarded Only 9 Orignator | | §9 Receiver

Viws raats | B Freese  filiDetach p | @ (EA0pen Account
Request * Originator Priority Receiver Phone Address Email Reason
so0z PRITAM JENA HIGH HARISH MACHA a728663378 HOME - ADD& newyork,... EDW.SIRSIGGMALL COM  REVIEW ACCOUNT
‘ n '

st [ SendResponse [ CossReguest [ ComplteRequest

Comment History & view
View > Formatv B Freeze i Detach 2 @

Type Sub Type Comment Comment By CommentDt
REVIEW REQUEST ORIGINATOR TESTFWD. PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER
REVIEW REQUEST SYSTEM GENERATED REQUEST : 8002 FORVADED FROM SURASH DESAI TO NAVEEN REDDY  INTERNAL
REVIEW REQUEST RECEIVER SURABHI
REVIEW REQUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FROM NAVEEN REDDY TO HARISHMACHA  INTERNAL

SURABHL 03/06/2017 09:33:45 AM

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Click ‘Open Account’. The Account details are displayed in Customer Service > Summary
tab.

4. Review the details in particular to the details specified in the comment (if any).

Responding to Review Request

On completing the review, you can Send Response detailing the feedback of your review. It
is ideally recommended to send a response back to the originator by providing your views on
the review as a comment. The details are recorded in the ‘Comment History’ section as
reference.

However, system also allows your forward the same request to another reviewer in case of
additional clarifications.

To respond to review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed.Click ‘Edit’.
Specify your review response in the ‘Comment’ field. Select the ‘Send Request’ check
box to send the review response immediately to originator. In case of any further changes,
retain the check box unselected and save the details. The response is not sent and the
same can later be sent to originator by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as RETURN
TO ORIGINATOR.

Reassign Review Request

While reviewing a request, system also facilitates you to reassign (i.e. forward) the review
request to another user for review. In such a case, you become the ‘Sender’ and the assigned
user will be the reviewer of the request. The request can further move to other reviewers if
required.
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When the request is reassigned or forwarded to another reviewer, the actual originator can
still track the status of request by selecting user ID in Query section. As a ‘Sender’, you can
view the reassigned review requests by selecting the ‘Forwarded Only’ check box in Query
section. Also, on reassigning or forwarding a review request, system automatically posts a
comment in ‘Comment History’ section in the format - REVIEW REQUEST: <Request #>
FORWADED FROM <first assigned user id> TO <next assigned user id> with Sub Type as
‘SYSTEM GENERATED’ and Comment By as ‘INTERNAL'.

Note

It is recommended to limit the reassignment of review request since tracking the request
status becomes difficult.

To reassign review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Inthe Query section, click ‘Receiver’. System displays all open review request you have
received.

3. Inthe Review Request section, select the record that you have reviewed and click Edit.

Review Requests
[ save andstay | [ saveandRetun | CaReturn

Request # 8002 Sender NAVEEN REDDY Days PastDue 0
Originator PRITAM JENA Account # 2000000011820 Total Qutstanding 28,806.94
Priority HIGH Reason REVIEW ACCOUNT Patnce
et (AT T AT = Customer  ALIVE PRI / DEA SPO
Phone 9728663378
Status WAITING FOR RESPONSE
omment s Address HOME - ADD&
Ente. ARRIGENHF DO LN NEWYORK, MASSACHUSETTS, 34038
Send Request [T Email EDW.SIRSIGGMAIL.COM

Comment History

View v Formatv G Freeze i Detach wrap @)
Type Sub Type Comment CommentBy Comment Dt
REVIEW REQUEST ORIGINATOR TESTFWD PRITAM 09/06/2017 09:32:30 AM
REVIEW REQUEST RECEIVER FwD SURABHI  03/06/2017 09:33:45 AM
[REVIEW REQUEST SYSTEM GENERATED REVIEW REQUEST : 8002 FORWADED FROM SURABHI DESAL TO NAVEEN REDDY  INTERNAL  09/06/2017 09:33:45 AM
REVIEW REQUEST RECETVER FWD SURABNL  09/06/2017 03:3%:31 AM

4. Select the required reviewer from ‘Receiver’ drop down list.

(Optional) Specify the reason for reassignment in the ‘Comment’ field. The same is
tracked in ‘Comment History’ section.

6. Select the ‘Send Request’ check box to reassign review request immediately on update.
In case of any further changes, retain the check box unselected and save the details. The
reassignment can later be completed by selecting the record and clicking on ‘Send
Response’ option from the action section.

The details are updated in Review Request tab and status of request is updated as WAITING
FOR RESPONSE.

E-mailing Review Request

While system updates ‘My Pending Review Requests By Priority ‘section in the DashBoard to
notify you about the new requests, you can also e-mail a review request to both the originator
and a receiver, as applicable. The system will use e-mail address recorded for both the
originator and receiver in Setup > Administration > User > User Definition section.
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7.13.8

To e-mail a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. In‘Email’ section, click ‘Originator’ to send the message to the person listed in Originator
field.

_O r_

3. Click ‘Receiver’ to send it to the person listed in the Receiver field.
The system emails the details of selected record to e-mail address recorded in user setup.

Closing Review Request

You can close a review request you created at anytime, regardless of status. However, you
can only close review requests that have your user id in the Originator field. When you close
a review request, the system removes it from Review Request tab.

To close a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Close Request’.
The system assigns the request as CLOSED and removes it from your Review Request

record. The closed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.

Complete Review Request

When a particular review request has completed the review process from reviewer with
required changes and confirmation, the same can be marked as ‘COMPLETE’ in the Review
Request tab. However, you can complete a request only if you are the originator of the
request. When you complete a review request, system removes it from Review Request tab.

To complete a review request

1. On the Oracle Financial Services Lending and Leasing Application home page, click
Servicing > Customer Service screen and select ‘Review Requests’ tab.

2. Select the request you want to close in the Review Request section.
3. Inthe Action section, click ‘Complete Request’.
The system assigns the request as ‘COMPLETED’ and removes it from your Review Request

record. The completed review requests can be reviewed anytime by selecting ‘View All’ in the
Query section.
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8.1

8.2

8.2.1

8. Deficiency

Introduction

After an application has cycled through the Line of credit origination process, it becomes an
account. Account maintenance and collections tasks can be performed with Oracle Financial
Services Lending and Leasing’s Deficiency screen.

The Deficiency screen enables you to view and manage all customer information in a
centralized location to ensure data integrity and provide better service. Oracle Financial
Services Lending and Leasing provides online real-time information about the applicant(s),
contract, account balances, dues, transactions, call activities, and comments. Oracle
Financial Services Lending and Leasing also supports back-dating of financial transactions till
the account’s opening date.

Activating an Account

An account is automatically activated when you fund the contract using the Funding main tab
or convert from a legacy system.

Posting and Reversing Payments

A payment can be posted and reversed on the Payments screen.

Account Mask

After an application completes the Line of credit origination cycle and is funded or is ported
into the system, it becomes an account and receives an account number. The system assigns
account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date

NNNNNNN = serial number

X = check digit

The system sorts accounts using the NNNNNN portion only. That portion is referred to as the
account ID.

Search Tab

There are two types of search available.

e Account
e Customer

Searching for a Customer or Account

There are a number of different ways to load the customer details on Deficiency screen.

e Use the Search screen by selecting Customer Centric option(s).
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e Use the Quick Search section to search for the customer by Account Number, or
Customer Id, or by specifying the last four digits of Primary SSN (SSN of the primary
applicant).

e Use the Next Account feature to load the customer from a predefined queue.

For details on how to search and load the customer or account details using Search screen,
refer Search Using Customer Details section in Search Function chapter.

Customer Service screen

Most screens on the Customer Service screen contain the Account(s) and Customer(s)
sections as a header. The Account(s) section provides a quick overview of an account by
displaying its company, branch, account number, product, payoff amount and amount due,
status, and oldest due date. The information on Customer Service screen always refers to the
account selected in this section.

The Customer(s) section displays information about the customer(s) attached to the account.
The information on Customer Service screen always refers to the customer selected in this
section.

To view account details in the Account(s) and Customer(s) sections, open the Deficiency
screen and load the account you want to work with.

On the Customer Service screen’s Account(s) section, you can view the information based
on your selection.

For details on this screen refer Customer Service screen section in Customer Service
chapter
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8.5

8.5.1

8.5.1.1

Customer Service screen’s Summary tab

Open the Deficiency screen and load the account you want to work with. By default the
Customer Service screen opens the Summary tab.

ORACLE' o Welame, vavar: +  ERSTRGN O
Financial Services Lending and Leasing
i Close
Spere Callections ®
> Origination Search  Customer Service | Review Request (Pending: 0)
> Senvicing
Callistions Account(s) Elview | o aut
o Views Fomatw B[] Freze 5 Detach wap @ & O cument O showal O Group Follovup
ollections
Collecions Company ranch Sub Unit Account # Froduct Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
e Mo data to display,
Repossession
Deficency Summary | CustomerSenice | Account Details | Customer Details | Transaction History | PmtModes | Bureau | Cross/Up Sel Acivites
Reports
Producers
oo Nerts Conditions
Vendors
Alerts Conditions
Aert Condition Start Ot Followup Dt
o data to display. Mo data to display.
4 Account Details Other Information
{
Dues o
Customer Information
Mo data to display. Customer ;e Relation ssh Birth Dt Gender
o data to display.
Delq Due Total Due Future Pmt Dt b
L Due Todays Payoff Oldest Due Dt
NSF Due Future Payoff AmtFaid Bxcess
Other Due Future Payoff e email Disabilty Privacy Opt Out
Ji formati Language Ship Active ilitary Duty
Delinquency Information Warital Status Stop Time Zone
Late 30 60 %0 120 150 180 Category Days Correspondence
No data to display.
BP(Life) NsF(Life) Collector Address Information
BP(Year NSF{Year) N Permissi |
Type Cument (" Mailng. Address Phone
Activities Mo datato display.
Adive Dt A Last Pt At
5 WEP Last Actiity Dt Paid Off Dt Charge Off Dt Employment Information
K Due Day Effective Dt Hilitary Duty Permissi
> Todls Last Pmt Dt Current Pmt Customer Score Twe S toCall Eplop Kitie B
> Setup Customer Grade Last Bill Amt Behaviour Score lio data to display. v

For details on this screen refer Customer Service screen’s Summary tab section in Customer
Service chapter

Customer Service screen’s Customer Service tab

Open the Deficiency screen and load the account you want to work with. Click the Customer
Service tab to view the sections under it.

Call Activities sub tab

With the Call Activities section, the system enables you to record details of all actions you
performed regarding this account. This includes calls from the customer, calls you make
regarding account, or changes to condition of the account. Entries in the Call Activities
section are listed in reverse chronological order of follow-up date and are user-defined.

Each action and result has a code and description. The code for the call action and call result
is what appears on Call Activity sub screen.

Recording a Call Activity

To record a call activity

1. Open the Deficiency screen and load the account you want to work with.
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8.6.1

2. Click Customer Service sub tab and then click Call Activities tab under it. Click Add.
The system displays the following screen.

Summary ~ Collections ~ Customer Service ~ Account Details =~ Customer Details =~ Customer Preferences  Transaction History ~Pmt Modes  Bankruptcy — Repo/Foreclosure  Deficiency  Collateral  Bureau  Timeli > ¥

Call Activities  Maintenance ~ Comments = Promises ~ Checklists ~ Tracking Attributes ~ Field Investigation ~ References ~ Correspondence  Letters  Document Tracking — Scenario Analysis ~ Access History
Call Activities

H saveandAdd | [ save and Sty || [ Saveand Retum | (@ Retum

View v Format~ [ Freeze Detach Virap W
Dt Action Result Contact Reason Promise Dt Promise Am: i Am%ﬁ Caondition Appn'mt Followup Dt
11/05/2020 v v v v 0.00 12,583.05 v [ 1 mm/ddfyyyy
11/05/2020 CC CUSTOMER CA... NP NOPROMISE ~ ATTORNEY 1ST PAYMENT DE.. 0.00 12,583.05 DELINQUENT __ 11/08/2020
11/05/2020 DC DEALER CALLED PS PAYMENT SEN... ATTORNEY 1ST PAYMENT DE... 11/12/2020 5,000.00 12,583.05 DELINQUENT v 11/11/2020

For details on this screen refer Customer Service screen’s Customer Service tab section in
Customer Service chapter

Customer Service screen’s Account Details tab

Open the Deficiency screen and load the account you want to work with. Click the Account
Details tab to view the sections under it.

Account Details sub tab

Oracle Financial Services Lending and Leasing enables you to view account details using
Account Details sub tab.

In the Account Information section click View.

ORACLE’
Financial Services Lending and Leasing

Collect 3] Close
» DashBoard okt
> Origination Search | Customer Service: 20150900014275 | Review Request (Pending: )
> Servicing
Collections Account(s): 20150900014275: RODRIGUEZ MILDRED [l view || o Audit
View v Format v F Detach o] Wrap B, @ curent @ Show All © Group Folow-uy
Colections & = = @ 8 @ - - oreee P
Collections Company Branch  SubUnit Account # Product L 'g"j; Currency  Pay Off Amt Amount Due Status Oldest Due Dt
2:::;1?;:0” USDL  USHQ  UNDEFL. 20150800014275 LINEHE (FR) 122 UsD 13,747.80 7,527.99 ACTVEDELQ  09/27/2015
« 0 ] v
Deficiency -
Reports
Producers Summary | Customer Service | Account Details | CustomerDetals  Transaction History | PmtModes | Colateral | Bureau  Cross/Up Sel Activities
Vendors
Account Details  Statements | RateSchedule  Inswances | Contract Information
Account Information (5 view || o Audit
View v Format v [ Freeze  ifDetach Wrap 5]
Stop Accrual Index Type Index Rate Margin Rate Rate LastRate Change Dt Accrual Start Dt Last Acorual Dt DEGRRL S g’; £of
N PRIME RATE 5.00 299 .99 10/25/2015 09/05/2015 01/24/2016 13.08
‘ il i ] v
«
Account Information
{aRetum
Interest and Accruals #of Rate changes (Life) 1 Credit Details
Extn and Due Dates
Stop Acarual CredtLimit 18,300.00
Index Type PRIME RATE £ of Extensions (Year) 0 Hald () 0.00
Index Rate 5.00 # of Extensions (Ufe) 0 Consumed (9 18,300.00
Margin Rate 499 # of Extension Term (Year) 0 Suspended() 0.00
Rate 9.99 # of Extension Term (Life) 0 Availsble Cradit (=) 0.00
LastRate Change Dt 10/25/2015 # of Due Dt Changes(Year) 0 OverLimit Year 0
Accrual Start Dt 09/05/2015 #0f Due Dt Changes{Ufe) 0 Over Limit Life 0
Last Accrual Dt 01/24/2016 Last Extn Dt Last Advance Dt 09/05/2015
Rate Start of the Year 13.98 Due Day Chg Dt Last Advance Amt 18,500.00
# of Rate changes (Year) 1
> WFP
» Tools
> Setup
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8.7

8.8

For details on this screen refer Customer Service screen’s Account Details tab section in
Customer Service chapter

Customer Service screen’s Customer Details tab

Open the Deficiency screen and load the account you want to work with. Click the Customer
tab to view the sections under it.

Information gathered on the application entry process regarding the customer and customer’s
address, employment data, and phone numbers appears on Customer Details screen. Using
the Customer Service screen’s Customer Details tab, you can update or add to a customer’s
address, employment information, or phone listing. All the information about the customer can
be changed using Maintenance screen.

To view or edit customer information
1. Open the Customer Service screen and load the account you want to work with.

2. Click Customer Details sub tab.

ORACLE B
Financial Services Lending and Leasing

> DashBoard Collcrtmine & e
I Dncnation Search  Customer Service || Review Request (Pending: 0) e
> Servicing
R Account(s) | Sl yew || o Audt
View = Format v Freeze [fiDetach g, Current ) show All &) Group Folow-up
Collections & L @ a
Collections Company Branch  Sublnit  Account % Product DeV= Pt Currency  Pay OFF Amt Amount Due Status Oldest Due Dt
gt No data to display.
Repossession 5 - 5
Deficiency
Reports
Producers Summary | Customer Service || Account Detals | Customer Details | Transaction Hstory || PmtModes | Burcau | Cross/Up Sell Activities
vendors
Customer | Business
Customer Information £
L E i 7 Audi
View v Format~  [Ep Freeze  idiDetach W
Customer % Relation Econ Name ssn Birth Dt Marital Status Enabled Lane
No data to display.
< it v "
Customer Information
(= save and stay Save andReturn || CaRetun
Customer
Identification Details Kve
Customer &
Relation Passport # Reference #
Econ Issue Dt Status
Name Expiry Dt
Birth Dt Visa = FATCA
Marital Status Nationziity .
o National ID el
SN Birth Country
Language &= Permanent US Resident Status
Education License = —
Mother's M License State
= Mother's Maiden Name R
> Class Type -
Military Service
> Tools il Power of Attorney
— Stop Correspondence e Holder Name i
Diahiity £ Arddrace

For details on this screen refer Customer Service screen’s Customer/Business Details tab

section in Customer Service chapter.

Customer Service screen’s Transaction History tab

Open the Deficiency screen and load the account you want to work with. Click the
Transaction History tab to view the sections under it.
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8.9

8.9.1

8.10

For details on this screen refer Customer Service screen’s Transaction History tab section in
Customer Service chapter.

Customer Service screen’s Pmt Modes tab

Open the Deficiency screen and load the account you want to work with. Click the Pmt
Modes sub tab to view the sections under it.

ACH sub tab

If used, the ACH section displays in